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Using a Jive Community

Find all that you need to know about navigating and using your community.

This guide provides the tools to make the most of the amazing potential in a Jive community.

Getting Started
Get acquainted with your community and learn the basics of communicating, collaborating, and innovating

the Jive way.

Take a Quick Tour
You'll spend most of your time in Jive finding and browsing information, connecting with other community

members, and creating content.

Here's a quick visual tour of the interface. If you're totally new to Jive, check out the built-in Get Started

guides that walk you through key tasks such as posting a status update, connecting with colleagues, and

joining a group.

Jive Like a Pro

If you're visiting your community for the first time,

check out the Get Started guides by clicking @ >

Get Started. Of course you can explore on your

own, but the Get Started guides are the best way

to quickly learn how to use and contribute to your

community.

Don't worry about completing all the guides at once.

You can do a few, and then revisit them later.

And here's a tip: if you don't want to see Get

Started in your sidebar, click your avatar in the

upper right corner and then Preferences > Get

Started > Off. Be sure to Save this change for it to

take effect.
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Read the Latest News

The News page features several streams designed

to keep you up to date on all the latest activity

in your community. Scroll through the Top &

Trending stream to get a feel for what's happening

right now, or take a look at the Most Recent

stream to see all community updates (that you have

permission to see) as they are posted in real time.

Click the image to see a breakdown of this page.

 

 

Browse Your Built-in Streams and Create Your Own

To get a sense of how the streams work, take a

peek at your Connections stream. This is a built-

in stream where you are automatically following

some of your colleagues. You'll see a stream

update every time one of your connections posts

something. You can add to this stream any people,

places, or content that you want to follow here.

You can also create your own customized streams

to focus on specific content, places, or people. For

example, you might create a stream to watch your

team's activity, or activity about your current project.

Click the image to see a breakdown of this page.
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Contribute!

Time to dip your toes in by creating

something useful for the community. Just click

on the main toolbar to create a document, blog

post, discussion, and so on.

Contributing to the community helps it grow into a

useful place to get your work done. It's easy to start

by just asking a simple question. Chances are that

your question, and the answers from your fellow

community members,will be helpful to many other

community members.

In some communities, you may not be able to see

the Create menu.

Click the image to see a breakdown of this page.

 

 

Invite Others and Start Collaborating

Invite other people to join your community! This

helps to build a stronger, more dynamic community.

Just go to the People page and click the Send

Invites button in the left sidebar to send an email

invitation to people who haven't yet joined.

Next, get out in the community and provide answers

to questions to help other users. Comment on

documents and discussions to make something

good even better. Or, join a group to collaborate on

shared work.

Click the image to see a breakdown of this page.
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Explore Your Inbox and Set Up Your View

Click the @ button in the upper right corner to see

your Inbox. Your Inbox shows activity you're directly

involved in—@mentions, shares, direct messages,

and updates to things you've participated in.

Click Your View to see a page that you can

customize to help you get to your most used items

quickly.

You'll see a number next to Actions when you

have Tasks or Action Items you need to get done.

Click the image to see a detailed view of this page.

 

 

Find What You Need

Use the Spotlight Search box in the upper right

corner to find people, places, or content items. If

you want to browse more casually, use one of the

browsing pages. For Content and Place browsing,

click your avatar in the upper right and then Your

Places or Your Content, or click People in the

main navigation. Once in the browsing view, use

the left navigation to refine the results by how they

relate to you. For more about this, see Browse and

Filter Content, People, and Places on page 42.

Click the image to see a detailed view of this page.

 

 

Explore the Community
Here's an overview of the main components you'll see in your community.

News Page

The News page functions as a central news page for your community. It features a variety of streams and

tiles designed to bring you the latest news and information.

The left pane of the News page organizes community activity into streams. From any stream, you can

preview and interact with activity that flows through your community. To learn more about streams, be sure

to read What Are Streams?

You'll see the following streams on the News page by default:

News (top-level view) The News view aggregates and displays only new

content posted in your News and Connections
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streams. However, unlike your other streams, the

News view does not show content updates and

comments in the stream. In addition, content that

gets updated or interacted with is not bumped to

the top of the News view. So, to repeat, the News

view shows only new things. To learn more about

the News view, be sure to read What Is News?

News Streams News streams are designed by your community

manager to bring you the latest news and

information. These are the streams listed above

the Communications stream. For example, you

could have a stream there called "CEO's Blog" or

"My Department." Note that you can't delete News

streams or change the email notifications settings

for them (like you can with your custom streams).

Connections Stream This stream shows the activity of people, places,

and content that you are following in the community.

If you are new to the community, you might want

to browse through People > All to begin following

your teammates or other people who interest

you. To see who you're following, click People >

Following. Note that you can't delete this stream,

but you can remove any or all items from it.

Your Custom Streams Click New Stream to create a custom stream

containing only activity related to the people,

places, and items you specify. You can have one

custom stream or several. For example, you might

create a "My Current Project" stream to follow

everything related to your current project. To learn

how to create custom streams, see Create a New

Stream.

Top & Trending Stream This stream shows the most valuable and

interesting community activity. What you see here is

generating a lot of Likes and comments.

Most Recent Stream This stream shows all public activity in your

community that you have permission to see.

Watching this can be useful if you are new to the

community and want to find people, places, and

content to add to your custom streams.
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Home Page

Your community manager configures the Home page to direct you to important content and places in your

community. As you begin interacting around the community, you may not visit the Home page as often

because the information you need will begin coming to you in your streams and Inbox. You won't see

Home if your community manager has not enabled the feature.

@ (Your Inbox)

Click the @ button next to your avatar in the main navigation to see your Inbox, which includes the

following pages:

Inbox Inbox includes updates to things you've participated

in: direct messages, @mentions, and shares, plus

any items you pulled in by following them in Inbox.

See Tips for Using Inbox for more details.

Your View Your View lets you set up a page just for yourself so

you can get to your most-used items quickly. You

can change what you see from Your View whenever

you want. For example, you might want to update

Your View when you change projects or teams,

or when you just want to watch new things in your

community. See Using Your View on page 33 to

learn how to set it up. Note that you won't see Your

View if your community manager has not enabled

the feature.

Actions Actions reminds you to complete a Task or Action

Item that's been assigned to you. See Tips for

Using Actions for more details.

What are Streams?

A stream shows you real-time updates of activity as people interact with content, people, and places in the

community.

You'll see an update in the stream when someone creates a document, replies to a blog post, posts a

status update, and so on.

Here are some examples of activities that trigger new stream items for people, places, and content that

you're following in a stream:

• Content: someone modifies the content item (for example edits, comments on, or replies to it).

• People: someone posts a status update, creates a content item, or comments on a content item.

• Places: someone updates content in the place (for example publishes a new document, edits a blog

post, shares content with a place, or comments on a document that lives in the place).

• Tags: someone creates or modifies an item with a tag you're following in the stream, or adds the tag to

a content item.
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You can see all public activity (that you have permission to see) in the Most Recent stream. You can also

create your own custom streams that show only the people, places, and content items you select. (Each

person and Place in the community also has an activity stream: you can see yours under your profile, and

Places have a place-specific stream that shows up on Place pages.)

Note that the News stream shows only new content. It does not show a stream update when someone

modifies, comments, or replies to something. Content you've read will stay in your News stream for three

days before going away. Content you haven't yet read will stay for seven days.

When you see the End of New Updates line in a stream, you'll know you've seen all the latest activity. A

little further down, you'll see an End of Previous Updates line that shows you the updates from last time

you checked.

News: Tips

The News page is the best place to explore the full range of what's happening in your community.

Use the following tips and tricks to get the most out of the News page:

• The Announcements banner shows critical headlines selected by your community manager. Just click

on a headline or Show Details to see the full article.

• The streams listed above Connections are streams curated just for you by your community manager to

keep you up to date on the most important community activity. You can't delete or edit these streams

like you can your custom streams.

• Your Connections stream is a built-in stream where you are automatically following some of your

colleagues. You can add to this stream any people, places, or content that you want to follow in the

Connections stream.

• Create a New Stream to focus on specific content, places, or people. For example, you might create a

stream to watch your team's activity and a project stream to follow activity about your current project.

• Look at the Top & Trending stream for the most valuable and interesting community activity. You'll see

content and people that are generating a lot of Likes and comments. Or, check out the Most Recent

stream to see all public activity in your community that you have permission to see. Both of these

streams can be useful for adding new people and content to your custom streams.

• Click the pin icon next to any of your streams to make it the landing page whenever you click News in

the main navigation.

To learn more about the News page, be sure to read the Using News on page 23 section.

Inbox: Tips

Inbox shows replies, @mentions, messages, Latest Acclaim and shares—plus any activity you decide

needs to show up in your Inbox.

Your Inbox shows the activity that's most you-centric—the information that's sent directly to you and has

your name on it. This automatically includes @mentions, replies to discussions you're participating in,

content people share with you, your latest acclaim, new follower notifications, and direct messages.

To see a quick tour of the Inbox, click the following image:
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Note:  Depending on your email preferences, everything that flows into your Inbox can result in an

email notification. If you want to get even less email, click your avatar in the upper right and then

Preferences. Set your email preferences for Inbox to Off. Then be sure to Save the change.

Use the following tips and tricks to get the most out of your Inbox:

• You can follow content items in your Inbox even if you haven't yet or don't want to participate directly.

From any of your streams, just click the content item, and then select Follow > Inbox > Done. All

updates and replies to that item will now flow into your Inbox.

• Use the Filter drop-down menu in Inbox to sort the view to @mentions, messages, notifications, or

shares. You can even use Filter by Participant to see only items including a certain person.

• Manage your unread communications and follow-ups using the blue dot toggle next to messages you

haven't read yet and clicking Unread Only to see only the messages marked with the blue dot.

• When you click the Split View icon in the top right of the Inbox stream and then select a message,

you'll see the content of the message in the lower pane and the list of messages in the upper pane.

• Get rid of activity on any item that no longer interests you by clicking Hide new activity in the lower

pane of the split-pane view. The current activity stays in your Inbox, but you'll see no more update alerts

for that item. (Click Start following in Inbox to restore Inbox notifications for that item).

• Keep in mind that if you are following a space in Inbox (new communities may not have spaces

available), you won't also be following its subspaces unless you separately decide to follow them in

Inbox.

• Click the pin icon next to Inbox, Your View, or Actions to make it the landing page whenever you click

the @ button next to your avatar.
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Actions: Tips

Your Actions area is focused on just what it sounds like: things you need to get done.

When you are assigned something to do, such as a task or something that's been Marked for Action for

you, you'll see an alert next to Actions in the left sidebar.

Use the following quick tips to use Actions effectively:

• Click Action Items to see a list of your Action Items. From here, you can Resolve them, or bring in

other participants. To see the Action Items you have already resolved, click Resolved.

• Click Tasks to see a list of tasks assigned to you, which you can sort by project. To see the tasks

you've completed, select View: Include completed. You can also Create a task from this page.

Alerts

Alerts let you know that there's new activity you might want to check out.

Glance around and you'll see numerical action alerts

that

indicate new activity. For example, if you see a number next to the Inbox icon,

,

you have new items in your Inbox.

Set Up Your Profile
Setting up your profile is the first step to participating in the community.

Your user profile provides community members with an easy way to learn about your experience, skills,

and interests. Your profile shows up in search results when community members search for keywords

contained in your profile. You can update your information at any time.

To set up your profile:

1. Click your avatar in the upper right corner and then click Edit profile.

2. Click the Avatar & Photos tab to change your photo and avatar. Your photo is a great way for people

to "meet" and recognize you in person. Your avatar lets community members quickly associate your

comments and status updates with a simple visual cue.

3. Click the Your Profile tab and fill in as much profile information as you like. Note that your profile will be

found when people search, so if you have professional roles or interests that would be useful for others

to know about, be sure to include them. You may not be able to edit certain fields, such as username.

Usually the community manager sets up these fields for you.

4. Click Privacy to edit your privacy settings. These control how different types of users see your profile.

For more information on privacy settings, see Securing Your Profile.

5. Click Save.
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Update Your Status
Tell others what you're doing right now by typing a brief update in the What's going on? box at the top of

any stream on the News page. You can include an @mention, image, link, or YouTube link in your post.

Status updates are a quick, informal way to let people know you're active and engaged in the community,

for example, "Loved the company pizza at lunch today. Thanks @HR team!" or "Slogging through the

#TPS #report. Ugh!" You can post a status update for the entire community (default) or limit it to a specific

group. For more about status updates, be sure to read Status Update Tips & Tricks.

Add an Image, Link, or YouTube Link to Your Status Update

You can insert an image, link, or YouTube video link to your status update. This is a good way to share

information with people in your community.

To insert an image into your update, click the upload image icon, browse to and select the image you

want to insert, and then click Post to include it in your update. To insert a link, or a video that others can

click to open or play without leaving the community, click the link icon, type the entire link in the URL field,

including "http://", and then click Add . For sites that include images, you'll see an optional thumbnail

image that will post alongside your link: use the arrow keys to select a different thumbnail, or click the x at

the top right corner of the image to post your link with no image. When it looks the way you want it, click

Post. (You can also type the URL directly in the post box, then type a space and wait for the thumbnail to

populate.)

Add an @mention to Your Status Update

You can use an @mention in your status update to call out specific people, content, and places. This can

be helpful if you want to point someone to a specific item or make sure someone gets your update in their

Inbox. When you @mention a person in your status update, the update will appear in that person's Inbox.

Filter for Status Updates

If you want to see a specific person's status updates, go to their profile page and click Activity > Status

Updates.

Join a Group
Joining a group helps you become involved in your community.

A group is a place for you to connect with people who share an interest. Groups can be about anything

from human resources informational groups to after-work sports groups. People join a group to participate

in discussions, keep track of the group-related documents, and remain aware of the group's activities.

There are four types of groups: open, members only, private, or secret. For more detail, see Types of

Groups on page 53. The group types available in your community may vary. If they're available in your

community, you can browse all open, members only, and private groups from the Places page to find

groups of interest. To become a member of a private group, your join request must be approved before

you are allowed to join. To join a secret group, you must be invited by an existing member of the group.
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Depending on how a group is set up, you may have to join it before you can collaborate on content in that

group.

1. In the main navigation, click your avatar and then Your Places.

2. Select All in the left pane.

3. Use the filtering options to find groups that interest you. For example, type accounting in the Filter by

text area to find all accounting-related groups.

4. Click the group title to open and look at the group. You won't see any secret groups here because you

need a personal invitation to even know about secret groups.

5. Open groups allow you to follow and participate in them without joining them. However, for members-

only and private groups, you must join the group before being able to participate in them. After you

Follow or Join a group, you'll see updates from that group in your Connections and custom streams.

Rate, Like, and Mark Content
Rate, like, and mark content so others know it's useful.

Good content deserves attention. You can help improve the popularity of a blog post, discussion,

document, or other type of content by rating and liking it. Popularity determines whether a piece of content

is promoted in certain content tiles, for example, the Popular Content and Answered Questions tiles.

The more people who view, like, and award 3- to 5-star ratings to a piece of content, the more popular it

becomes. Some communities may have rating or liking disabled for certain content types.

Marking content helps others quickly see what has been decided, marked for action, or was a success.

• To like something, click the Like link. Notice the like counter increments by one. Click on the like

counter to see who else liked the content. Likes also contribute to status rankings for the person who

created the content.

• To rate something, click the stars beneath My Rating at the end of a document, blog post, or other

type of content. You'll see the ratings counter increment by one and the average number of stars that

content has received.

• To mark something, click Actions on a comment or reply. This helps others see which comment is the

Decision, needs Action, or is a Success. You can also mark a reply Helpful. Note that you may not see

all of these options depending on how your community manager has set up your community. To learn

more, be sure to read Using the Marking Feature on page 86.

Creating Content
Choose a content type based on your collaborative goals.

Click

to draft a discussion, document, blog post, or another type of content in Jive, or select any of the content

type links at the top of a place's activity page. Note that you may not see the Create menu if your

community manager has not enabled the feature.
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Most collaborative activity occurs in discussions and documents. Blog posts are typically used for viewpoint

essays and other long-form communications that don't invite collaboration. For a more detailed analysis

of the differences between these types of content, see What's the difference between a document, a blog

post, and a discussion?

Private and Public Content

By default, content you create is public in the community and searchable. The power of Jive is that

everyone in the community can benefit from shared content. However, in some cases, you may want to

limit who sees content and who can collaborate on it with you. For more information about deciding who

can see and collaborate on your documents, see Getting more out of documents. For more information

about private discussions, see Getting more out of discussions and questions. Or, you can choose to

publish your content in a private social group that limits content to approved members.

For more information, you might want to read the help topics starting with Public and Private

Communication.

Monitoring Your Content

You'll automatically follow all content that you create, so you'll receive an update in your Inbox whenever

anyone responds to your content or, if it's a document, changes it. You can also delete any comments on

your content, as well as delete the content entirely.

Participate in Content and Discussions
Comment on content or join a discussion to engage with other users in the community.

Collaboration is your main activity in Jive. When you look around your community and discover documents

and conversations, you'll want to take advantage of the opportunity to comment and collaborate. The

following guidelines can help you get started with participating:

• Commenting is as simple as clicking Comment or Reply  at the bottom of a document, blog post, or

discussion. You can reply to an individual message in a thread or to the original post. Everyone reading

the thread will see your response.

• Documents have owners who control whether you can change the content of the document, comment

on it, or even see it. You may be able to see documents that you don't have permission to comment on

or participate in. If you think you should be able to comment on a document and you can't, contact the

author and ask for permission.

• If you can edit a document, you'll see Edit in the Actions menu in the right sidebar.

• A comment or reply may have a badge showing Decision, Action Item, or Success. These badges help

you avoid endless discussion and quickly determine the state or outcome of the conversation. To learn

more about this feature, be sure to read Using the Marking Feature on page 86.

Shout Out to People, Places, and Things
Using @mention, you can alert people, places, and groups that you're talking about them.
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When you create or comment on content in your community, you have the ability to mention a person,

place, document, or other piece of content. This is a way to give a shout out to someone or something to

catch their attention. You might say, "Way to close deals today @Joey Ramone!" or "Trivia Night was a

success for Team Chaos! @Trivia Night Group." This notifies any person mentioned after the @ that you

are talking about him or her. (Members of groups you mention will see an @mention in Followed Activity.)

When someone is @mentioned in a piece of content, a status update, or elsewhere, a notification of the

activity flows into their Inbox. In Jive, @mentioning doubles as a link picker in content or in status updates.

For example, you can add links to a document or group by typing some of the words in the title after typing

@. You can even use both formats in the same status update, for example to say "@Joey Ramone and

@Johnny Ramone, please check out my question @Why is the Submit form not working today?

1. Type the "@" symbol (or click the "@" icon if it is available). A search dialog opens and suggests

possible matches. To narrow matches, use an underscore (_) as a space. For example, @Mike_D

would match the Mikes whose last name begins with "D." Your picker will include documents,

discussions, and places as well as people. Keep typing to narrow the choices further. You can also

scroll through the list of people, places, and content that are suggested for you.

2. Select the correct match from the list. The new link shows up in your content.

Find Stuff You Need
Here's a quick guide for learning how to find stuff you need.

You can make use of the following ways to keep track of, and find, everything that's important to you. And

remember, as you develop behavior patterns in the community, Jive will recommend relevant content,

people, and places based on your activity.

For more searching tips and tricks, be sure to read the topics in the Finding People, Places, and Content

section.

Tip:  Browse the people and places that your co-worker or someone with similar interests follows

by going to their profile page and clicking More > Connections/Places. This is a great way to find

things you might want to follow, too.

Search for something specific: Let Jive finish your thought with its predictive

searching feature. When you start typing in the

Spotlight Search box in the upper right corner, Jive

returns the most closely related items found while

searching everything in your community. You can

pick from the list, or press Enter to see all matching

results that you can sort to find what you need.

You'll be able to refine your search to a specific

space, project, group, or person. Direct messages

and status updates are searchable. You can also

choose a search time frame.
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Browse for something more general: Click a subject to browse: People (in the top

navigation), Your Places (under your avatar), or

Your Content (under your avatar). Once you get

there, you can use the options in the left sidebar

to narrow the results by how they relate to you.

For example, did you author the content? Did you

participate in the discussion? Or, do you want to

look at all content in the community?

Filter what you're browsing: Once you're browsing, you have even more sorting,

filtering and keyword search options, including

things like sort by date, filter by tags, or search

specific text, which all help you find what you need

as quickly as possible. For more on filtering, see

Browse and Filter Content, People, and Places.

Bookmark items: From any piece of content, you can create a

bookmark by clicking Bookmark in the right-hand

menu. Later, to see the content you've bookmarked,

just click the Spotlight Search box at the top right.

From there, click Bookmarks. If you don't see your

bookmarked item listed there, click Show all my

bookmarks. Be sure to read Using Bookmarks to

learn how to bookmark like a pro.

See your History and Suggestions: You can look at your Jive browsing history of

Content, People, and Places by clicking the

Spotlight Search box at the top right and then

selecting History. If you don't see what you need

from the list, click Show all my recently viewed

content. Or, click Suggestions to see your

frequently viewed items.

Pinning Pages for Quick Access
You can pin any of your streams to the News button and any of your Inbox pages (Inbox, Your View, or

Actions) to the "@" button. You can also pin either News or Inbox to your community logo. This makes it

faster to get to your favorite pages.

News You can pin any of the streams listed on your News

page to the News button, including the Most Recent

and the Top & Trending streams. Just click News

and then the pin icon or triangle next to your desired

page's name in the left sidebar. Now when you click
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News from anywhere in the application, you'll be

taken right to the page you pinned. Yay!

@ (Inbox) You can pin any of the pages listed on your Inbox

page to the "@" button, including Inbox, Your View,

and Actions. Click the "@" button and then the pin

icon next to the page's name in the left sidebar.

Now when you click the "@" button from anywhere

in the application, you'll be taken right to the page

you pinned. Double-yay!

Community Logo You can pin News or Inbox to your community logo.

Click your user avatar in the upper right and then

Preferences. Under Personal Home Page, select

either News or Inbox, and then click Save. Now

click your community logo and...voilà!

Using Jive in a Mobile Browser
Jive delivers an awesome community experience to smaller screens, too. The mobile browser features

simple navigation with large buttons that are better suited for touch screens. You won't see options that are

too complex or take up too much real estate on a mobile device.

To visit your community from a mobile browser, just enter your community's URL into the built-in browser

of your device and log in. Note that you can see the same narrow interface on the desktop version by

making your desktop browser smaller.

Here's what you can do from the mobile browser (and for a quick visual tour of the interface,  check this

out):

Read and interact with your streams and Inbox Just like in the desktop version, you can cruise

through and interact with your streams, and read

and respond to your Inbox items.

Create most content types Create all sorts of content from your mobile device,

for example, ideas, blog posts, documents, and so

on.

Search and filter Tap the magnifying glass, enter your search term,

and then click the down-arrow to filter by Content,

People, or Places, and/or the time period of the last

modification.

Access and use places like a pro Follow, join, or leave places from the mobile

browser. You can also see a place's activity,

content, people, and any subspaces, projects,

and custom pages the place may have. To sort
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the content in a place, just click Content and then

an icon: documents, discussions, blogs, or polls.

If you're looking for the tiles on a group's activity

page, be sure to scroll all the way down to see

them.

Note:  Some content and functionality only make sense in the wider desktop view, so you won't see

some things cluttering up the smaller space. Also, iPads will always benefit from the full functionality

of a wide-screen view.

Known Issues

• The mobile browser does not work on Blackberry devices.

• Older Android browsers struggle with content creation. You can resolve this by upgrading your Android

operating system and using Chrome to browse your community.

Quick Tour from a Mobile Browser
Here's a quick visual tour to help you learn how to navigate your community from the built-in browser on

your mobile device (or a narrow desktop screen).

If you're totally new to Jive, check out the Get Started guides that walk you through the key tasks such as

posting a status update, connecting with colleagues, and joining a group. Otherwise, to jump right in from

your mobile device, just enter the URL of your community into the built-in browser, and then:

See what's new

When you first log in using a mobile browser, you'll

see the latest posting from News, like you see to

the right. To see your streams, tap the down-arrow.

You can go to any of them by tapping one.
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Check out your Inbox

If you see a blue alert next to the person icon, you

have something unread in your Inbox. You could

also go to Your Content and Your Places from here.

You could also log out from here, but why would

you want to do that?
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Create content

Create all kinds of content right from the mobile

browser. You can publish it for specific people, in a

place, or the entire community.
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Find what you're looking for

You can search from your mobile browser by

tapping the magnifying glass in the upper right

corner. After you enter your search terms, click the

down-arrow to filter by Content, People, or Places,

and/or the time period of the last modification. Note

that we decided that a narrow-screen search should

be just about search, so you won't see Bookmarks

or Recently Viewed Content taking up precious real

estate here.

Finally, you can find your red stapler.

Using News
The News page functions as a central news page for your community. It features a variety of streams and

tiles designed to bring you the latest news and information.

What Is News?
News is the central place for you to see what's happening in the community.

The News page features a variety of streams created for you by your community manager, designed to

direct you to content, people, and places that pertain directly to you. You'll also see your Connections

stream, any custom streams you have created, the Top & Trending stream, and the Most Recent stream,

which shows recent activity from all over the community that you have permission to see.

You can pin any of the streams listed on your News page to the News button. Just click News and then

the pin icon or triangle next to your desired page's name in the left sidebar. Now when you click News from

anywhere in the application, you'll be taken right to the page you pinned.

The News page also features a variety of tiles to help you find important people, places, and content

quickly. The Trending Content and Trending People tiles are included by default, but may be removed by

your community manager.

Here's an overview of what you'll see on the News page. For a quick visual tour of the News interface, click

here.
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News (top-level view) The News view aggregates and displays only new

content posted in your News and Connections

streams. However, unlike your other streams, News

will not show content updates and comments in the

stream. In addition, content that gets updated or

interacted with is not bumped to the top of the News

view. So, to repeat, the News view shows only new

things.

Because the News view aggregates new posts

from your News and Connections streams, content

is pulled in and displayed in the News view in the

order in which your streams are displayed in the

left sidebar. Six items from each stream are pulled

in and shown in creation-date order. Duplicated

content is removed if it's already being pulled in

from a higher-order stream. Content you've read (by

clicking-through to it either from your desktop or a

mobile version of Jive) will stay in News for three

days before going away. Content you haven't yet

read will stay for seven days. Because the News

streams are designed just for you, you won't see

the same content pulled into the News view that

others will see.

News streams These are the streams you see listed above

the Connections stream. They are created and

managed by your community manager or people

with Manage News Streams permissions. Because

these streams are designed just for you, you may

not see the same News streams or the same

content in them that others see. To learn more, be

sure to read What Are News Streams? on page

25

Connections stream This is a built-in stream where you are automatically

following some of your colleagues, but you can

add to or delete content, people, and places from

it. This stream can be a good way to avoid stream

proliferation if you just want to check in throughout

the day with things that interest you without having

to create a lot of custom streams.
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Your custom streams If you've created any custom streams, you'll see

those listed below the Connections stream. Custom

streams can be a great way to keep up with the

content, people, and places that matter most to

you in your community. Here are some examples

of custom streams you might want to create for

yourself.

For a quick visual tour of the custom streams

interface, click here.

Top & Trending stream Check out this stream to get a feel for what's

happening right now. The Recommended

Content and People widgets, as well as the

Trending Content and People widgets, show you

what's generating a lot of interest around the

community. To learn more, take a look at Using

Your Recommendations on page 42.

Most Recent stream This stream shows you all community updates that

you have permission to see as they are posted

in real time. Scrolling through this stream can be

useful for adding new people and content to your

Connections or custom streams.

What Are News Streams?
News streams are configured for you by your community manager and are designed to bring you the latest

news from your organization, department, team, or product.

News streams are listed above the Connections stream. Because they are designed just for you, you may

not see the same News streams or the same content in them that others see.

For example, everyone in your community may see the "CEO's Blog" stream that shows the latest blog

posts from your organization's CEO. However, only people in the Marketing department may have a

stream called "Marketing News" that shows activity from the Marketing space.

In addition, you might have a news stream based on your role in the community. For example, let's say

everyone has a stream called "What’s New," but what is displayed there will be different depending on your

role. So Customers might see content pulled from the Special Promotions blog in their What's New stream,

but vendors might see content pulled from the New Solutions group.

To learn more about streams and how they work, be sure to read What Are Streams?
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Creating Custom Streams
You can create your own custom streams to help you keep up with the content, people, and places that

matter most to you in your community.

What are Streams?
A stream shows you real-time updates of activity as people interact with content, people, and places in the

community.

You'll see an update in the stream when someone creates a document, replies to a blog post, posts a

status update, and so on.

Here are some examples of activities that trigger new stream items for people, places, and content that

you're following in a stream:

• Content: someone modifies the content item (for example edits, comments on, or replies to it).

• People: someone posts a status update, creates a content item, or comments on a content item.

• Places: someone updates content in the place (for example publishes a new document, edits a blog

post, shares content with a place, or comments on a document that lives in the place).

• Tags: someone creates or modifies an item with a tag you're following in the stream, or adds the tag to

a content item.

You can see all public activity (that you have permission to see) in the Most Recent stream. You can also

create your own custom streams that show only the people, places, and content items you select. (Each

person and Place in the community also has an activity stream: you can see yours under your profile, and

Places have a place-specific stream that shows up on Place pages.)

Note that the News stream shows only new content. It does not show a stream update when someone

modifies, comments, or replies to something. Content you've read will stay in your News stream for three

days before going away. Content you haven't yet read will stay for seven days.

When you see the End of New Updates line in a stream, you'll know you've seen all the latest activity. A

little further down, you'll see an End of Previous Updates line that shows you the updates from last time

you checked.

Create a Custom Stream
Follow these easy steps to create your own customized stream.

1. From the News page, click on New Stream in the left sidebar and enter a name for this stream, for

example, Water Cooler, My Cool Product, Team Activity, and so on.

2. Drag and drop items from the Suggested People and Places in the right column, add one or more tags

you want to follow, or use the Search box to find specific items you want to follow in this stream. For tips

about how to find and follow useful things, see Follow People, Places, and Content or Following a Tag

on page 46.
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3. Decide whether you want to receive an email every time there is a new item in this stream (Email

update > On or Off). We strongly recommend setting email notifications to Off, which is the default. For

more information, see Email or Stream Notifications?

4. To save this new stream, click Done.

You can add to, edit, or delete this stream any time you want.

Examples of Custom Streams

Here are some examples of custom streams you might create, depending on your role in the organization

or how you want to check in on community activity throughout the day.

Consider creating and organizing your custom streams based on the following strategies. Try using a

combination of these to develop the best approach for your unique needs.

My Stream Create a stream where you follow yourself. This can

help you get to your most-used items quickly.

Priority Streams You might create streams for Immediate, Soon,

and Later. You could check Immediate often, Soon

occasionally, and so on. In Immediate, follow your

high-priority people, places, and content items. In

Soon, follow your less urgent people, places, and

content items. This kind of organization can be

good if you like to read some things later, but don't

want to miss your high-priority things as they are

posted.

Content Streams You could create an Awesome Blogs stream where

you follow the blogs of the CEO, CTO, and VP of

your department.

Email Watches This stream can be very handy if you're in and out

of the community a lot, and especially if you're out

of the office for a few days. Add to this stream only

critical items that you just can't miss. Then, make

sure to set Email Updates to On when you are

editing this stream. You can also set your email

notifications by clicking your avatar in the top right

and selecting Preferences.

Team and Product Streams Add to these streams the people you work with,

the content you all are working on, and the places

where your team most frequently posts. Or, create

just one good Team and Product stream to check

throughout the day for updates from your team and

the product you're working on.
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Connections Stream Follow people, places, and content items of interest

here. This can be a good way to avoid stream

proliferation if you just want to check in throughout

the day, but not create a lot of custom streams. This

stream is included for you by default, but you can

add to or delete content, people, and places from it.

Tag Streams Follow tags that make sense for you. You can

create an entire stream for one tag, or add tags

to optimize your existing streams. If you're a QA

Engineer, you might add the #test tag to your

stream that already follows the QA Group.

Here are more specific streams that you might create, depending on your role in the organization.

If you work in the Engineering department, you might create the following new streams:

• Email Watches - Follow critical items here and then make sure to set Email Updates to On when you

are editing this stream. You can also set this by clicking your avatar > Preferences . If you go on

vacation, you'll receive an email notification for these critical activities. Use this stream wisely so that

you don't create an email nightmare for yourself.

• Product A - Follow everything related to one of the products you're working on.

• Product B - Follow everything related to another product you're working on.

• Team - Follow everyone on your team so that you stay current with their activities.

• Research - Follow things related to your next big product idea.

• Awesome Blogs - Follow blogs that you like.

• Water Cooler - Never miss a good joke or an after-hours trip to the pub. Follow fun people, content

items that are amusing, and community places where people organize social events.

If you work in the Accounting department, you might create these streams:

• Customer Account A - Follow everything related to one of the customer accounts you're working on.

• Customer Account B - Follow everything related to another customer account you're working on.

• Team - Follow everyone on your team so that you stay current with their activities.

• Sarbanes-Oxley - Follow people, places, and content items in your community related to Sarbanes-

Oxley so you don't miss important new regulations or processes.

• Latest Wins - Follow the place where your latest wins are reported. You might also follow the VP of

Sales and the blogs of Sales team members here.

• Email Watches - Follow critical items here and then make sure to set Email Updates to On when

you are editing this stream. You can also set this by clicking your avatar > Preferences. If you go on

vacation, you'll receive an email notification for these critical activities. Use this stream wisely so that

you don't create an email nightmare for yourself.

If you work in the Sales department, you might create these streams:
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• My Region - Follow everyone working in your region, plus all of the places you and they post most

often.

• Central Region

• West Region

• Marketing for Product A - Follow the people, places, and content related to the marketing of Product A.

• Marketing for Product B

• Exec Blogs - Follow the blogs of the CEO, CMO, SVP of Sales, and other leaders who matter most to

you.

• Email Watches - Follow critical items here and then make sure to set Email Updates to On when

you are editing this stream. You can also set this by clicking your avatar > Preferences. If you go on

vacation, you'll receive an email notification for these critical activities. Use this stream wisely so that

you don't create an email nightmare for yourself.

• Comic Relief - Follow entertaining people and places where people post funny stories and videos.

Tips for Finding Things to Follow

Here are some tips for finding useful activity to follow in your community.

• Browse the content, people, or places that your co-worker or someone with similar interests follows by

clicking More > Connections/Places on their profile page. This way you can quickly find things and

people you should also follow. It can also be helpful to look at their Bookmarks.

• Read the Top & Trending stream on the News page to see what other people are excited about.

• Browse for items using the People browse in the main navigation or Your Content or Your Places

in your user profile menu in the upper right. Once you're browsing, type keywords into the filter box to

narrow your results. To learn how to browse and filter like a pro, see Browse and Filter Content, People,

and Places.

• Use the Search box to find things that interest you. To learn how search works, see Using the Spotlight

Search.

• Watch the Trending People and Trending Content tiles on the News page. These tiles use a complex

algorithm to suggest items relevant to you that you may have missed in your daily travels around the

community. To learn more about this, see Using Your Recommendations.

• Try following a tag. Note, however, that this can be tricky because tags are assigned by people all over

the community, so you may not know how other people are tagging content, places, and people.

Start Following People, Places, and Content

There are several ways to begin following a piece of content, a person, or a place in the community. Here

are some easy ways to get started.

• From any stream you're reading, including News streams, hover your mouse over a person's name or

avatar, or the name of a place, and click Follow. You can then select the stream in which you want to

follow the person or place.

• Use the Browse menus. Click People from the top navigation menu, or click Your Content or Your

Places from the menu under your avatar, then browse for things to follow. Be sure to check the

Recommended tab to see recommendations based on your individual activity and connections in the
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community. When you see an item you want to follow, click on its gear icon and then Follow. Then

select the stream in which you want to follow the content item, person, or place.

• Use the Search feature. Search for keywords of things that might interest you. When you find

something you want to follow, click on the item. From there, click Follow. Then select the stream in

which you want to follow the content item, person, or place.

Stop Following People, Places, or a Piece of Content

To stop following something, either hover over it from the stream or go to the item and then click

Following. Select the streams from which you want to stop following the person, place, or content item,

and then click Stop Following. You will no longer see updates for that person, place, or content item in

those streams. Those updates will still appear in the Most Recent stream, however, because that stream

shows all public activity in the community.

You can also click the gear icon next to the stream and click Edit stream to use the stream drag-and-drop

feature.

Email or Stream Notifications?

Here are some real-world examples that explain why you might want to turn email notifications on for some

of your streams, but off for others.

Email or No Email?

Part of the power of your community is the ability to "live" in it for most of your working hours and, as a

result, reduce your email. In Jive, you can customize your notifications so that you receive an email, or

not, when a person, place, or item posts an update in one of your streams. If your community is busy,

you may find that you rapidly accumulate hundreds of email messages from any streams that have email

notifications set to On.

Here are some good email notification strategies:

• Turn off all email notifications and live in your Jive community 100%. You will never get an email when

your followed people, places, or items post updates in the community.

• Create an Email Watches stream and set email notifications to On for only that stream. Then, only

follow critical items in your Email Watches stream. This stream can be helpful when you're away from

the community for a few days or if you want to watch something that you haven't directly participated in

(if you had, you'd see those updates in your Inbox).

Be aware that if you set email notifications to On for Inbox (everything in my Inbox page), you will receive

an email each time someone posts an update to an item in which you were previously @mentioned or that

you participated in. This can get overwhelming quickly; we recommend setting email notifications to Off for

Inbox (everything in my Inbox page).

Note:  The email notifications for news streams (those listed above Connections) are set by the

community manager or person who created the stream. You cannot change the email notification

setting on these streams.
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Community Digest

You can set your Preferences by going to the top right and selecting your avatar > Preferences and

then choose a Community Digest option so you'll receive an email with a summary of community news.

The links in the digest open the content right in the community. If you're already getting a digest, you can

cancel it or change its frequency here.

The digest includes:

• Your status. If you've entered a status message, it'll be here.

• A list of activity around your content. If you've created or commented on content, for example, it'll be

listed here. This list will also include notes about content of yours that was viewed or commented on by

others.

• A list of activity by people connected to you.

• A list of popular content in the community.

Customizing Email Notifications

You can set email notifications on any of your custom streams, your Connections stream, and your Inbox,

so that you receive an email each time a person, place, or item posts an update in that stream.

There are a few ways to turn email notifications off or on:

From the unsubscribe link in the email If your community manager has enabled this

feature, you can click the unsubscribe link to

turn all email preferences to the off setting. It

switches the Receive Email option to No. You can

also find this option when you click your avatar >

Preferences.

When you're editing a stream Click the triangle next to the stream name and

select Edit Stream. At the top of the stream, switch

Email Updates to Off or On and then Done next to

the stream's title in the left sidebar.

From your Preferences page Click the triangle next to your avatar in the upper

right corner and select Preferences. From there

you can turn Email Preferences to Off or On for

each stream, including your Inbox. Click Save when

you're done.

Caution:  When you turn On email updates for a stream or your Inbox, you will get an email every

time that stream or Inbox is updated. This can get overwhelming quickly; we recommend setting

email updates to Off whenever possible.

You cannot set the email notifications on the streams listed above the Connections stream. Your

community manager sets the email notifications for these streams.

Use the following settings to understand when you'll receive an email:
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Table 1: Email Settings

Setting When Email Notifications are ON you will:

Inbox (things you've followed in

your Inbox)

Receive a separate email each time someone posts an update to an

item you've selected to follow in your Inbox.

Inbox (@mentions, messages,

and shares)

Receive an email each time someone @mentions you, shares

content with you, or sends you a message in the community.

Inbox (tasks, connections, and

skills endorsements)

Receive an email each time you have a new task, a new connection,

or a new skills endorsement.

Moderation Receive an email when you have content to moderate (if you're a

content moderator).

Connections Stream Receive an email each time a followed person, place, or item posts

an update in this stream.

Your Custom Streams Receive an email each time new activity is posted in your custom

stream(s).

Community Digest Receive a community digest email every day, once or twice a week,

or never. To learn what is included in the digest, see Community

Digest.

Include body of content in email You can select whether or not you'd like your email notifications to

include the full text of the community item you're being notified about.

Add to a Custom Stream
Quickly add content, people, and places to any of your custom streams and your Connections stream

using any of these methods.

Tip:  If you are already following something in a stream, you'll see the notation "Following in". If

you're not following it, it will show "Follow".

• From any stream you're reading, including News streams, hover your mouse over a person's name or

avatar, or the name of a place, and click Follow. You can then select the stream in which you want to

follow the person or place.

• Use the Browse menus. Click People from the top navigation menu, or click Your Content or Your

Places from the menu under your avatar, then browse for things to follow. Be sure to check the

Recommended tab to see recommendations based on your individual activity and connections in the

community. When you see an item you want to follow, click on its gear icon and then Follow. Then

select the stream in which you want to follow the content item, person, or place.

• Use the Search feature. Search for keywords of things that might interest you. When you find

something you want to follow, click on the item. From there, click Follow. Then select the stream in

which you want to follow the content item, person, or place.
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Edit a Custom Stream
As your projects and interests change over time, so should your custom streams. Edit them to match what

you need from the community at any given time. You can also delete a custom stream.

Your streams should change over time as you add and remove people, places, and content from them,

depending on what you're working on and how your team, products, and tasks change over time. From

any of your streams, you can hover over a place name or person's name and select Stop Following. For

content items, click the name of the item, and then select Stop Following.

To edit a stream using the drag-and-drop interface, just select a stream, click the down arrow next to it,

and then Edit stream. Now drag and drop to your heart's content. When you're finished, click Done.

To delete a stream, click on it and then click the down arrow next to it. From here, select Delete Stream.

Why Am I Seeing This in My Stream?
Understand why you are seeing something in a stream with these sanity-checks.

Here are some examples of activities that trigger new stream items for people, places, and content that

you're following in a stream:

• Content: someone modifies the content item (for example edits, comments on, or replies to it).

• People: someone posts a status update, creates a content item, or comments on a content item.

• Places: someone updates content in the place (for example publishes a new document, edits a blog

post, shares content with a place, or comments on a document that lives in the place).

• Tags: someone creates or modifies an item with a tag you're following in the stream, or adds the tag to

a content item.

If you are seeing something in your stream that you don't think you are following, ask yourself these

questions:

• Am I following the person who posted the item?

• Am I following the place where the item was posted?

• Am I following this content item?

If you discover that you are following the person, place, or content item in your Connections stream or any

of your custom streams, but you don't want to, go to or hover over the person, place, or content and click

Stop Following.

Your News streams (those listed above Connections) were created by other people, so you'll have to ask

them about any unexpected content you see in your News streams.

A common question is why you're getting email notifications on activity you're not interested in. Note that

each of your custom streams (those listed below Connections) has a configuration setting to enable or

disable email notifications. To learn more, be sure to read Email or Stream Notifications? on page 30

Using Your View
Your View lets you customize a page just for yourself so you can get to your most used items quickly.
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Plus, you can change what you see from Your View whenever you want. For example, you might want to

update Your View when you change projects or teams, or when you just want to watch new things in your

community.

Note that you won't see Your View if your community manager has not enabled the feature.

Setting Up Your View
Your View is pre-populated with a few tiles to get you started, but you can edit these or remove them

altogether. You can also add new tiles that you select and configure to suit your specific needs.

To go to Your View, click the @ button in the main navigation banner (if you're using a customer- or other

externally-oriented community, you'll need to first click your avatar in the upper right corner, then Activity

& Inbox to see Your View in the left sidebar). By default, you'll see the following tiles in Your View:

• Frequently Viewed

• Latest Blog Posts (You won't see this tile if your community manager has disabled blogs in your

community.)

• Trending Content

• Key Content and Places

You can edit these to display things you want by clicking the gear icon on the tile and adding links to the

tiles. You can also move the tiles up and down on the page by clicking the up and down arrows on each

tile.

To pin Your View to the "@" button, click the pin icon next to the words Your View in the left sidebar. Now,

when you click the @ button in the main navigation banner, you'll go right to Your View. This can be helpful

if you design Your View with links to your most visited items. But, Your View is totally up to you, so design

it, and change it, however and whenever you like.

Adding a Tile to Your View
Add a new tile to Your View in a few easy steps.

1. Click Your View in the left sidebar. If you're using a customer- or other externally-oriented community,

you'll need to first click your avatar in the upper right corner, then Activity & Inbox to see Your View in

the left sidebar.

2. Click Edit page in the upper right corner.

3. Click Add a tile.

4. Select a tile to add to your page. Note that the tiles are organized by category: Content, People, Places,

or Other. To see a complete list of the tiles you can display on Your View, be sure to see the Your View

Tile Reference on page 35.

5. Configure the tile. Typically, that means adding links to it. You can also move the tiles up and down on

the page by clicking the up and down arrows on each tile.

6. Apply your tile changes when you're finished. And don't forget to Save your changes to the Your View

page.
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What is a Tile?
Tiles display useful information, such as Popular Content or Featured People.

You can use a tile as is or customize it to display specific information. Different tiles are available by default

in different places (spaces, groups, Your View, and so on). For example, the HR Pre-Hire Collaboration

place template includes the Helpful Links and Action Items tiles by default. If you own the place, you can

choose not to show these default tiles, and instead select different tiles.

Here's an example of the Top Participants and Upcoming Events tiles:

 

 

Your View Tile Reference
Here's a complete list of the tiles available in Your View.
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Table 2: Content Tiles

Tile Description Dependencies

Document Viewer Shows a full preview of a document you choose to display. Content added

manually.

Featured Video Shows a manually selected video from an external, non-

community source.

Content added

manually.

Expandable

Sections

Shows links to community content under collapsible headings. Content added

manually.

Latest Blog Posts Shows the newest blog posts in your community. (You won't

see this tile if your community manager has disabled blogs in

your community.)

Content added

manually.

Trending Content Shows content that's attracting views and interactions. Relies on an

algorithm.

Frequently Viewed Shows the people, places, and content you visit most. Relies on an

algorithm.

Recently Viewed Shows the people, places, and content you viewed recently. Relies on an

algorithm.

Table 3: People Tiles

Tile Description Dependencies

Frequently Viewed Shows the people, places, and content you visit most. Relies on an

algorithm.

Recently Viewed Shows the people, places, and content you viewed recently. Relies on an

algorithm.

Table 4: Places Tiles

Tile Description Dependencies

Frequently Viewed Shows the people, places, and content you visit most. Relies on an

algorithm.

Recently Viewed Shows the people, places, and content you viewed recently. Relies on an

algorithm.
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Table 5: Other Tiles

Tile Description Dependencies

Featured Video Shows a manually selected video from an external, non-

community source.

Content added

manually.

Finding People, Places, and Content
Jive includes several search features to help you quickly find what you're looking for, or just to browse

through content, people, and places. The following topics will help you understand which feature best suits

your searching goal.

Search and Browse Features
Here is an overview of Jive's search and browse features. And remember, as you interact in the

community, Jive will keep track of your interests and connections and recommend relevant content,

people, and places.

Search for something specific using keywords

in the Spotlight Search:

See how to use the Spotlight Search.

View your History and Recently Viewed items: To see your Jive browsing history, click in the

search field at the top right, and then select

History. To see your recently viewed items, click

Show all my recently viewed content.

Search for something within a Place: If you know something is saved in a specific place,

you can limit your spotlight search to just that place.

First, go to the place. Then, type your keyword into

the search box and select Show: Only for [this

Place].

Search for someone's content: If you know someone authored a document or

participated in a discussion but you can't remember

any keywords from the discussion, go to the

person's profile and open Content. From there,

browse through their recent content creations,

discussion comments, and so on, to find what

you're looking for.

Find places by categories Click your avatar and then Your Places > Filter

by Category, and then pull down the All menu

to select a predefined place category. (This will
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work only if your community manager set up place

categories.)

Browse and filter Content, People, and Places: Click People in the top site navigation bar, or in

the menu under your avatar, click Your Content

or Your Places. Once you get there, use the left

navigation to refine the results by how they relate

to you. For more on filtering, see Browse and Filter

People, Places, and Content.

Bookmark useful content and look at your

Bookmarks:

You can bookmark any piece of content and

then look at your most recent bookmarks later by

clicking the Spotlight Search box at the top right

and then Bookmarks. To browse through all of

your bookmarks, click Show all my bookmarks.

From there, you can see the bookmarks of others

by clicking All in the left sidebar.

Tag content to make it easier to find later: You can assign tags that act as keywords to

existing or new content to describe it for people who

might search for it later. You can even assign tags

to a status update. To learn more about tagging,

see Using Tags.

Use your Recommendations: Jive includes a powerful "genius" feature that

analyzes your business relationships, expertise,

and areas of interest based on your behavior in the

community. It then uses that data to recommend

relevant content, people, and places that you

have not yet seen in the community. There

are several places in the interface where you

see your recommendations, but a quick way to

see them is to navigate to People (in the top

navigation) or to Your Places or Your Content

(from the menu under your avatar). Then click

Recommended in the left sidebar. To learn more

about using recommendations, see Using Your

Recommendations.

Search in your language Searches are performed across all supported

languages of the Jive platform. When you search

for something, however, the search engine first

searches for results that match the language you
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have set in your Preferences on your profile page

(click on your avatar and go to Preferences). If

you do not have a language set there, the search

engine will use the locale setting of your browser.

Using the Main Spotlight Search
Type keywords into the main Spotlight Search box to quickly find what you're looking for.

The Spotlight Search is a quick way to look for things you already know about or have good keywords for

if you're just looking generally. Just start typing your keywords in search box in the upper right and Jive

will list suggested content. If what you want is listed in the results, click on it. If not, press Enter to see all

matching results on the advanced search page. From there, you can create more complex and filtered

searches.

For more detailed search information, be sure to read the Search Reference.

Tip:  You can prevent your History and Bookmarks from being returned in search results. Just click

the triangle next to your avatar and then Preferences. From there, select the Don't show history

or bookmarks when searching box, then Save.

Search Reference

Use this search reference to get the most out of searching in Jive. These rules apply to all word search

features in the application.

Search for specific words

This is the most basic search mode, and is also the default. Simply enter your search terms to see content

containing all the specified words in any order.

Search for someone's name

Searching for people is similar to searching for specific words. You can't use phrase searching, wild cards,

or field- and date-specific searching to find the names of people in the community.

Search for phrases

If you enclose a phrase in quotes, your search will return only content where the words in quotes occur

next to each other and in the same order. For instance, specifying "black cat” will return text where this

phrase appears exactly as quoted, such as “our black cat brings us luck”, but will not return “the cat was

hiding in the black box”.

Note:  Content searches are case-insensitive. For example, entering any of Jive, jive, or JIVE will

return content with any of the words jive, JIVE or jIVe. For both regular and phrase searches, we

also match words that are very similar, but not identical.
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Search for content with words containing certain letter sequences

The wildcard character * matches any number of non-whitespace characters when it is placed at the end

of a word or within a word in the query. You can use the following examples to search for "multiplication" or

"concatenation". Note that spotlight searches automatically use wildcards, even if you do not type * in the

string.

mult* Matches content containing the words

multiplication, multiple, multimodal, multitude, etc.

con*ion Matches content containing the words contagion,

concatenation etc.

Note:  A wildcard cannot be used at the beginning of a word, and it can't be used as a standalone

word.

Synonym searching

Your community may or may not support synonym searches, depending on whether your community

administrator has enabled this feature. Ask your community administrator whether synonym searches are

supported in your community.

If synonym searches are enabled, your searches will return results for synonyms. For example, if you

searched for "search tips" (not in quotation marks), the search engine would return any found results for

"search tips" AND "find tips" because "search" and "find" are synonyms.

Restrict to certain date ranges

If you press Enter after entering your search terms into the search box, you'll see the advanced search

page. From there, you can restrict your search by selecting last modified date ranges, such as All time,

1 day, 7 days, 30 days, 90 days, and 1 year. The default is "All time," which does not put any date range

restriction on your search.

Compound expressions using Boolean operators

The special keywords AND, OR and NOT let you create logical expressions in your searches. When you

search, you need to use these terms in ALL CAPS to distinguish them from normal words. For instance,

the word And in a search will be interpreted as the word "and," not the special operator AND.

The AND operator says that the search should return content containing both the search terms before

and after the AND operator. The OR operator returns content if either one of the terms matches. The NOT

operator excludes documents that contain (in the fields searched for) the search term after the NOT. (You

can't start a search with the NOT operator.) You can also use these operators with sub-queries enclosed in

parentheses to create more complex expressions as shown in the following examples.

“quick brown fox” OR rabbit Matches text containing the exact phrase “quick

brown fox” or the word rabbit.



 | Using a Jive Community | 41

quick brown fox Matches content containing the words "quick,"

"brown," and "fox" in any order. Search implicitly

assumes the AND operator when an operator is not

specified.

(quick brown) AND (fox OR rabbit) AND NOT

forest

Matches content containing both "quick" and

"brown" in any order, plus either "fox" or "rabbit,"

but not containing the word "forest." This example

shows how you can use parentheses to group more

than one word together as a regular (non-phrase)

search and to specify the order of operations. Note

that the NOT operator can only be applied to simple

terms, not compound sub-queries, and it cannot be

used inside a sub-query.

Special characters and operator words

The following characters and operator words are treated specially in the search syntax (separated by a

single space):

* ( ) “ AND OR NOT You can't search for these characters and

operators, because we the application uses them

for special search syntax. If you use these words in

search text in a way that doesn't make sense to the

application, the search engine may ignore them. For

example, an odd number of quote characters will be

ignored, and multiple asterisks next to each other

will be interpreted as a single wildcard.

Multi-language searching

Searches are performed across all supported languages of the Jive platform. When you search for

something, however, the search engine first searches for results that match the language you have set in

your Preferences on your profile page (click on your avatar and go to Preferences). If you do not have a

language set there, the search engine will use the locale setting of your browser.

Promoted Search Results

You may see some results marked as "Promoted" when you search. These results have been selected by

an administrator to ensure that certain content is always associated with one or more search keywords,

even if the keyword isn't actually in the content--for example, your site administrator may want users who

type "Benefits" to always see the Human Resources page as the first result, even if there are many other

pages with titles containing the word "Benefits". If a result has been promoted, you may see it again as a

result farther down the results page.
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Using Your Recommendations
Use the Jive recommendation features to find content, people, and places you might like to follow in your

streams.

Jive includes a powerful "genius" feature that analyzes your business relationships, expertise, and areas of

interest based on your behavior in the community. It then uses that data to recommend relevant content,

people, and places that you have not yet seen in the community. The more you and others interact in the

community, the better the recommendations you'll receive.

Look for these recommendation widgets in the Top & Trending stream when you're cruising through your

News page:

• Recommended Content

• Recommended People

• Trending Content

• Trending People

You can also click on any of the browse menus (People, Your Places, and Your Content), and then click

the Recommended tab on the left.

Note:  Jive recommendations obey all content permissions and will not recommend content that

you don't have permission to view. Therefore, you may not see the same Trending Content or

Trending People as others, depending on your content viewing permissions, when you logged in,

and when the last data collection occurred. Your Recommended Content, Recommended People,

Trending Content, and Trending People will change based on your shifting interests, affinities, and

even changes in the org chart.

Browse and Filter Content, People, and Places
Zero in on the information you need by filtering as you browse Content, People, or Places.

People is in the top navigation menu, but you can start browsing Content or Places by selecting Your

Content or Your Places in the menu under your avatar.

Using the Filter Keyword Search

Start by typing a keyword in the text box and waiting for the results to refresh.

Keep in mind that every browse page includes a set of filtering tabs on the left and across the top which let

you refine your search criteria. For example, when you browse content you can choose whether to browse

everything, or only content you authored or participated in as you can see in the following image.
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The icons at the top of each browse page let you filter by content type.

Refining Your Filter Results by Type

As shown in the following graphic, you can limit your view by selecting certain types of information. For

example, you can limit content to just blog posts or discussions. You can even filter by actions or outcomes

marked on content. For instance, you can filter to see only content marked Official. Place browsing can be

narrowed to just spaces, social groups, or projects.

 

 

You can use the keyword, tag, and filter options to refine your search even further. (Tag filtering only works

if the content is tagged.) For example, here are two ways you might look for last April's East Coast sales

report:

• Select Your Content from the menu under your avatar, change the filter to All, and type Sales Report

in the Type to filter by text box. Then click the arrow under "Sort by latest activity" and select Sort by

date created (newest or oldest). By default, the most recent results are shown first.
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• Click People from the top navigation bar and type the Sales Director's name in the Type to filter by

text box. If you don't know her name, try typing in "Sales Director." After you have located the person,

click her name and go to the Content tab. From there, select Authored from the left-hand menu and

Documents from the top menu to show only the documents she wrote. You can filter these further by

keyword or tag if she's an especially productive content creator.

Making Things Easier to Find
Rely on these best practices to make things easier to find for yourself and others.

To help yourself and other people find the content that you create, try the following:

• Put the content in a place where it's likely to be discovered. For example, put it in a group that's open-

access and of interest to your audience to attract the notice of community members who follow that

group. Before you publish new content in a place, you'll be able to see how many people are following

the place, and (if it's a group) how many are members.

• Bookmark content so that you and others can find it simply by browsing bookmarked items.

• Apply tags to the content or add them in the body of the content by using the #, which is a hash or

pound sign, and following it with the tag, such as #tagging_this. Tags give other people a way to find

things based on the ways your community thinks about them. You can even follow tags in your streams.

• As you collaborate on content, make sure you mark it appropriately. Did someone answer your

question? Mark the answer as Correct. Did a document reach a final state? Mark it Final or Official.

Other people can see these outcomes and use them to filter results when searching and browsing.

• Don't forget that you can make yourself easier to find by adding information to your profile that other

people might be interested in. What are you good at? What do you know? Add these to your expertise

list. For more about profiles, see Set Up Your Profile.

Labeling People to Manage them Around the Community
You can name and color code groups of people to make them easier to find when you browse or

communicate with people as a group.

You can create labels to group your friends or connections, the people you follow. You might use this

to group people from a certain location together. For example, if you have a New York office in your

company, you can create a New York label. This will help you find people fast when you have a lot of

connections. When you apply a label to multiple friends or connections, the label becomes a way to show

only those with certain labels. You can even type the label name in when you're creating a direct message

or adding collaborators on a document to automatically include all the people with that label.

To create a label:

1. Browse your friends or connections by clicking People and selecting Following on the left. Remember,

you can only group and label people you're following.

2. Click Create Label in the left pane.

3. Select a color, type the name for the label, and then click Save.
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4. Add someone to that new label group by clicking the gear icon

on their profile card and then clicking the Label People button

.

5. Select the label that you want to apply to the person. (You can remove the label by clicking it again to

deselect it).

6. If you want to delete a label group later, click Browse > Following and then click the Delete label icon

that shows up when you mouse over the label.

What are Role Badges?
If your community administrator has activated role badges, then you'll see small icons next to certain

community user names.

A role badge is an icon used to indicate roles or responsibilities of community users. You might use this to

find someone who can answer a question, or to identify people whose answers you can count on. Mouse

over the icon to see the name of the role.

Here's a list of possible roles for the badges:

• Administrator

• Champion

• Employee

• Expert

• Moderator

• Support

Using Tags
Assigning tags to your content makes it easier for you and others to find later.

Tags are like key search words that you and others assign to content. Tags make it easier to find content

when you or others search for it later. You can assign tags to existing or new content. You can even assign

tags to a status update.

• To assign tags to a status update, type # before the keyword, for example, "Really enjoying that

amazing #presentation about #XYZ customer." Now others will find this update whenever they search

for "presentation" and "XYZ."

• There are two ways you can assign tags to content. You can open or create your content and scroll to

the bottom of the page to the Tags box. Type in the keywords you would use to search for this content.

You can also use inline tagging by adding tags on the fly, as you're editing the body of the content. To

do this, use the #, which is a hash or pound sign, and follow it with the tag. So if you're writing about

your competitor's new corporate branding, you could say, "Company X is resorting to Comic Sans.

#jumpingtheshark."
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Tagging tips Consider using any existing tags that pop-up in the

suggestion box. Existing tags are often assigned to

related content, so it's good practice to use them.

An underscore can help with longer tags such as

sales_report or employee_benefits. Note that if

you are tagging content that is being moderated by

an admin, your tags may not show up right away

because content updates may need to be approved.

Speed up tagging You can speed up tagging by changing your user

preferences. To enable on-the-fly tagging, click

on your avatar in the upper right corner and then

Preferences. Turn on Quick Tagging Mode and

then click Save.

Following a Tag
Follow tags to discover new areas where you can become involved and stay informed.

Tags can generate more participation and collaboration by helping people find your content. Create custom

streams that include people, places, and tags so you can fine-tune the stream's content. Following tags in

custom streams helps bring you relevant information from uncommon sources.

For example, if you're in the accounting department, you'd probably add the VP of Finance and the

Accounting Group to your Accounting stream. But also think about adding tags like #money, #pay, #taxes

to direct content into your stream that you wouldn't normally come across.

To follow a tag, create a custom stream and then search for relevant terms. Click Tags to see all tags that

relate to that search term. Click Add to include tags in your stream.

Note:  When you follow a tag, only content that's been tagged with that tag sometime in the

previous 180 days will show up in your custom stream.

Using Bookmarks
Bookmarks help you keep track of your favorite content over long periods of time. You can bookmark

content inside or outside of your community.

You can bookmark any content in the community, and even sites outside the community. When you

want to look at that content again later, you can go to it quickly by clicking in the search box at the top

of any page and selecting Bookmarked. You'll see a list of your recent bookmarks. Clicking Show all

bookmarks at the bottom of the list lets you toggle between a complete list of Your bookmarks and All,

which shows public bookmarks from everyone in the community. (You won't see bookmarks created for

content that you can't access, such as documents in a private group.)
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Bookmark Content Inside Your Community

To bookmark content stored inside your community, navigate to the content item and then click Bookmark

in the right menu.

Bookmark Sites Outside of Your Community

To conveniently bookmark sites outside of your community, add the "bookmarklet" tool to your web

browser. The bookmarklet tool allows you to bookmark external sites and bring them inside your

community.

To install the bookmarklet, click in the Spotlight Search box and then select Bookmarked > Show all

bookmarks > Click to install in the left sidebar. Then simply drag the Add Site button onto your browser's

toolbar.

To bookmark a site outside the community, click Add site to community in your browser's toolbar and

then add your notes and tags. You can use the bookmarklet link to bookmark any content as you browse

the Web. In other words, you don't need to be using Jive to save and share bookmarks in your Jive

community.

You might also be interested in learning about Jive Anywhere, which allows you to socialize things in your

Jive community that you've found on the Web or even in other applications. (Your community may not

include this additional module by default.) See Jive Anywhere Help for more information.

Using the History and Suggestions Features
Click in the Spotlight Search field to see pages you've recently or frequently viewed in the community.

The History and Suggestions tabs in the Spotlight Search area show the Content, People, and Places you

have recently visited (History) or frequently visited (Suggestions) in your community. For a more detailed

listing of items in your history, click Show all my recently viewed content. From there, you can sort your

items by date or use a keyword search to filter them.

Can't Remember the People, Place, or Title?
Sometimes you can't remember the title, people, or place of something you know you saw. In that case, try

this search method.

For example, you remember participating in a discussion during the last three months about how to

increase customer survey participation, but you can't remember the discussion title, which space the

discussion occurred in, or the other participants. Use the Spotlight Search at the top right and type in

keywords such as "customer survey". Click View all Results and then click Discussions in the top menu

because you don't need to see results from blogs, documents, or polls.

Tip:  Still can't find the discussion? Is it possible it wasn't a discussion that you remember? Next

you might try looking in the comments of documents or blogs.
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Getting More Out of Groups
Social groups help you bring people together around shared interests, ideas, and projects.

Use these topics for learning how to create and manage social groups in Jive.

How Do I Create a Group?
Creating a group enables you to set up an area where like-minded people can put their heads together and

share information on the group subject. You must have special permissions to create a group, which are

set by your community administrator.

Before you create a group, you may want to consider the purpose of the group, what kind of information

needs to be included, who will participate, and how people who need to know about it will find it. The way

you name the group and the tags you assign it are different ways you can make it available to people who

might be interested. See the Group Creation Options topic for ideas about the important choices you need

to make when deciding on a group setup.

Creating a Group

Group options are described in more detail below.

1. Click

 > Group.

2. Give your group an identifying name. You won't be able to create a group with the same name as an

existing one: a green checkmark next to the field indicates the name is unique.

3. Enter a brief description to appear in the user interface. For example, your RFP Collaboration group

could say "Look for the latest RFP templates and materials here."

4. Choose a group type. Group types limit who can see your group and/or its content without an invitation.

For more details, see Types of Groups on page 53.

5. Select tags that can be used to find this group. For example, a Sales group might use the following

tags: RFPs, sales_videos, wins, and so on.

6. If your community administrator has set up categories to identify places while browsing, you can select

some categories to associate with the place.

7. Decide whether this group should allow its users to share and collaborate on individual pieces of group

content, without granting them group access. Note that this option only works for Private groups.

8. Decide whether this group should extend activity to "external users"--users from outside your

community you'd like to collaborate with. This option is typically applied to Private groups.

9. Click Advanced options to expose more options. (Advanced options are described in detail below).

10.If you click through without selecting Advanced Options, your place will use an Activity page as its

main page, with the option to add more custom pages. We recommend using an Activity page because

it can be displayed on mobile devices, and because it's more friendly to streaming content. However,
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you may want to include an Overview page with widgets. You do this by clicking Advanced Options

and choosing one of the two options that include an Overview page. If you select Activity + Overview

Page, you'll need to specify which page will be the landing page for the place.

11.If you want to apply a customized place template to this place, click Preview and browse templates.

If you don't choose a template, just click Preview: the place will use the default template, Team

Collaboration. Place templates determine which tiles and streams will be included in your group's

Activity page (which you can further customize). Choose the one that's right for the kind of collaboration

that will happen in the place you're creating. You might want to read more about Using Place

Templates.

12.Optionally, click Place Image and Banner Design to configure the visual presentation of your place.

13.Click Create Group.

Create Group Page

Template Determines what data tiles and streams make up

your group's Activity page. By default, your group

will use the General Collaboration Place Template.

However, there is a wide range of templates

available for specific collaboration tasks. See Using

Place Templates and the associated reference

topics for more information. If you don't like the

template you've chosen, you can always change it

later.

Name The name you want to show up at the top of the

group page. This will be used at the end of a URL

that links to the group. (You can change the URL by

clicking the Edit link.)

Description The information about the group shown on the

group's main page. Capture what the group's about

in a way that will attract other people who might be

interested.

Type Choose a group type that will determine whether

your group can be seen by others and whether they

can participate. For more information, see Types of

Groups on page 53.

Tags Tags are words or short phrases that will help other

people find your group. Use tags that describe your

group's focus. To enter multiple tags, press Enter

after each word or phrase.
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Categories If your community manager has set up categories

that help to classify places so they're easier to find

when browsing, you can select some categories to

apply.

Extend Visibility You may be able to create a group that's open

for collaboration with external contributors. This

option is only available to secret and private groups,

and external contributors must be invited by a

standard user who belongs to this group. You can

also enable members in a private group to share

individual content items (without granting access to

the group itself) using non-member content editing.

Advanced Options

Place Navigation Use this setting to determine whether you want

to use a tile-based Activity page, a widget-based

Overview page, or both. For guidance, see Tile

Pages Versus Widget Pages on page 52.

Content and Activity

External Storage If your administrator has enabled a connection

with an external storage provider such as Box,

Dropbox, SharePoint, or Google Drive, you can set

your group to synchronize document storage to that

provider. Files that are uploaded to the group will be

stored in external storage, rather than in Jive, and

files can be added, deleted, or modified from either

side.

Note:  For Box users: although you can

connect an Open group to a Box folder, only

community members who have joined the

group will be able to see Box documents

and have their comments reflected on the

Box side. Because of this limitation, it's

recommended to use the Box external

storage only with Members Only, Private, or

Secret Groups.

Group Features and Activity Select which types of content will be available to

group members, such as blog posts, documents,
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and so on. This list also controls what shows in the

Content tab of the group, as well as what content

types you can use to filter the Content tab.

Group Creation Options
Creating a group always starts with clicking Group in the Create menu, but it helps to understand the

options that can help your group do what you want it to.

For deciding whether to use an Overview or Activity page, you should also see Tile Pages Versus Widget

Pages on page 52.

I want to. . . You should. . . Can I change this later?

Collaborate in private by limiting

who can see what's in my

group, or even who can see

that my group exists.

Choose a Private or Secret group

type during the initial setup. You can

change this setting later. See Types

of Groups on page 53.

Yes. Keep in mind that changing

this setting changes the visibility

setting for all the group's content.

Design a landing page that's

optimized for a specific work

purpose.

Choose Activity + Pages or

Activity + Overview from the

Advanced Options during the initial

setup, then choose and configure

a Place Template customized for

the kind of work you want to do.

See Place Template Reference on

page 145. Place Templates only

apply to Activity pages, and not to

Overview pages.

Yes, but if you start with Activity

+ Pages and change the setting

later so Overview is enabled, any

custom pages you created will be

invisible.

Design a landing page with

widgets (but no additional

pages)

Choose Overview or Activity

+ Overview from the Advanced

Options during setup, and fill out

a widget layout under Manage >

Overview Page from the group

page.

Yes.

Make more custom pages in the

place for displaying information,

not just a landing page.

Choose Activity + Pages from

the Advanced Options during your

setup, and then add the pages to

your place afterward. See Adding a

Custom Page to a Place.

Yes, but if you change the setting

later so Overview is enabled, any

custom pages you created will be

invisible.
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I want to. . . You should. . . Can I change this later?

Integrate external streams from

Facebook, Chatter, or any other

apps your community admin

has enabled.

Choose Activity + Pages or

Activity + Overview from the

Advanced Options during the initial

setup, then click Add a stream

integration when configuring the

Activity page.

Yes, but keep in mind that some

external stream types cannot

be disconnected from the group

except via a Support call.

Limit the kinds of content that

can be included in this place.

During place setup, after you

preview the group, edit the Features

and Activity settings.

Yes.

Store this place's binary

documents outside Jive, for

example in Box or SharePoint.

During place setup, after you

preview the topic, edit the Features

and Activity settings. You'll only

see options other than "No external

storage" if your community admin

has enabled another external

storage type. See Groups with Box

Storage on page 58.

Yes, but if the place is later

disconnected from external

storage, users will see references

to documents that they can't

access from Jive anymore.

Make this group a place for

collaborating with people

who aren't members of the

community.

Make the group Private or Secret,

and select Externally Accessible.

See What Are External Groups? on

page 118

Yes. Changing the Externally

Accessible setting will remove

access by non-members, but

their contributions will stay in the

group.

Make sure people can find the

place.

Add tags and/or categories in the

About settings of your place.

Yes. Just remove the tags or

categories.

Tile Pages Versus Widget Pages
In some cases, you may need to choose between designing pages based on widgets and pages based on

tiles.

When you're setting up a new place, you can choose to enable an Overview page, which uses widgets,

or an Activity page, which uses tiles. Place templates, which are customized for specific kinds of

collaboration, always use tiles. Tiles use newer technology and are mobile-optimized; widgets cannot

be displayed on a mobile device. Keep in mind that if you disable the Overview page in a place, you can

choose to add additional tile-based custom Pages, which let you spread out your content over multiple tabs

with less content (and thus better mobile usability).

Use widgets when:

• You are configuring a community home page for desktop users. (Widgets are your only choice here.)
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• You're setting up a Jive-x community and you need to take advantage of the customer service widgets

set.

• You have an Overview page you created in an earlier version of Jive and you're not ready to change the

look and feel of the place.

• Your community or the audience of your Place doesn't rely heavily on mobile usage.

Use tiles when:

• You are configuring a community home page for mobile browser users. (Tiles are your only choice

here.)

• Your community or the audience of your Place relies heavily on mobile usage. (For example, many

sales teams operate remotely.)

• You need to bring streamed content, such as a Chatter or Facebook stream, into your place from

outside the community.

• You want to include custom pages as well as an Activity page in a place. (To use the Pages feature in a

place, you need to disable the widget-based Overview page in that place.)

Types of Groups
A group's type (open, members only, and so on) determines who can join, see content, participate, and

invite new members. Use the following table to help you understand the different types of groups that can

be created in the community.

Unlike spaces, which use permissions to determine access, social groups rely primarily on membership

to determine access. You need permission to join a group if it is private or secret. Because groups do not

exist inside spaces, they do not inherit any space permissions.

Group owners and community managers can change the settings for a group after it is created.
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How Do I Customize My Group's Home Page?
If you're a group owner or administrator, you can use either a tile-based Activity page or a widget-based

Overview page to lay out an effective landing page that includes the information and images you want

people to see when they visit the group.

If you are a group owner or administrator, you can choose a tile-based or widget-based layout for your

group. See Tile Pages Versus Widget Pages on page 52 for more information about which one is right

for your group. You can then customize the tiles or widgets with your group's information and any images

you want to feature. The layouts are fairly intuitive, but see Designing Activity Pages for Places on page

143 and Designing Place Overview Pages on page 162 for much more detail about these kinds of

pages and how to use them effectively.

If you don't need a highly specialized experience for your group's overview, the default choice is an Activity

page with the General > Team Collaboration Place Template selected.

To change the way your group looks after it's been created:

1. To customize the banner and the inset image in the header, click Manage > Settings from the main

page of the group you want to customize. Then click Banner Design or Place Image to select new

visuals for the header. You can only do this for groups you own.

2. If you're customizing a tile-based Activity page, you can configure any of the tiles in your current place

template from here by clicking the gear icon at the top right of any configurable tile. (Tiles without an

active gear icon are automatically populated, so there are no configuration options available for those

tiles.) To configure a tile, click the gear icon, make your changes, and then click Apply. You can also

move tiles around, add them by clicking Add a tile, or remove them from your template.
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3. Optionally, you can select a new Place Template from the Browse Templates menu at the top of the

page. Keep in mind that if the page has already been customized, changing the Place Template will

remove any configuration in the existing tiles, and could change the group type.

4. When your Activity page is the way you want it, click Save at the bottom of the page.

5. If you want to customize an Overview page with widgets, you can change your layout and design by

clicking Manage > Overview Page from the main group page. Then select a layout and drag and drop

the widgets you want onto it.

How Do I Invite People to Join a Group?
As a group administrator or member, you can invite people to join groups. Keep in mind that if you're using

Jive as an internal corporate community, people from outside the community might not be able to join your

group.

Any group member can invite any other user to join a group. If the group is private or secret, the invited

user must accept the invitation. A group administrator must then approve the request to join the group. If

it was a group administrator who originally sent the invitation to the private or secret group, the approval is

automatic. Be sure to read Types of Groups to understand how a group's type affects the content visibility,

participation, and invitation permissions for group members.

As a group administrator, you can delete or resend invitations while managing group membership. This

can be handy if you've got a lot of outstanding unanswered invitations. Go to your group's main page, then

click Manage group members. On the Manage group members page, click the Open Invitations link

and select the names of people whose invitations you want to delete or resend. Use the drop-down menu

above the list to select the action you want to take.

To invite people to join your group:

1. Navigate to your group.

2. In the Actions menu, select Invite.

3. Enter the Jive user names or email addresses of people you want to invite. If you can't remember them,

you can do two types of searches:

• To invite several people from your email address book, browse your contacts by clicking the browse

icon. Select the people you want to invite, and then click Add selected people.

Note:  You can also paste in a comma-, space-, or semicolon-separated list of addresses

exported from your email application.

• To invite only those with certain skills, click Search by skill to browse people by their skills. Type in

the skill you are looking for, or select a popular one. Select the people you want to invite, and then

click Add selected people.

4. Edit the message you want potential group members to see with their invitation.

5. Click Send Invitation.
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Posting a Status Update in a Group
There may be times you want to limit your status update to only a specific group in your community. When

you post a status update to a group, only members and/or people following the group will see the update

in their attention streams. If the Overview page of the group includes the Recent Activity widget, the status

update will be displayed there as well.

To post a status update for a group:

1. You can create a group update from either the News page or the group's Activity page.

Note:  Some groups do not use Activity pages.

• Activity Page:  Go to the Activity page for the group where you want the status update to display.

• News:  Click Change next to your community name, and then select or type the name of the group

from the group picker.

2. Type your status update in the What's going on? box next to your avatar.

3. Click Post.

Enabling Non-Member Content Editing
Private group owners can configure their private group so that group members can share specific

documents and discussions with non-group members. This allows non-group members to help review or

edit private group content, but does not allow them to see any other content items that live in the group.

To enable this feature, your community manager will first need to enable non-member content editing for

private groups in your community.

To enable non-member content editing in your private group:

1. Go to the private group that you own and click Manage > Settings.

2. Click the pencil icon next to the group's name in the header.

3. Be sure that Group Type displays Private.

4. Select Non-Member Content Editing. If you don't see this option, you'll need to ask your community

manager to enable non-member content editing in private groups.

5. Click OK and then Save your changes.

Sharing Content with Non-Group Members
If your private group is configured for non-member content sharing, as a group member, you can share

specific documents and discussions from the group with non-group members. This is useful if you need a

non-group member to help you review and edit a document or discussion. Your community administrator

and/or the group's owner may need to enable this feature for you, depending on how your community is set

up.

To share a document or discussion with a non-group member:

1. Go to the document or discussion that you want to share.

2. Click Share in the right sidebar.
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3. Enter the name of the person you want to share the item with. (If the person is not a member of the

community, you'll have the option to send them an invitation to join the community or just send them a

PDF of the item.)

4. Select Grant this user access to this content only. Or, you can send the person a PDF instead.

5. Click OK.

6. You can type a note for the person in the Message box, or do nothing to use the default text provided.

7. Click Share.

You'll see a green bar at the bottom of the screen letting you know the Share was successful. You'll also

see an orange bar that lets you know the item is visible to non-group members. Click the link to see which

non-group members the item has been shared with.

Sharing Content with Other Places
In the same way you can share content with people, you can share it with one or more places. This feature

may not be turned on if you're using an externally-facing community (typically those serving customers,

partners, and vendors).

To make life easier for people who tend to focus on certain groups, spaces, or projects, you can share your

content with their place even if you originally post it in your team's place. When you share content with

another place, it will show up in that place's activity stream. Anyone following the place where the content

is shared will receive a notification in the stream.

This is a great option for the Documentation team, who might be posting a discussion in their own

Documentation group for feedback, but they also want to get the subject matter experts to review the

content, so they go ahead and share the discussion with the Feature Team's group so that team sees it

along with specification documents and feature wireframes.

To share content with multiple places:

1. Go to the piece of content you want to share, such as document, blog post, status update, discussion,

and more.

2. Click Share in the right sidebar.

3. Enter the name of the place you want to share the item with, or use the place picker to navigate to and

select the place.

Note:  People who don't have access to the original content will not have access to the shared

one either. For example, if you post a Contact List document in the Human Resources group,

and there are some Engineering managers who have access to the Human Resources group,

but they spend most of their time in their Engineering group, you could share the document with

the Engineering group, which is open, and know that only the managers can search for and view

the Contacts List document.

4. Add more places if you'd like.

5. Type a little note about the share in the Message box, or do nothing, which uses the default text

provided.
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6. Click Share.

You'll see a green bar at the bottom of the screen letting you know the Share was successful. At the top,

you'll see the places it has been shared with so you can keep track. Click the x other places link to see

which other places the item has been shared with.

Groups with External File Storage
If your administrator has connected your community with an external storage provider such as Box,

SharePoint, or Google Drive, you can take advantage of file storage and synchronization for groups where

this is enabled.

When you create a group, you may have the option to connect it to a different storage provider than the

default configured when your community was set up. (Typically, the default is a binary storage archive on

a server that's part of your Jive installation.) Using external file storage means that when a user uploads

a document, it's stored with a third-party file storage service instead of directly in Jive. Files can then be

automatically synchronized in both directions, which means you can add or update them from either side.

If the storage provider has comment functionality, comments are also synchronized with comments in the

group.

Note:  Attachments to Jive are not stored in external storage.

Groups with Box Storage

If your administrator has connected your community with a Box.com file store, you can take advantage of

file storage and synchronization with Box for groups where this is enabled.

When a user uploads a document, it's stored in Box instead of the regularly configured binary storage

location. (Attachments are not stored in Box.) Files are automatically synchronized in both directions, and

so are comments and replies, so users can interact from either the Jive side or the Box side.

To take full advantage of the linkage, users should join the Box-linked group. This allows users to

interact with Box-linked content under their own user accounts and synchronize comments correctly to the

Box side. Otherwise, their interactions will be posted by a system user called the Jive Integration User, and

their comments will not be visible on the Box side.

Note:  For Box users: although you can connect an Open group to a Box folder, only community

members who have joined the group will be able to see Box documents and have their comments

reflected on the Box side. Because of this limitation, it's recommended to use the Box external

storage only with Members Only, Private, or Secret Groups.

Modifying Files in Box

Files can be modified on the Box side by any user who has a Jive account and rights to the group-linked

folder in Box. In addition, file comments made in Box will be synchronized and displayed in the Jive group.

Note:  There is a known limitation for files that have been deleted from Box and then restored

on the Box side. Restored files will not be synchronized to Jive when they're restored. However,

uploading a new version of the file to the Box side will re-add the restored version as well as adding
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the new version, resulting in two added files. Re-adding the file from the Jive side will initially return

a generic error, but the second upload attempt will succeed.

Groups with SharePoint Storage

If your administrator has connected your community with a SharePoint storage site, you can take

advantage of file storage and synchronization with SharePoint for groups where this is enabled.

When a user uploads a document, it's stored in a SharePoint site instead of the regularly configured binary

storage location. Files are automatically synchronized in both directions, and so are comments and replies,

so users can interact from either the Jive side or the SharePoint side. Users can also search inside the

SharePoint site without leaving Jive.

For detailed information about using a SharePoint-linked site, see the Jive for SharePoint documentation.

Groups with Google Drive Storage

If your administrator has connected your community to a Google Drive storage site, you can take

advantage of file storage and synchronization with Drive for groups where this is enabled.

When a user uploads a document, it's stored in Google Drive instead of the regularly configured binary

storage location. Files are automatically synchronized in both directions.

Getting More Out of Content
Content is the bread and butter of Jive, so learning to create, promote, and manage it effectively is a

cornerstone of Jive collaboration.

Creating Content
Choose a content type based on your collaborative goals.

Click

to draft a discussion, document, blog post, or another type of content in Jive, or select any of the content

type links at the top of a place's activity page. Note that you may not see the Create menu if your

community manager has not enabled the feature.

Most collaborative activity occurs in discussions and documents. Blog posts are typically used for viewpoint

essays and other long-form communications that don't invite collaboration. For a more detailed analysis

of the differences between these types of content, see What's the difference between a document, a blog

post, and a discussion?

Private and Public Content

By default, content you create is public in the community and searchable. The power of Jive is that

everyone in the community can benefit from shared content. However, in some cases, you may want to

limit who sees content and who can collaborate on it with you. For more information about deciding who
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can see and collaborate on your documents, see Getting more out of documents. For more information

about private discussions, see Getting more out of discussions and questions. Or, you can choose to

publish your content in a private social group that limits content to approved members.

For more information, you might want to read the help topics starting with Public and Private

Communication.

Monitoring Your Content

You'll automatically follow all content that you create, so you'll receive an update in your Inbox whenever

anyone responds to your content or, if it's a document, changes it. You can also delete any comments on

your content, as well as delete the content entirely.

Earning Status Points
Create and respond to content in Jive and earn status points in the community.

The success of your community depends on your contributions, so you are rewarded with points for getting

involved. Over time, you develop a reputation for reliability and authority in your favorite areas. The more

people participate, the more information that is available for the community as a whole. You can become a

top participant in your community by earning the most status points.

To find out how many points you have, do one of the following:

• Hover over your name from any content item in the interface. In the pop-up profile card, you'll see your

Current Points and Current Level status icon.

• Go to a Latest Acclaim notification in your Inbox. Scroll down through the notification to see your points

and how you rank in a list with other community users.

Note:  The Top Participant widget shows your status points for your activity in that place only.

Therefore, you may notice that your points vary from place to place in the Top Participant widget.

Because each community can be set up differently, you should ask your community administrator for

details on status points. What activity is rewarded, status levels, and points awarded may vary. Depending

on how your community is set up, you may earn points when you involve yourself in the following types of

activity:

• Post a discussion or question, or respond to one.

• Correctly answer a question.

• Provide helpful information in the replies or comments of documents, discussions, and blog posts.

• Create new documents.

• Create new blog posts.

• Complete new tasks in a project.

• Create a new status update.

• When someone likes your status update.

• When someone shares your status update.
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Note:  When content is deleted, status points are also deleted.

Sharing Content with Other Places
In the same way you can share content with people, you can share it with one or more places. This feature

may not be turned on if you're using an externally-facing community (typically those serving customers,

partners, and vendors).

To make life easier for people who tend to focus on certain groups, spaces, or projects, you can share your

content with their place even if you originally post it in your team's place. When you share content with

another place, it will show up in that place's activity stream. Anyone following the place where the content

is shared will receive a notification in the stream.

This is a great option for the Documentation team, who might be posting a discussion in their own

Documentation group for feedback, but they also want to get the subject matter experts to review the

content, so they go ahead and share the discussion with the Feature Team's group so that team sees it

along with specification documents and feature wireframes.

To share content with multiple places:

1. Go to the piece of content you want to share, such as document, blog post, status update, discussion,

and more.

2. Click Share in the right sidebar.

3. Enter the name of the place you want to share the item with, or use the place picker to navigate to and

select the place.

Note:  People who don't have access to the original content will not have access to the shared

one either. For example, if you post a Contact List document in the Human Resources group,

and there are some Engineering managers who have access to the Human Resources group,

but they spend most of their time in their Engineering group, you could share the document with

the Engineering group, which is open, and know that only the managers can search for and view

the Contacts List document.

4. Add more places if you'd like.

5. Type a little note about the share in the Message box, or do nothing, which uses the default text

provided.

6. Click Share.

You'll see a green bar at the bottom of the screen letting you know the Share was successful. At the top,

you'll see the places it has been shared with so you can keep track. Click the x other places link to see

which other places the item has been shared with.

Who Sees My Stuff?
In Jive, People post Content in Places. This means that all content (discussions, documents, blog posts,

and so on) are published in a "container" place (space, sub-space, group, or project). All places have
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visibility permissions set by the place's owner(s) that determine who can see the content posted in that

place.

Create Hidden Content

In addition, each user has his/her own "personal container." Content that you set as Hidden before you

publish it is stored in your personal container and is private to you. When you publish Hidden content, only

you will see it as a content update in your streams; other users will not. You might want to read How Can I

Create a Document Just for Myself?

Note:  Externally-facing communities (those serving customers, partners, and vendors), do not

have this feature.

Limit Content to a Few People

Alternatively, you can publish something in your personal container and select to show it only to Specific

People whom you designate before you publish. In that case, only you and those other people can see the

content and only those people will see it as a content update in their streams.

Limit Content to Multiple Places

You can also publish in one place and share it with other places. As long as people have access to view

the original content, they'll also be able to access it from the place you share it with. They can find it in the

Content tab for that place.

Limit Discussions to a Few People

You can publish discussions so that only a few people can see them.

Save a Document or Blog Post as a Draft

Another handy feature is Save As Draft which allows you to share a draft of a document or blog post with

one other person or more before you publish it. This is helpful for working together on a document or blog

post before you publish it for a larger audience. Drafts are not visible in any streams.

What's the Difference Between a Document, a Blog Post, and a Discussion?
Documents, blog posts, and discussions have different purposes and rewards.

Documents, blogs, and discussions were born and raised on the Web, so you use them in Jive as you

would there. The following table suggests ways to think about these content types.
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Documents Blog Posts Discussions

Purpose Collaborate with

others on a single

document; capture

information that

should be available

for a while; create a

report, agenda, or

meeting notes. See

Getting more out of

documents.

Express a point of view; call

something to others' attention;

make a proposal to get feedback

from others; ponder an idea. See

Getting more out of blogs.

Ask the community a question;

ask for suggestions; make a

short observation or assertion

to get feedback; report a

problem. See Getting more out

of discussions and questions.

Format Most of the content

is in the document

itself; comments by

readers and authors

are appended.

Most of the content is usually

in the initial post, with reader

comments appended.

Most of the content is in the form

of replies to the initial question.

Style Somewhat formal,

often in the third

person.

Informal, usually in the first

person.

Informal, usually in the first

person.

Stream

Updates

Whenever the

document is edited

(and "minor update"

isn't selected), and

whenever comments

are added.

Whenever comments are added.

Edits to a blog don't trigger an

update.

Whenever replies are added,

and whenever an answer is

marked as Correct or Helpful.

Status Update Tips & Tricks
Status updates let you interact with others in the community. You can also delete your own updates, see

who liked them, see other people's updates, and several other fancy things.

Interact with Others from Status Updates Comment on, share, follow, or repost a status

update by clicking any of these commands in the

footer of the update (yours or others'). This is a fun

way to engage with other community members.

Limit Your Status Update to a Specific Group Share your update with only a specific group by

clicking Change beneath the status box and then

selecting the group before you post. When you

post a status update to a group, only members

and/or followers of that group will see the update

in their attention streams. If the overview page of
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the group includes the Recent Activity widget, the

status update will be displayed there as well.

Delete Your Status Update Delete your own update by going to your Inbox

and clicking on the time stamp in the update

(for example, "posted 2 hours ago"). From the

permalink page, click Delete. You can also delete

an update by going to your user profile and clicking

Activity > Status Updates. From there, click the

update's time stamp, and then Delete.

See Who Liked Your Status Update Click the number next to Like in your status update

to see the people who liked it.

Use Tags in Your Status Updates Insert one or more tag(s) in your update by

preceding keywords with a hash or pound sign (#)

so that you and others can find the update more

easily later. For more on tagging, see Using Tags

on page 45.

Filter by Status Updates Filter any of your attention streams by selecting

Filter > Status Updates.

See Someone Else's Status Updates Click a person's avatar or name from any of your

attention streams, or search for the person from the

People finder or spotlight search box. Click on the

person's name to go to their profile page, then click

Activity > Status Updates.

What are Categories?
Categories associate content with keywords for easier searching later.

Content categories are words or phrases predefined by administrators within a particular place (a space or

social group). If there are categories available in the place, it usually means that the place's administrator

has given thought to how that place's content should be grouped. An administrator who creates a category

can optionally associate certain tags with it behind the scenes. (These categories are used only inside a

single place, and are different from the Place Categories that are used to tag and find groups, spaces, and

projects.)

How Do I Apply Categories?

You can assign categories to your existing or new content.

To assign your content to categories:

1. Open the content for editing and scroll to the bottom.
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2. Beneath the editing window, under Categories, you might see a list of categories that have been

defined for the place in which the content lives. Select check boxes for the categories in which your

content seems to belong.

How Do I Create a Poll?
Use polls to get instant feedback on a question.

A poll is a fast and fun way to ask a multiple choice question in the community. When you create a

poll, you define the question and the possible answers. For example, you could create a poll asking

the community if your team should change a workflow process or create a bagel day on Fridays. A poll

appears on the home page of the space it's created in. As people respond to the poll, results are shown

graphically as colored bars. (A person can vote only once in the poll.)

To create a poll:

1. Click

 >

Poll.

2. Give the poll a title and description. The title will appear above the list of options in the published poll,

so you should use it as the poll's question. For example, "Where should we have the holiday party?"

The description will appear on the page that lists the poll's full results.

3. In the Choice 1 and Choice 2 boxes, type in answer options. For example, choices for the holiday party

poll might be, "In the office," "In a restaurant," "At someone's house," and so on. You can also add

choices.

4. Select a place in which to publish the poll.

5. Add any tags to the poll so it will show up in searches.

6. If set up in the space, you can select the Category to which this poll belongs.

7. To change the publish and end dates of the poll, click Advanced Options > Change voting options.

You can set the date you want to publish the poll (immediately or a specific date) and when you want

voting to end (on a specific date, in X amount of days, or manually).

8. Click Create.

How Can I Create a Document Just for Myself?
Create a Hidden document to keep it private. Later, you can change the visibility to include other people if

you need to.

Note:  Externally-facing communities (those serving customers, partners, and vendors), do not

have this feature.

You can create documents that are visible only to you. To do this, click

 >

Document (or Uploaded Document. When you finish, click Hidden in the visibility options before you
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publish or save as a draft to ensure no one else can see it. To see your Hidden document later, go to

Content > Authored in the main navigation menu and then filter by Documents. From there, you can edit

your document and keep it hidden, or you could make it visible to other users by changing the visibility

options before you publish the document.

To understand which content types can be hidden, limited to specific people, or public, see Content

Visibility Options on page 113

You can also keep bookmarks private if you don't want others to see them. In addition, if you assign

yourself a personal task, no one else can see the task.

How Do I Use the Save Draft Feature?
Use the Save As Draft feature to quickly jot down and save your thoughts in documents or blog posts.

Then, you can come back later to edit and publish your content. You can also collaborate with others on

saved drafts before publishing them.

You can use the Save As Draft feature on blog posts and documents. This can be useful if you need time

to marinate your thoughts a little before publishing something. Just create a document or blog post and

click Save Draft. Later, when you want to edit it, go to Content > Drafts to see your all your saved drafts.

From there, filter your Drafts results by Documents or Blog Posts, find and click on the draft, and then

click Edit. You can edit the content and save it again as a draft, or publish it. Drafts are not visible in any

streams.

Collaborating on Drafts

You can collaborate on drafts of blog posts or documents before you publish them. Just create the post

and save it as a draft. From there, click Share in the right sidebar. Select the people you want to share the

post with, include a message for them, and then click Share. The recipient(s) will be able to edit the post

and either save it as a draft or publish it.

Getting More Out of Profiles

Use your profile to express who you are to your community. If you have something you want the

community to know about you, add it to one of the cards that can be found here.

Your profile also shows everyone what you've been working on, who you're connected to, the recognition

you've been getting, and the groups you've most recently visited.

Set Up Your Profile

Setting up your profile is the first step to participating in the community.

Your user profile provides community members with an easy way to learn about your experience, skills,

and interests. Your profile shows up in search results when community members search for keywords

contained in your profile. You can update your information at any time.

To set up your profile:

1. Click your avatar in the upper right corner and then click Edit profile.
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2. Click the Avatar & Photos tab to change your photo and avatar. Your photo is a great way for people

to "meet" and recognize you in person. Your avatar lets community members quickly associate your

comments and status updates with a simple visual cue.

3. Click the Your Profile tab and fill in as much profile information as you like. Note that your profile will be

found when people search, so if you have professional roles or interests that would be useful for others

to know about, be sure to include them. You may not be able to edit certain fields, such as username.

Usually the community manager sets up these fields for you.

4. Click Privacy to edit your privacy settings. These control how different types of users see your profile.

For more information on privacy settings, see Securing Your Profile.

5. Click Save.

Using Skills and Expertise

Use the Skills and Expertise card to feature skills on your profile. Endorse others' skills by going to their

profile.

Skills and endorsements not only provide more information about others in your community, they tag

people with those skills, so when you search the community for users, you can filter by skills.

1. Add skills to your own profile, or endorse someone else's skills:

• To add your own skills, first go to your profile by clicking your avatar in the top right and selecting

View Profile. Add your skills by clicking New skill in your Skills and Expertise card.

• To endorse skills for a community user, go to their profile and click New endorsement.

2. Select a popular tag, or create a new one—just type a word or phrase and press Enter to turn it into a

tag. Community users need to accept new endorsements via an Inbox notification before they show up

in their profile. You'll see new skill alerts in your activity once community users approve endorsements.

To back up an existing endorsement, just click the plus sign next to the skill listed in their Skills and

Expertise card.

Securing Your Profile

If you're concerned about privacy, you can limit who sees different parts of your profile by editing your

privacy settings.

1. To edit your profile, click your avatar in the upper right corner and then Edit Profile.

2. Select the Privacy tab.

3. For each profile field, select the type of user who can view it. If you select everyone, then all users can

see the contents of that field. Make sure you don't hide too much about yourself because that's how

others will connect with you. Your community administrator may control who sees certain fields, such as

those without a Visible to... option.

Note:  You can take a look at how others will see your profile by using the Preview your profile

tool to the right. Just select the person whose view of your profile you want to see.

4. Click Save.
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Getting More Out of Discussions and Questions
Use discussions to ask questions or introduce new ideas to the community.

Discussions are a quick way to get an answer to a question or feedback on an idea. You can attach a file

or insert an image, video, or code example into a discussion to better explain your question or idea.

To start a new discussion, click

 >

Discussion. Make sure to check the Mark this discussion as a question box (it may already be

checked depending on the defaults set up by your community administrator). If you don't initially mark

the discussion as a question, you'll have 15 minutes to change your mind after you post (the default is

15 minutes; your community administrator may change that setting). Within that time, you'll see a link to

change your mind in the discussion post.

If you want to transform a discussion into a document, you can save it as a document. For more

information, see How do I convert a discussion thread to a document?

Discussions Best Practices

• By marking discussions as questions, you can easily keep track of unanswered questions in a space by

using the Unanswered Questions widget on the space's home page. See Designing pages with widgets.

• If someone replies to your question with useful information, it's good practice to mark their reply as

either Helpful or Correct. That way, others who have the same question can quickly see which replies

are the most useful. A Helpful reply is on the right track, while a Correct reply answered your question.

Correct and Helpful answers earn status points for their creators. (Note that only system administrators,

place owners, and discussion authors can see the Correct Answer option and only on discussions that

have the "Mark this discussion as a question" check box selected).

• Tag discussions so that others can search for and benefit from them later.

Choosing Where to Publish a Discussion

When you're ready to post the discussion, you'll need to decide how and where to make it visible. Carefully

choosing a space or social group will make the discussion more visible to people who follow the place

where you publish it. For example, publishing a question about technical support in the IT group can

ensure the question is displayed in a stream for users who follow or belong to that group. Your discussion

will also inherit the permissions of the place where you publish it. Therefore, keep in mind that publishing in

a members-only group limits participation to people who are members of the group. If you want community

users to be able to search for and stumble across your discussion, don't publish it in a private group. On

the other hand, if you need a discussion to be confidential, a private group could be exactly the right place.

You can also choose to publish your discussion only to specific people.

What Are Flat and Threaded Views?

From your Preferences page, you can set discussion replies and content comments to display all on one

level (flat) or indented hierarchically (threaded).
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Flat views display comments and replies chronologically in the order they were received, and there is no

indentation between responses. This view can be helpful if you like to see comments in the order they

were made. However, it can become difficult to follow conversations between people when a discussion is

longer than a few comments.

 

 

In a threaded view, you can see which post a person is responding to because comments and replies

appear indented beneath the post to indicate embedded replies or comments. This can help you follow

conversations because responses remain associated together visually, like so:
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To set up your view style preferences, click your avatar in the upper right corner, and then Preferences.

On the General Preferences tab, select your Discussion View and Comment View styles, and then click

Save.

Getting More Out of Documents
Jive is a powerful tool for creating and uploading documents, collaborating on them with others, and

managing versions.

You can create documents in Jive or upload documents from outside of Jive, such as Microsoft Office

documents or Adobe PDFs. (For information about uploading external files to the community, see

Uploading a File.) Documents can be available for viewing or editing only by you, a group of people you

designate, or the entire community. You can also view and manage the changes between versions of a

document, including restoring a previous version so that it is the current version.

To create a document, click

 >

Document and start writing.

Choosing Where to Publish a Document

When you're ready to save the document, you can decide how and where to make it visible.
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Choosing a place such as a space or social group will make the document more visible to group members

who follow the place where you publish it. For example, publishing your schedule document in the Sales

Kickoff Planning group will highlight your planning for anyone who's following that group in a stream. Your

document will also inherit the permissions of the place where you publish it. Publishing in a private group,

for example, limits the viewers of your document to the people who are members of the group. If you want

community users to be able to search for and stumble across your document, don't publish it in a private

group. On the other hand, if you need a document to be confidential, a private group could be the right

place.

Even when you publish your document in a public place, you can still control who can edit it. After you add

the text for your document, scroll down the page and use the Collaboration Options to set the editing and

commenting permissions. You can also specify that another user must approve the document before it is

published. To learn more about this, see Document Approval on page 126.

If you want to be the only one who can see your document, select Hidden. You can add more people as

viewers or collaborators later if you change your mind.

Managing Versions

When a document has been edited and published multiple times, you can view and manage the

differences between versions and delete specific versions, or restore a previous version so that it is the

current version. To manage a document's versions, navigate to the document and then click Manage

Versions. Now you can view the changes between versions, restore a version to be the current version, or

delete a version.

Repurposing a Document

If you want to use an existing document as the base for a new one, the HTML editor can help.

To start a new document using an old one as the base (much like the Save as function some document

editors use), use the following steps.

1. Navigate to the document you want to start with, and click Edit in the Actions menu.

2. At the top of the document window, where the editing settings are, click HTML. This will switch the

document editor into HTML mode and expose the HTML code.

3. In a different browser tab, start creating a new document.

4. Click HTML to put the new document into HTML mode.

5. Select all the HTML in the base document and paste it into the new document.

6. Switch the new document back to the full editor and edit the document before saving.

Uploading a File to Jive

You can upload a variety of files to the community to collaborate on them with others.

Depending on how your community manager has set up your community, you can upload a variety of

external file types such as Microsoft Word documents, Adobe PDFs, and so on. After you have uploaded

an external file, you can view and navigate through a preview view of its pages.
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With documents created from Microsoft Office versions 2003, 2007, 2010 or higher (on Windows) or

version 2008 or higher (on Macintosh), you can:

• Comment inside the uploaded document by clicking the Add Inline Comment button.

• See comments made inside the document.

• If you have Jive for Office, manage and sync the document with the community while working within

Office (Windows only). For more information about this, see Working with Shared Office Documents.

Uploading a file is a great way to include an externally-authored document or track its progress. For

example, you can upload a Word document, then add collaborators so that it gets reviewed by other team

members. Each collaborator can add inline comments to the document while in preview mode in Jive.

(Comments made while editing a document in Office cannot be synchronized with comments made in the

community.)

To create a smooth review and update process without the need to manually remove comments, inline

comments added to a document are associated with a single version, and are removed whenever an

updated version is saved. You can use Manage Versions to look at any comments associated with a

previous version. You may want to mark the document as Final when you're finished collaborating on it.

To upload an external file to Jive, click

 >

Uploaded File, then browse to the file you want. You can make the file available for viewing or editing only

by you, a group of people you designate, or the entire community. If your community manager has enabled

the antivirus feature, there will be a slight delay while the file is being scanned for viruses.

Working with Shared Office Documents

With Jive for Office, you can share your Office documents with others in your online community. As you

make changes to a shared document on your computer, Jive for Office synchronizes the document with the

version that's visible in the community, and provides real-time notifications to users working in the same

document. The notifications tell users that content has changed, plus give them the option to incorporate

the changes into their version using a merge tool. This keeps the content on the community up to date, but

also synchronizes comments, tags, and collaboration settings between the community and your document.

This feature is supported for Microsoft Office versions 2003, 2007 and 2010 running on Windows.

Note:  If you have the appropriate permissions, you can edit everything but the content of a shared

document in the community. In the community you can edit descriptions, tags, and categories, and

you can use an Office program to edit the document content.

What You Can Do

With Jive for Office, you can upload Microsoft Office documents to your community, then keep changes to

the document in sync while you work in Office.

In particular, with Jive for Office you can:
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• Upload Office documents to your community without leaving Microsoft Office. When you upload a

document, the community displays a preview of the document (although it must still be edited using

Microsoft Office).

• Use Jive in the Office toolbar ribbon to:

• Change collaboration options to indicate who can edit the document in the community.

• Create a document for your community.

• View the currently published version of your local document in your community.

• Share your document with others.

• Check for updates to the document.

• Use the Dashboard to:

• See who else is editing the document.

• See how many people viewed the document, who created it, and who’s contributed to it.

• View, add, delete, and reply to comments.

• View and add tags to help categorize the document in the community.

• Edit the document's description.

• View older versions of the document.

• Rate the document, and see how others rate it.

• Browse files similar to the open file.

• Take a look at more files created by the author.

• Rate the document, and see how others have rated it.

Get set up

You'll need the Jive for Office add-in to share documents between Office applications and your community,

which requires Microsoft Windows. If you don't have the add-in, you can get it when you're viewing an

uploaded Office document in the community.

To get the Jive for Office add-in:

1. In your community, navigate to—or upload—an Office document.



 | Using a Jive Community | 74

2. To the right of your document, click the Download Jive Connects for Microsoft Office link as shown

in the following image.

Get connected to your community

After you first install Jive for Office, it might not be completely set up to connect to the community you want

to synchronize documents with. To connect, you need to provide your user name and password.

To get connected to your community:

1. In the Jive menu, click Accounts.

2. Click Add to add your Jive account.

3. Enter the Community URL, which is the exact URL that you use to navigate and log in to your

community.

4. Enter your Jive user name and password.

5. To begin adding documents to the community, see Add a document to the community.

Add a document to the community

To have an Office document appear in the community, you can either add it using Jive Connects for

Microsoft Office or upload the document from inside the community.

To add a document using Jive Connects for Microsoft Office:

1. Connect to the community. For more on this, see Get connected to your community.

2. Open or create a document in Microsoft Office.

3. Click Jive > Publish New as shown in the following image.

Note:  Once the document lives in the community, clicking Publish Update uploads your

changes to the community.



 | Using a Jive Community | 75

 

 

4. In the dialog box, navigate to the place in the community where you want to save the document.

5. Enter the name in the Document Name field at the bottom of the dialog box. You can also add tags to

help other users find your document in the community; provide an optional description; and decide who

can edit your document. You can even change the local file location for your document by editing the

Store At path.

Note:  You don’t need to save your document or changes to your document locally before

publishing to Jive

6. Click Save.

7. To synchronize documents with the rest of the community, see Keep documents synchronized.

Attention:  When you add an Excel spreadsheet to a community, Jive for Office adds a hidden

spreadsheet that contains a copy of the original spreadsheet with additional metadata. This copy is

used to track changes and allow collaborative working on the spreadsheet.

Once the document is added to the community, you can click Jive > Dashboard to display a panel

of information about the document, such as comments, ratings, and the current version number. The

following image shows the Dashboard.
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To add a document from inside the community:

1. From your community, click New > Document.

2. Select Upload a File.

3. Select the location for your document.

4. Click Choose File.

5. Select the file from your desktop.

6. Click Publish. Depending on the size of your document, it might take a few seconds to upload it.

Create a new document from an existing one

To avoid a few steps, you can just upload an existing document and rename it as a new document to

start fresh with in the community. This creates a new uploaded document in the community, leaving

the previous uploaded document in the community as it was when you last synchronized. The new
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document will have the content of the previous one, but won't have its other properties, such as comments,

collaboration settings, tags, and so on.

Note:  Making a new document in this way leaves you with an Office document that has the same

content, but without all of the community-related information. To get the previous Office document

with that information, go to that document's page in your community and click the Download link

beneath its preview.

To create a new document from an existing uploaded document:

1. In Office, open the document you want to start from.

2. Select Jive > Publish As.

3. In the dialog box, navigate to the place in the community where you want to save the document.

4. Enter the new name in the Document Name field at the bottom of the dialog box.

5. Click Publish.

Keep documents synchronized

After you've connected your community to Office, Jive Connects for Microsoft Office keeps your documents

synchronized with the community. Jive for Office does the following:

• Updates the document preview in the community when you save changes to the document's content.

• Updates the Office document comments list with comments made in the community.

• Lets you see updates from others in your community and review them before using them.

• Keeps changes to community-related document properties in sync between the Office application

and the community. When a change is made in one place, it shows up in the other. You can see the

following properties in the Dashboard:

• Tags

• Categories

• The document's title

• The document's description

• Revision activity

• Document's state

To grab document updates from the community:

1. When your document has been updated by someone in the community, you get a real-

time pop-up notification. You can also click Check for Updates if you're feeling impatient.
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2. If there are no changes, a message tells you so. Otherwise, you can select how you want to deal with

the changes:

• Replace my version to accept the newer version, overwriting your own local changes. (You can

also Overwrite Local Version from the Jive toolbar at any time if you want to discard your local

work and start over with the published version.)

• Merge and Review to review which changes you want to use.

• Ignore to continue working without accepting or rejecting changes at this time.

3. When you're done working, save your changes so others in the community can see your recent

changes.

4. If at any time you want to overwrite the current local document with the version on the community, click

Check for Updates > Overwrite local version in the Jive toolbar.

Work with document versions

As you work on a document in Office, Jive Connects for Microsoft Office keeps track of changes, including

community-related information such as comments. It can sync your changes with what's going on in the

community with the click of a button. You can even view the changes that have been made since previous

versions of the document while in Office. You can also save a previous version as the current one.

Note:  The version management feature does its work in part by using the change tracking feature

built into Office. That means that if you download a document that someone has made changes to,

you might see revision marks placed there by the change tracking feature. The document is fine,

but the revision marks can make it hard to read. You can hide the marks in the following ways:

• In Word 2007 or 2010, select the Review tab. In the Tracking group, select Final in the Display

for Review drop-down menu to hide the changes.

• In Word 2003, locate the Reviewing toolbar. In the Display for Review drop-down menu, select

Final.

Work with document revisions

Jive Connects for Microsoft Office creates a new version of a document whenever you save changes to the

document.

To view previous versions of a document:

1. Open a community document. You'll see the dashboard on the right. (If you don’t, select Jive in the

toolbar and click the Dashboard button.)

2. Under Versions, if the version you want to see isn't visible, scroll down to display it. Previous versions

will be listed with the date/time when they were saved. If you mouse over a version, you'll see the name

of the person who published that version.

3. From the list of versions, click the one you want to view.

Note:  You can't save a previous version as the current one. To recover a previous version, open

that version and publish it under a new name.
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Work with document activity

Jive Connects for Microsoft Office displays a list of activity related to the document. This activity includes

versions saved and comments added. By clicking certain items in the activity list, you can add information

to it. For example, You can view and add comments from the Comments tab.

To view document activity:

1. In Office, click Jive and then click the Dashboard button.

2. In the Overview panel, you can see details about the document, such as when it was last edited and

what version you're looking at.

3. Click the arrows next to tags, categories or description to add or edit this information and have it show

up in the community.

4. Click the Comments tab and then Reply to add a comment to the open document. These comments

show up in the community as comments. For more on this see Add a comment

5. You can also browse other documents that the author has created or documents similar to the open

document.

Add a comment

When you comment on a document in Office or the community  (as opposed to adding inline comments

in the body of a document), your comments are synchronized and appear in both places. When you

add inline comments in either location, these comments are visible where they are created, but are not

synchronized or visible from the other location.

There are two kinds of comments for shared Office documents:

• Document comments are like those people make elsewhere in the community. People can usually

comment on shared documents just as they comment on other kinds of documents. These are added

in the community or in Office. You can see these in Office when you go to Jive > Dashboard and then

click the Comments tab.

• Inline comments appear in the document itself. An inline comment is a way to add a comment to a

particular part of the document. When you add an inline comment in the community, it shows up in the

community on the Inline Comments tab at the bottom of the document, as well as in the document

preview, but is not visible in Office. Inline comments you create in Office can be seen in the Review

tab when you select Final Showing Markup in the Tracking group, but cannot be seen in the Jive

community.

To add a document comment:

1. In Office, go to Jive > Dashboard and then click the Comments tab.

2. Type your comment.

3. Click Add.

4. You can also click Reply to reply to an existing comment, or Delete to delete an existing comment.
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Add collaborators

By default, when you use for Office to add a document to your community, the document's collaboration

options are set as follows:

• Only you can edit the document when you save to your personal container.

• Anyone can edit it when you save it to an open place.

You can change these defaults to fit the document needs.

To change collaboration options:

1. On the Jive toolbar, click the Collaboration button.

2. In the dialog box, select the option to set who can edit:

• Specific people—Only the people whose names you choose can make changes. If you select this,

begin typing the person's name in the box beneath Specific people. When their full name appears,

click it to add it to the list.

• Just you—Only you can make changes to the document's content.

• Anyone—Anyone in the community can make changes.

3. Click Update.

Reserving Files and Documents

Marking an uploaded file or a document as Reserved indicates that someone is currently editing it, so other

users won't edit it until the Reserved badge is removed. It does not actually lock the file or document.

The Reserved badge provides important information about file status for anyone who can't use Jive for

Office to edit and merge uploaded files, for example Mac users. It can also be used to warn users off a

published Jive native document that's not ready to be edited by other people yet. (Note that if you want

to hide an in-progress Jive document before publishing it, you can just save it as a draft and share it with

anyone you want to.)

When an author or editor marks a file Reserved, anyone can see who reserved the file and contact the

person if they're unsure whether it's OK to proceed with editing. Anyone with the rights to edit a file or

document also has rights to mark it as Reserved. When someone reserves a file, the author and anyone

who has already edited the document will receive an Inbox notification. You can filter content to find

reserved documents, too.

This feature has a slightly different meaning for uploaded files and Jive documents:

• For uploaded documents, Mark as Reserved warns users who don't use Jive for Office that publishing

a new version could overwrite and invalidate a version someone is working on locally. (Windows users

with Jive for Office have live merge capability and don't need this feature as much.) Currently, marking

a file as Reserved will not lock the document or prevent uploading another version. But any another

user who clicks Edit with the intention of uploading a new file will see a message pointing out that the

file is currently reserved for editing.

• Jive native documents already provide an indicator when someone has started editing a document.

already exists. (However, note the lock on the document while someone is editing only lasts ten
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minutes, and after that it's possible to edit the document and overwrite another user's changes.) Mark

as Reserved replaces the need to put "WIP" or another indicator in the title when a document isn't in a

state where you'd like other users to jump in and edit it. In other words, it shows an author or editor's

intention to keep working on the document undisturbed until the next time that author publishes it.

How to Reserve an Item

To mark a file or document as Reserved, just use the Actions menu to Mark as Reserved. This won't lock

the document, but it will alert other users you are planning to update the item and they should wait or

contact you before editing.

Reserving a document or file is a lightweight way to alert other users you're working on a document. The

Reserved badge doesn't prevent anyone else from editing, but it shows information about who is working

with the item, making it easy for other people to check in with you before adding their own edits. This is

especially useful if you're using uploaded files, but can't use the Jive for Office program for collaborative

editing.

To mark and unmark a file as Reserved:

1. To mark a file or document, go to its page and in the Actions menu, click Mark as Reserved.

You'll see the Reserved badge at the top left of the file preview display area (for uploaded files) or at the

top of the document, with a time stamp indicating who marked it, and when.

2. To unmark the file, use any of the following methods:

• Click the Unmark link at the top right.

• Publish the item. When you or anyone else publishes a new version, the Reserved badge is

removed.

• Mark it as Final, Official or Outdated. These markings override Reserved and the reserved badge is

removed.

Getting More Out of Blogs
Use blog posts to express ideas or opinions and get community feedback. If you've got something to say,

get your blog going!

Use your blog to express opinions, call attention to noteworthy items you've seen (such as an article on

the Internet), or make proposals. Because other people can comment on your blog posts, they are a great

way to pitch ideas that could impact the team or the organization. Of course, you can comment on other

people's blog posts, too.

Your community might include several blogs, each allowing posts from specific people. For example, you

might see "Bill's Blog" (with posts from Bill) or "The Human Resources Blog" (with posts from people in the

HR department). Your administrator creates personal blogs and associates them with particular people

or teams. If you want to see some of the blogs in your community, click Your Content in the menu under

your avatar, make sure All is selected on the left, and then click the Blog Posts button to limit the results

to blogs only. You'll see the latest blog posts from around the community.



 | Using a Jive Community | 82

To start a new blog post, click

 >

Blog post. If you haven't created a blog before, you'll get a choice between setting up your own personal

blog and posting in a blog belonging to a particular place. Place blogs typically relate to the subject matter

of a group or space.

Manage Your Blog

To manage your blog, go to your blog (click your user name in the upper right, then Content; you'll see

your blog listed at the bottom left). From your blog's home page, click Manage in the Actions list on the

right. From here you can create new posts, view and post comments, import content from an external

blog, subscribe to your blog's comments, and set other options. To import content from an external blog

into your Jive blog, click Import from the Actions list. From there you'll be able to upload the external blog

content into your Jive blog.

Importing Content into My Blog

If you have content from another blog that you want to bring into your Jive blog, you can import it by

converting it to Movable Type first.

If you've got a blog in Jive, you can import content from your other blogs. You'll need to first export content

from those blogs into the Movable Type import format. Some blogging tools can do that pretty easily.

Note:  If you export content from WordPress, you might need to do a little editing of the exported

content before you import it. When your WordPress blog posts include HTML tags, the file exported

from WordPress omits tags needed to tell Jive that the HTML is there. You'll need to enclose the

content in <body> tags before importing. Here's an example:

Before

This is my <b>BOLD</b> HTML example.

After

<body>This is my <b>BOLD</b> HTML example.</body>

To import content into your Jive blog:

1. Open your profile by going to the top right and selecting your avatar > View Profile

2. Click Activity.

3. Under Your Blog, click your blog name.

4. Click Manage in the Actions menu.

5. Click Import under Manage.

6. Click Browse to find and select your file.

7. Click Upload File.

https://movabletype.org/documentation/appendices/import-export-format.html
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Creating a Custom Blog Stream

Use these steps to quickly create a custom stream for all your favorite community blogs.

1. First, create your own custom stream and call it something like Awesome Blogs. Save the stream, but

don't add anything to it yet.

2. Now, navigate to a community blog you like. A good way to do this is to go to Content > All > Blog

Posts. When you find a post from a blog you like, click on it, then click the name of the blog post. This

will take you to the home page of the blog.

3. Click Follow, and from the pop-up list, select Awesome Blogs. Every time this blog is updated, you'll

see a stream update. If you set email notifications to On for your Awesome Blogs stream, you'll get an

email every time a followed blog is updated. Note that you will also get an email every time someone

comments on the blog, as well, so you may want to turn email notifications Off for Awesome Blogs.

Can I Tweet into Jive?
You can tweet from Twitter into your Jive community using a special hashtag.

If your community administrator has enabled Jive's Twitter functionality, you can have your tweets show

up in your Jive community by using a special #hashtag in your tweets. You enable this by clicking on

your avatar in the upper right corner and selecting Preferences. On the Twitter Preferences tab, select

Enable. You'll then sign in at Twitter and allow it to access your Jive community. If your community's

special hashtag is not listed on your Twitter Preferences page, you'll need to ask your community

administrator for it.

Using the Content Editor
You can write and format text, create tables, embed images and videos, insert links, and more with the

content editor.

When you create or edit discussions, blog posts, documents, or other content, you use the content editor

built into Jive. You can use either the icons in the interface or keyboard shortcuts to perform basic text

editing operations such as cutting, pasting, undoing, and text formatting. The editor includes many of the

standard features of other word processing programs. Here are some features of the Jive content editor

you may want to explore:

• In-line @mentioning

• Tables of contents

• Tables

• Spell checker

• Code syntax highlighting

In-line @mentioning

To @mention someone while you are typing in the content editor, type the @ symbol (or click the @

button if it is available). A search dialog opens and suggests possible matches. To narrow matches, use

an underscore (_) as a space. For example, @Mike_D would match the Mikes whose last name begins
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with "D." Select the correct match from the list and note the new link in the content editor. For more about

@mentioning, see Shout out to people, places, and things.

Adding a Table of Contents

The content editor includes a feature that automatically generates a hierarchical table of contents based on

the headings in your content. When you insert the table of contents, the editor looks at the headings your

content uses, including their levels (Heading 2, Heading 3, and so on). Based on the heading levels, the

editor creates links to the headings, indenting the links at similar levels.

To insert the table of contents, click Insert > Table of Contents. While you're editing the content, the

presence of the table of contents will appear as an icon like so:

 

 

In the saved or published version of the content, the icon will be replaced with a hierarchical list of links to

headings in your content.

 

 

Working with Tables

The content editor's table feature allows you to create and manipulate tables. Create a new table by

clicking the table icon and selecting the number or rows and columns you want. Once you've got the table
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in place, use the gear icon to move around or add/remove rows and columns. To format individual cells,

rows, or columns, click in a cell and when you see the Edit: Table icon, click it and then select the item you

want to format (a cell, row, or column). You can designate and format headers, change the color of text,

lines, and background, and customize many other settings. Note that when you change the header setting

while making changes in a column, only the header for that column will change, not all of the headers.

In addition, changing the color of text using Table: Format changes the default text color setting for the

selected cell, row, or column. To make text color changes that you don't want to apply as a default to the

cell, row, or column, use the text color icon in the editor's toolbar. When you are finished formatting your

table, simply click away from it and continue editing your document.

Using the Spellchecker

The content editor includes a spellchecker that you turn on when you want to check spelling. When you're

ready to check the spelling in your document, click the  spellchecker button. Misspelled words will be

underlined in red. Click a misspelled word to view suggested alternate spellings and scroll down to select

the best match. Note that the spellchecker does not check spelling as you type. You must turn it on or off

by clicking the spellchecker button. After you have made corrections, click the button again to recheck

spelling.

Note:  You can change the language used for spell checking by clicking the down arrow at the right

side of the Toggle spellchecker button.

How can I use HTML in my content?

The content editor's HTML feature allows you to edit your document in HTML. Click the HTML link in the

editor's toolbar when you want to write directly in HTML. When you're finished, you can toggle back to the

default editor view by clicking Show Full Editor.

Some kinds of HTML markup can cause the site to be less secure. For this reason, certain HTML tags

aren't supported by default. When you use these tags in the code macro, Jive will remove them before

displaying the content. You can include them and they'll be saved, but they won't render when someone

views your content. Here's a list of what's not supported:

Tags: <embed>, <html>, <head>, <iframe>, <link>, <meta>, <object>, <script>, <style>

Attributes: action, class, method, on* (such as onClick), *src*

Code Syntax Highlighting

The content editor's syntax highlighting feature allows you to format programming code so that it renders

correctly in the saved and published versions of your document, blog post, or other content. Supported

code styles are SQL, XML, Java, and Plain text. To apply the code formatting:

• Select the block of text you want to format, then click the >> button and select the formatting style you

want; or,

• Click the >> button and select the formatting style you want, then type your code in the shaded box.
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Using the Marking Feature
Turn a conversation into a real business decision or collaboration success story.

Collaboration and discussion are free-form in your community, but decisions and official versions should be

marked clearly. The marking feature allows you and others to mark items for Action, as a Success, and so

on. Visual badges for these states let others know which document is Final, which comment became the

Decision, or who has Action items as a result of the discussion.

You and other users can mark the replies or comments of:

• Blog posts

• Discussions

• Documents

In addition, users with edit permissions on top-level items can mark the top level as Final, Official,

Outdated, Success, or for Action.
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Your community manager may limit this feature to specific users and configure which marking options are

available in your community.

How Marking Adds Value

Here's an example of how to effectively use the Marking feature in your community.

Let's say the VP of sales has just published a discussion called "Possible Hotels for Sales Kickoff." In the

post, she has included a list of hotels that are available, their amenities, and the pros and cons of each.

She ends her post by @mentioning the Sales Kickoff group and inviting comments and opinions about the

hotels. Over the next few days, over fifty comments are posted to the discussion.

Here's what happens:

1. Two new hotels are suggested. Different thread participants mark those comments for Action

(Actions > Mark for Action) and ask the commenters to provide the hotels' availability, amenities, and

pros and cons. Those comments now have Action Item badges on them. You can click the badge to

see any notes included with the action item.

2. The receptionist replies that she has dealt with Hotel ABC and highly recommends it. (To enlarge the

following image, click on it).

 

 

3. The two new hotels that were suggested are now included in the list, and those actions have been

resolved by their owners (Action Item > Resolve).

4. Based on the receptionist's and others' positive comments about Hotel ABC, the VP of sales decides

that it's the best hotel for the Sales Kickoff. She adds a final comment to the thread explaining her

decision and then marks it as the Decision (Actions > Mark as Decision).



 | Using a Jive Community | 88

5. Now, the VP marks the entire discussion as Final to let future readers know that the post has been

discussed and decided on. At the top of the discussion, the Final badge is now displayed. (To enlarge

the following image, click on it).

 

 

Marking Options for Comments and Replies

You can mark a comment or reply Helpful, Correct, Decision, Success, for Action, or Resolved. You may

see all or only some of these marking options, depending on how your community manager has configured

this feature.

Note:  The Marking feature is different from Tasks, which are a formal way to assign work tasks to

people.

When you mark a comment or reply, a badge appears that displays its state (Helpful, Decision, and so on).

These badges are visual indicators only; they do not prevent anyone from further commenting or marking

any comments or replies as a Decision, Helpful, Resolved, Success, or for Action.

To see who marked the comment or reply and when, click its badge.

Mark for Action Choose Mark for Action to assign an action to

yourself, and, optionally, bring in others. When

you bring in others to help, note that doing so

doesn't assign the Action item to them; it sends

a notification to their Inbox about the action item.

From there, they can Take Ownership of the action

item.)

The Action Item badge on the comment/reply lets

readers know that the item has been assigned to
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someone. Other users may Mark for Action other

comments or replies as well.

Resolve Choose Resolve on an Action (whether you own it

or not) when you have completed the action. This

lets others know that you've taken care of the issue.

Mark as Decision Choose Mark as Decision to let others know that

this comment or reply is the Decision, or one of the

Decisions. Other users may mark other comments

or replies as the Decision as well.

Mark as Success Choose Mark as Success to let others know that

this was a collaboration success story for your

community.

Helpful Click Helpful to let others know that this comment or

reply contains helpful information.

Correct Answer Only system administrators, place owners, and

discussion authors can see the Correct Answer

mark option and only on discussions that have the

"Mark this discussion as a question" check box

selected. There can be only one Correct Answer. In

addition, your community manager may disable this

feature altogether.

Marking Options for Top-level Items

You can mark a top-level item (a blog post, discussion, or document) if you have edit permissions for it.

Note:  The Marking feature is different from Tasks, which are a formal way to assign work tasks to

people.

You mark a top-level item from its Actions menu in the right sidebar. You won't see this menu if you don't

have edit permissions on the item.

After you mark a top-level item, a badge appears that displays its state (Final, Outdated, and so on). These

badges are visual indicators only; they do not prevent anyone from further commenting or marking any

comments or replies as a Decision, Helpful, Resolved, Success, or for Action. If you want to prevent further

replies on a discussion, click Lock under the Actions menu in the right sidebar.

You may see all or only some of the following marking options, depending on how your community

manager has configured this feature.

Mark for Action (discussions, documents, and

blog posts)

Choose Mark for Action to assign the item to

yourself or others. The Action Item badge lets

others know that the content item is being reviewed.
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Resolve (discussions, documents, and blog

posts)

Choose Resolve on an Action when you have

completed it. This lets others know that you've

taken care of the issue.

Mark as Final (discussions and documents) Choose Mark as Final to let others know that the

conversation is complete and no further discussion

is encouraged. If you mark something Final, you

cannot also mark it Outdated or Official.

Mark as Official (discussions and documents) Choose Mark as Official to let others know that this

is the official version of this item. This can be helpful

for policies and company-wide communications

such as the 2014 Holidays in an HR space or the

company's Mobile Purchasing Policy. If you mark

something Official, you cannot also mark it Final or

Outdated.

Mark as Outdated (discussions and documents) Choose Mark as Outdated to let others know that

this is old information and no longer valid. This

can be helpful for old procedures, policies, and

processes such as 2011 Health Plan Coverage

or Engineering Intern Projects 2012. If you mark

something Outdated, you cannot also mark it Final

or Official.

Mark as Reserved (documents only) Marking an uploaded file or a document as

Reserved indicates that someone is currently

editing it, so other users won't edit it until the

Reserved badge is removed. It does not actually

lock the file or document.

Mark as Success (discussions, documents, and

blog posts)

Choose Mark as Success to let others know that

this was a collaboration success story for your

community.

I have the same question (discussions only) Choose this to let others know you have the same

question. You'll see this only on discussions that

have the "Mark this discussion as a question"

check box selected and that do not yet have a reply

marked as the Correct Answer.

Who Can Mark and Unmark?

Different types of users have different permissions to mark and unmark items. The following tables list who

can do what for comments, replies, and top-level items, as well as other rules of marking.
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For Comments and Replies

 

 

For Top-level Items (Blog Posts, Discussions, and Documents)
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Searching for Marked Content

Marks are ranked differently in search results and have varying visibility options. The following tables list

the visibility and searching options of marks for comments, replies, and top-level items.

For Comments and Replies
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For Top-level Items (Blog Posts, Discussions, and Documents)
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Marking Comments and Replies

You can mark the comments or replies of discussions, documents, or blog posts in places where you have

permission to comment or reply. After you mark an item, you'll see a badge on it. This helps others quickly

see what has been decided on, a success, and so on.

1. Go to a discussion, document, or blog post and read through the comments or replies.

2. Select the mark you want. The options are listed in the table below. You may not see all of these

depending on how your community manager has set up the marking feature.
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Marking Option Description

Actions > Mark

for Action

This mark shows others that this comment or reply needs action. You can mark

for action for yourself this or, optionally, bring in other participants and leave them

a note describing what you need them to do. (When you bring in others to help,

note that doing so doesn't assign the Action item to them; it sends a notification

to their Inbox about the action item. From there, they can Take Ownership of the

action item.) The Action Item badge on the comment/reply lets readers know that

the item has been assigned to someone. Other users may Mark for Action other

comments or replies as well. To understand how to Resolve your actions, be sure

to read Resolving Action Items.

Actions > Mark

as Decision

This mark shows others that this comment or reply is a Decision. Note that there

can be more than one comment or reply marked as Decision.

Actions > Mark

as Success

This mark shows others that the comment or reply was a collaboration success

story for your community.

Helpful This mark lets others know that this comment or reply contains helpful information.

Correct Answer Only system administrators, place owners, and discussion authors can see the

Correct Answer mark option and only on discussions that have the "Mark this

discussion as a question" check box selected. In addition, your community manager

may disable this feature altogether.

3. Note the new badge on the comment or reply. If you change your mind later, just click Unmark on this

same item.

Marking Top-level Items

Users with edit permissions on the top-level content item can mark the top level of the item. Here's how to

do that.

1. Go to the discussion, document, or blog post for which you have edit permissions.
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2. In the Actions menu on the right, select the Mark option you want. You may not see all or any of these

depending on how your community manager has set up the marking feature.

3. Note the new badge at the top level of the content item. If you change your mind later, you can always

Unmark from the right side of the badge box.

 

 

Mark for Action, or Use a Task?

Understand the differences between Mark for Action and creating Tasks and the best ways to use these

features.

Actions Mark for Action is part of the Marking feature and

allows you to assign content items to yourself for
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action, or invite others to review them and take

ownership. Typically, you'll use Mark for Action

in an informal, on-the-fly manner when you're

discussing something.

Tasks Tasks are a formal way to assign

and track tasks for yourself or others

(  >

Task or Actions > Tasks > Create a task). You

can assign the task a deadline and associate it with

a project, such as "Sales Kickoff January 2015", or

save it as a personal task for yourself. Any Tasks

that are associated with a project are displayed on

the Tasks tab of the Project's home page.

Mark as Decision, or Correct Answer?

Understand the differences between Decisions and Correct Answers and the best ways to use these

features.

Decisions Mark as Decision is designed to help you take

control of a conversation in the comments section

of a discussion, document, or blog post. Users can

easily Mark as Decision, or Mark for Action to send

it to someone else for review.

The Final and Official marks for a top-level item

(discussion, document, or blog post) are additional

ways to let users know that a decision has been

reached and no further discussion is needed.

More than one comment or reply per discussion,

document, or blog post may be marked as a

Decision, Success, or for Action.

Note that you may see all, some, or none of

these marking options, depending on how your

community manager has configured this feature.

Correct Answers When the Correct Answers feature is enabled,

only system administrators, place owners, and

discussion authors can see the Correct Answer

option on discussions that have the "Mark this

discussion as a question" check box selected.

There can be only one Correct Answer per

discussion.
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This feature is not limited to a certain type of space

or group, but it is most useful in places that are

specifically designed to answer questions quickly,

such as a customer support space or a human

resources group.

Community managers cannot configure the Helpful

option. It is always available.

Reserving Files and Documents

Marking an uploaded file or a document as Reserved indicates that someone is currently editing it, so other

users won't edit it until the Reserved badge is removed. It does not actually lock the file or document.

The Reserved badge provides important information about file status for anyone who can't use Jive for

Office to edit and merge uploaded files, for example Mac users. It can also be used to warn users off a

published Jive native document that's not ready to be edited by other people yet. (Note that if you want

to hide an in-progress Jive document before publishing it, you can just save it as a draft and share it with

anyone you want to.)

When an author or editor marks a file Reserved, anyone can see who reserved the file and contact the

person if they're unsure whether it's OK to proceed with editing. Anyone with the rights to edit a file or

document also has rights to mark it as Reserved. When someone reserves a file, the author and anyone

who has already edited the document will receive an Inbox notification. You can filter content to find

reserved documents, too.

This feature has a slightly different meaning for uploaded files and Jive documents:

• For uploaded documents, Mark as Reserved warns users who don't use Jive for Office that publishing

a new version could overwrite and invalidate a version someone is working on locally. (Windows users

with Jive for Office have live merge capability and don't need this feature as much.) Currently, marking

a file as Reserved will not lock the document or prevent uploading another version. But any another

user who clicks Edit with the intention of uploading a new file will see a message pointing out that the

file is currently reserved for editing.

• Jive native documents already provide an indicator when someone has started editing a document.

already exists. (However, note the lock on the document while someone is editing only lasts ten

minutes, and after that it's possible to edit the document and overwrite another user's changes.) Mark

as Reserved replaces the need to put "WIP" or another indicator in the title when a document isn't in a

state where you'd like other users to jump in and edit it. In other words, it shows an author or editor's

intention to keep working on the document undisturbed until the next time that author publishes it.

How to Reserve an Item

To mark a file or document as Reserved, just use the Actions menu to Mark as Reserved. This won't lock

the document, but it will alert other users you are planning to update the item and they should wait or

contact you before editing.
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Reserving a document or file is a lightweight way to alert other users you're working on a document. The

Reserved badge doesn't prevent anyone else from editing, but it shows information about who is working

with the item, making it easy for other people to check in with you before adding their own edits. This is

especially useful if you're using uploaded files, but can't use the Jive for Office program for collaborative

editing.

To mark and unmark a file as Reserved:

1. To mark a file or document, go to its page and in the Actions menu, click Mark as Reserved.

You'll see the Reserved badge at the top left of the file preview display area (for uploaded files) or at the

top of the document, with a time stamp indicating who marked it, and when.

2. To unmark the file, use any of the following methods:

• Click the Unmark link at the top right.

• Publish the item. When you or anyone else publishes a new version, the Reserved badge is

removed.

• Mark it as Final, Official or Outdated. These markings override Reserved and the reserved badge is

removed.

Managing Your Action Items

Understand how to resolve, add participants, and manage your Actions.

Adding Participants to Action Items

You can add participants to items that have been Marked for Action for you. This is a great way to get help

on an Action Item.

Bringing in other people on your Action Item notifies them that you need help and gives them the

opportunity to Resolve the issue or Take Ownership of the action. (Keep in mind that adding participants

does not assign the action to them. For formal task management, you'll want to use Jive's task

functionality. For an explanation of the differences, see Mark for Action, or Use a Task?

• To add participants to an existing Action Item that you own:

a) Click the badge of the Action Item. (You can go to the item by searching for it or looking at your list

of Action Items under the Actions tab in the main interface.)

b) Click the Add Participant icon.

 

 

c) Select the user(s) you want to add to this Action Item.

d) In the field under the people selection, leave a note describing what you need. The note will show up

only in the participant's Inbox, so it should let them know specifically what you need from them, such

as, "Do you know where the RFP is?"

e) Click Mark.
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The new participant(s) will see an alert in their Inbox, along with your note. They can then Resolve

or Take Ownership of the item.

• To add participants while creating an Action Item:

a) Go to the item and click Actions > Mark for Action.

b) Add a general description about the action that anyone in the community will be able to see when

they click the Action Item badge, for example, "Provide remaining RFP information."

c) Select Bring in others to resolve this action item.

d) Select the user(s) you want to add to this Action Item.

e) In the field under the people selection, leave a note describing what you need. The note will show up

only in the participant's Inbox, so it should let them know specifically what you need from them, such

as, "Do you know where the RFP is?" Here's an example:

 

 

f) Click Mark.

The new participant(s) will see an alert in their Inbox, along with your note. They can then  Resolve

or Take Ownership the item.
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Resolving Action Items

You can resolve action items and leave a note explaining why you are resolving it. The author of the top-

level item and owner(s) of an action item have permission to resolve action items.

To resolve something that's been Marked for Action:

1. Go to the item. For comments or replies, click the Action Item badge and select Resolve

 

 

2. Add a note explaining why you are resolving the Action and click Mark. This note will be visible to

others, so it's helpful to describe how you resolved the action.

 

 

You'll now see a Resolved badge on the content item.
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Managing Your Action Items

You can manage items that have been Marked for Action for you from the Actions area of the main

interface.

To manage Action Items that you own:

1. Click Actions from the main interface.

 

 

2. From the Action Items > Active tab, you'll see a list of items awaiting Action from you.

 

 

3. You can do any of the following:

Marking Option Description

Resolve the item. Add a description of your resolution so that others

know what you did that resolved the item. When

you Resolve an item, it will be moved from the

Active list to the Resolved list. From there, if you

need to Unresolve the item for any reason, you

can.
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Marking Option Description

Add more people to the item (Resolve > View

Conversation > Add participants).

Add other participants to this Action and leave

them a note describing what you need. They can

then Resolve or Take Ownership of the item.

Go to the action item to review it in context by

clicking on its title.

Lets you review the full conversation. From there,

click the Action Item badge and Resolve the item

or Add Participants to bring in more people on this

item.

Using Impact Metrics
Use Impact Metrics to gain insight on how documents and blog posts are received by the community,

including their Global Reach, Impact, and Sentiment.

Additionally, if your community is connected to Cloud Analytics, you will see more features, such as:

• Impact metrics for discussions

• Number of subscribers

• List of top departments

• List of top referrers, and

• Number of emails generated by your content.

Understanding Impact Metrics

There are two views of Impact Metrics: summary and detailed. The summary view highlights the calculated

metrics for global reach, impact, and sentiment. Content in private and secret groups shows viewers

instead of global reach. The detailed view provides calculated metrics shown in the summary plus an email

metric, a graph of social actions that contribute to the metrics, and details about viewers and referrers.

The summary view of calculated metrics lives in the sidebar of your published content:
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When you click View More, you see the detailed view of Impact Metrics. For more on the detailed Impact

Metrics, see Using the Detailed View on page 104. The following calculated metrics are available for

supported content type:

Global Reach Conveys how widely viewed your content is in your

community. We use a calculation based on number

of registered users, and include web and mobile

views only. This calculation does not include those

following content via email.

Viewers In private and secret groups, you'll see Viewers

instead of Global Reach. These are the unique

viewers who have looked at your content.

Impact Shows how your audience reacts to your content by

looking at their social actions, such as Bookmarks,

Comments, Likes, Shares, and Views.

Sentiment Indicates how well your content resonates with your

audience. Content can achieve Neutral, Good, or

Excellent sentiment based on social action and

views.

Using the Detailed View

In the sidebar of your content, where you see the calculated metrics, click View More to open the detailed

view of Impact Metrics.

The Impact Metrics detailed view shows a graph with number of Views, Viewers, Comments, Likes,

Shares, and Bookmarks of your content by date. It also gives you the calculated metrics, which are global

reach, impact, sentiment, and email. Use these metrics to see how your content is being received in the

community. Content in private and secret groups shows viewers instead of global reach.

Note:  Some features described in this topic are only visible for commmunities using Cloud

Analytics.
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In addition to what you see in the Summary view, you also see:

Report Dates You can adjust the report dates in the top left corner

of the detailed Impact Metrics graph. Either enter a

custom date range that focuses on a specific period

of time, or select a preconfigured report period that

shows the first 7, 30, or 60 days of publishing the

content.

Note:  Impact Metrics are real time, so

expect to see new viewers right way.

Daily or hourly data When you click daily or hourly and then mouse

over the graph, you see data for more specific

chunks of times.

Show Only Subscriber Metrics If your community has the News feature enabled,

then you can click Subscribers to see how many

of the viewers clicked through to view this content
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from their News stream. When News is disabled,

you will not see the Subscribers button.

Data by Department If you want to look at which departments have the

most Views, Viewers, Comments, Likes, Shares,

and Bookmarks, then click Top Departments in the

top right of the detailed Impact Metrics graph.

Email Counts how many email notifications occur when

one of the following events happen:

• Use @mention in content, comments, or replies.

• Share content.

• Add collaborator to content.

• Reply to discussions, or comment on blog posts,

videos, or documents.

• Create content when someone who follows you

has email notifications enabled.

Viewers and Referrers Viewers tells you who's looking at your content, and

top referrers tells you who's generating interest in

it. For more in this, look at the Viewers and Top

Referrers lists.

Where are the Impact Metrics for this?

You can find out who's viewing and who's referring your content by looking underneath the detailed Impact

Metrics graph.

Authors and a few others can use Impact Metrics as a way to measure how the content is received by the

community. If you don't see impact metrics for a content type, you might not have permission to view them.

Who Can See Impact Metrics for Documents,

Discussions, and Videos?

The content author and everyone with admin rights

can see the Impact Metrics. When you publish the

metrics to everyone, then everyone who can view

the content can see the Impact Metrics for it.

Who Can See Impact Metrics for Blog Posts? The content author can see the Impact Metrics.

When you publish the metrics to everyone, then

everyone who can view your blog post can also see

the Impact Metrics for it.

What Types of Content Show Impact Metrics? Blog posts, documents, discussions, and videos

show Impact Metrics. If your community has been

recently upgraded to include this feature, all content

created before the upgrade cannot be tracked with

Impact Metrics.
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Who's Viewing and Referring Your Content?

You can find out who's viewing and who's referring your content by looking underneath the detailed Impact

Metrics graph.

Viewers

If enabled in your community, find out who has viewed your content when you look under the Impact

metrics graph in the detailed view. Only the standard access user can see this viewers panel, and external

contributors will never see it. From the Viewers panel, you can search for viewers based on first name, last

name, and title.

Top Referrers

If enabled in your community, see whose referrals gained new viewers to your content. It's under the

detailed view of the Impact Metrics graph. You also see how many viewers have been referred by that

user. Only the standard access user can see this viewers panel, and external contributors will never see it.

Improving Your Impact

Improve your Impact, Global Reach and Sentiment by sharing your content with either the entire

community, or just a few colleagues.

Consider your audience when posting or sharing content. If you're posting something that only Sales needs

to pay attention to, then post it to the appropriate Sales group. If you already posted your content in a place

where it's not getting the attention you need, then you can move it, or try @mentioning the appropriate

group or user(s) in your status update to get the right people to see your content.

When you share content with the right set of people, you can really improve your impact. Sharing with

users who interface with a lot of people can make your content much more visible--if these superstar users

interact with it show up in Top & Trending. For example, many managers and executives are superstar

users because people who report to them will pay attention to what they do.

Publishing Impact Metrics to Everyone

You can expose Impact Metrics to everyone who has permission to view your content.

When you're ready to show everyone the Impact Metrics on your content:

1. Go to the sidebar and mouse over the calculated metrics.

2. Click the pencil edit icon when it shows up.

3. select Make these Impact Metrics public.

Using Projects and Tasks
Tasks and projects are a great way to turn collaboration into action and track your progress.

A project is a great way to give collaborative work a context that's time-based and outcome-based. With

a project, you collect people's content in a way that focuses their work along a schedule toward a specific
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goal. You can then create and assign people tasks and sub-tasks associated with the project to make sure

everything gets done.

Using Jive Projects and Tasks
Jive projects provide lightweight project management with tasks, due dates, checkpoints, and notifications.

A project can contain various kinds of content, including tasks. You can create tasks with titles and

descriptions, assign them to people, set due dates, and mark them as complete. Once you enter all the

tasks for a project, you can edit or delete them, add sub tasks, set up email notifications on tasks, and

mark tasks complete. As with other content, you can assign tags to tasks, too.

You can add checkpoints to a project as a way of making sure your project is proceeding on track. A

checkpoint is merely a named place in the schedule, and it's often used as a point at which to take stock.

To help you manage your project's progress, Jive provides visual cues that snapshot the project. On

a project's home page (which you can customize with widgets, as with other main pages), you'll get a

checkpoint timeline that shows where your checkpoints are between the project's start and finish, and

where the current date falls on the timeline. A project calendar captures task due dates and checkpoint

dates in a traditional calendar style.

Creating a Jive Project

Follow these steps to create a project. After that, you can create some tasks for the project.

1. Click

 >

Project.

2. Select a location for the project. Projects are associated with a place, such as a space or group. The

place you choose will determine who can see and collaborate on the project.

3. Give your project an identifying name.

4. Enter a brief description to appear in the user interface.

5. Select tags that can be used to find this project.

6. Select a project start date and the end date. Use the target date for completing the project.

7. Change the project owner, if necessary. The default owner is the person creating the project.

8. If you click through without selecting Advanced Options, your place will use an Activity page as its

main page, with the option to add more custom pages. We recommend using an Activity page because

it can be displayed on mobile devices, and because it's more friendly to streaming content. However,

you may want to include an Overview page with widgets. You do this by clicking Advanced Options

and choosing one of the two options that include an Overview page. If you select Activity + Overview

Page, you'll need to specify which page will be the landing page for the place.  If you use the checkpoint

and status functionality for tracking project tasks, you will probably want to stick with the old-style

Overview page rather than updating to the Place Template format. The widgets in the Overview page

more effectively support Projects at this time.
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9. If you want to apply an Activity page and a customized place template to this place, click Preview and

browse templates. If you don't choose a template, just click Preview: the place will use the default

template, General Collaboration. Place templates determine which tiles and streams will be included in

your group's Activity page (which you can further customize). Choose the one that's right for the kind

of collaboration that will happen in the place you're creating. You might want to read more about Using

Place Templates.

10.Click Apply Template

11.Click Create Project.

Deleting a Project

When you delete a project, you remove the entire project, including its content, from the system. You

cannot undo a project deletion.

1. Go to the project's Overview page and click Manage > Delete in the upper right corner.

2. Confirm the project's deletion by clicking Delete.

Creating a Task

You can create a personal task for yourself or assign a task for others and associate it with a project.

1. From the main navigation menu, click

 > Task.

2. In the Description field, provide a brief overview of the task.

3. Select a project for this task in the Project field. The default selection is None, which means it is a

personal task for yourself and only visible by you. You cannot create personal tasks for other people.

4. To assign the task to someone else, you need to select a project and then click the "x" next to your

avatar to close it. After doing this, you can select the person who should own the task.

5. In the Due Date field, enter the date you want this task to be complete by. The default due date is

tomorrow.

6. Click Advanced if you want to use the content editor to describe the task and add tags to it.

7. Click Add Task.

Managing Tasks

You can edit a task, add a sub task, delete a task, and follow it in a stream. You can do this from either

your personal task list (Actions > Tasks) or a project's task list (Project > Tasks).

1. Next to the task, click Show details.

2. Select edit a task, add a sub task, delete a task, and follow it in a stream.

Completing Tasks

There are two ways to manage and complete tasks: through your personal tasks list or the tasks list

associated with a project.
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Completing Project Tasks

You can complete tasks associated with a project.

1. Go to the project's home page and click the Tasks tab.

2. Click the check box to the left of the task you want to complete. You'll briefly see the task with a line

through its text before it disappears completely from the list. If you want to see the completed tasks, be

sure to check Include completed.

Completing Your Personal Tasks

Tasks that have been assigned to you are listed in the Actions > Tasks area. You can filter your tasks by

All, projects, completed, and incomplete.

1. Go to Actions > Tasks. You'll see a list of your tasks and their associated projects and due dates.

2. Click the check box to the left of the task that you have completed. You'll briefly see the task with a line

through its text before it disappears completely from the list. If you want to see your completed tasks, be

sure to check Include completed.

Mark for Action, or Use a Task?

Understand the differences between Mark for Action and creating Tasks and the best ways to use these

features.

Actions Mark for Action is part of the Marking feature and

allows you to assign content items to yourself for

action, or invite others to review them and take

ownership. Typically, you'll use Mark for Action

in an informal, on-the-fly manner when you're

discussing something.

Tasks Tasks are a formal way to assign

and track tasks for yourself or others

(  >

Task or Actions > Tasks > Create a task). You

can assign the task a deadline and associate it with

a project, such as "Sales Kickoff January 2015", or

save it as a personal task for yourself. Any Tasks

that are associated with a project are displayed on

the Tasks tab of the Project's home page.

Public and Private Communication
To enjoy the full power of Jive, we recommend keeping discussions and documents public whenever

possible. The following topics describe the visibility options for content, as well as the security of the

application for end users.
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Are My Community Activity and Content Secure?
Your organization has deployed Jive to provide a place for you to get your work done by contributing to and

collaborating in the community. Your activity in Jive is safe and secure.

Your company owns your activity in the community, just as they own your activity in your company email

program. To understand who can see your content and how visibility works in Jive, be sure to read Who

Sees My Stuff? and Content Visibility Options.

Still Nervous? Dive into the Security Back End

If you're concerned about the security of Jive and want to get a deeper understanding of how your

information is protected, read this security overview here on the Jive Software website. Or, you can really

dive in and read the security section of our administrator documentation.

Who Sees My Stuff?
That depends on the place where you published it. Different places have different visibility permissions.

In Jive, People post Content in Places. This means that all content (discussions, documents, blog posts,

and so on) is published in a "container." A container can be a space, sub-space, group, project, or your

own personal content. All places have visibility permissions set by the place's owner(s) that determine who

can see the content posted in that place.

While it's best to keep things public whenever possible so that other community users can benefit from all

of the discussions, documents, and so on, there are times you may want to publish things only for yourself

or a handful of other people. In addition, you may want to keep entire categories of content private or even

secret, for example accounting or human resources information. In that case, you would create a space or

group with the content visibility options that you need. To learn more about that, be sure to read the topics

in Managing Permissions in the administrator documentation.

If you are concerned about the security of the community, you might find it helpful to read Are My

Community Activity and Content Secure?

The following table lists the different types of containers in which you can publish content in the community:

Note:  Externally-facing communities (those serving customers, partners, and vendors), do not

have the Personal Content (Hidden) feature.

http://www.jivesoftware.com/social-business/engage-employees/technology/security/
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Table 6: Content Containers

Container Description How to Find It

Your

Personal

Content

Your personal container is

where your documents and

discussions that are Hidden

or limited to Specific People

are stored. In addition, your

Personal Tasks are stored

here.

To see your documents and discussions that are limited to

only you or specific people, go to Content > Authored >

Documents | Discussions and then select Filter by

personal content. A dark lock icon next to the item

indicates it is limited to you; a light lock icon next to the

item indicates it is limited to you and the other people you

designated.

To see your personal tasks, go to Actions > Tasks. In the

Project drop-down menu, select Personal.

Groups Different types of groups

have different content

visibility permissions. To see

a handy table that illustrates

the various options, be sure

to read Types of Groups on

page 53.

Go to the group and click the Content tab. You can filter

the content by discussions, documents, and so on.

Spaces Spaces have complex

content visibility options that

are set up by the owner(s) of

the space.

In addition, spaces have

different content creation

options that are set up by

the owner(s); therefore, you

may not be able to create a

discussion in Space A, but

you can in Space B.

Go to the space and click the Content tab. You can filter

the content by discussions, documents, and so on.

Sub-spaces Sub-spaces inherit all of the

content visibility permissions

of their containing parent

space.

Go to the sub-space and click the Content tab. You can

filter the content by discussions, documents, and so on.

Projects Projects inherit all of the

content visibility permissions

of their containing parent

space or sub-space.

Go to the project and click the Content tab. You can filter

the content by discussions, documents, and so on.
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Content Visibility Options
You can limit to selected people the visibility of content that you create, or hide it completely from other

people. Here is a reference of the visibility options of all content types.

Note:  Externally-facing communities (those serving customers, partners, and vendors), do not

have the Personal Content (Hidden) feature.

Your Personal Content

Content Item Description Are streams

updated?

To set the item as

Personal:

To find the item later:

Documents

and Uploaded

Documents

When you

publish a

document

as Hidden,

it is stored in

your personal

container and is

private to you.

You will see a

stream update

when you

publish, but

other users will

not.

Before you publish the

document, set its visibility

option to Hidden. You

might want to read How

Can I Create a Document

Just for Myself?

Go to Content >

Authored > Documents

and then select Filter by

personal content. The

dark lock icon next to the

document indicates it is

limited to you.

External

Bookmarks

Your private

bookmarks

are stored in

your personal

container and

are private to

you.

You will see a

stream update

when you save

the bookmark,

but other users

will not.

Go to

 >

Bookmark and paste

in the external URL.

Then, select Make this

bookmark private before

you Save it.

Click in the Spotlight

Search box and select

Bookmarked > Show

all bookmarks. In the

top navigation bar, filter

by External URL. The

dark lock icon next to the

bookmark indicates it is

limited to you.

Personal

Tasks (tasks

you assign to

yourself)

You can assign

yourself personal

tasks so that no

one else can see

them.

You will see a

stream update

when you add or

edit the task, but

other users will

not.

Go to

 >

Task and select Project >

None (personal task).

Go to Actions > Tasks.

In the Project drop-down

menu, select Personal.
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Content Limited to Specific People

Content Item Description Are streams

updated?

To limit the item to

Specific People:

To find the item later:

Documents

and Uploaded

Documents

When you

publish a

document limited

to Specific

People, it

is stored in

your personal

container and

is private to you

and the other

people you

designated.

You and the

other Specific

People will a

stream update

when you

publish, but

other users will

not.

Before you publish the

document, set its visibility

option to Specific People.

Go to Content >

Authored > Documents

and then select Filter

by personal content.

The light lock icon next to

the document indicates

it is limited to you and

the other people you

designated.

Discussions When you

publish a

discussion

limited to

Specific

People, it

is stored in

your personal

container and

is private to you

and the other

people you

designated.

You and the

other Specific

People will a

stream update

when you

publish, but

other users will

not.

Before you post the

discussion, set its visibility

option to Specific People.

Go to Content >

Authored > Discussions

and then select Filter by

personal content. The

light lock icon next to the

item indicates it is limited

to you and the other

people you designated.

Messages You can send

one or more

other users a

private message.

Messages are

listed in the

Inbox. They do

not appear in

streams.

Go to

 >

Message and select

the person(s) to whom

you want to send the

message.

Go to Inbox. In the Filter

drop-down menu, select

Messages.

Content You Cannot Hide

• Blog Posts

• Discussions
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• Polls

• Status Updates (however, you can limit your status update to a group if you want to limit its audience)

• Projects

Creating Direct Messages and Private Discussions

Using messages and private discussions limits your audience to only the people you want.

Messages and private discussions show up in the Inbox of only the people you send them to. These are

useful features, but the power of Jive is that nearly all topics in the community can be helpful to others, so

try to keep things public whenever possible.

To send a message to someone, click the Send Message button from your Inbox or

Message from the top of any of your attention streams. Alternatively, you can click

 >

Message or hover over the person's name in any of your attention streams and click Message. After your

message is sent, the receiver will see it in their Inbox. From there, the receiver can respond directly.

To create a private discussion, click

 >

Discussion and select Specific People. Select the participants you want to include in the discussion.

When you're finished drafting the discussion, click Post. Only the participants you selected will see a

discussion notification in their Inbox. From there, they can respond to the discussion.

Securing Your Profile

If you're concerned about privacy, you can limit who sees different parts of your profile by editing your

privacy settings.

1. To edit your profile, click your avatar in the upper right corner and then Edit Profile.

2. Select the Privacy tab.

3. For each profile field, select the type of user who can view it. If you select everyone, then all users can

see the contents of that field. Make sure you don't hide too much about yourself because that's how

others will connect with you. Your community administrator may control who sees certain fields, such as

those without a Visible to... option.

Note:  You can take a look at how others will see your profile by using the Preview your profile

tool to the right. Just select the person whose view of your profile you want to see.

4. Click Save.

How Do I Use the Save Draft Feature?

Use the Save As Draft feature to quickly jot down and save your thoughts in documents or blog posts.

Then, you can come back later to edit and publish your content. You can also collaborate with others on

saved drafts before publishing them.
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You can use the Save As Draft feature on blog posts and documents. This can be useful if you need time

to marinate your thoughts a little before publishing something. Just create a document or blog post and

click Save Draft. Later, when you want to edit it, go to Content > Drafts to see your all your saved drafts.

From there, filter your Drafts results by Documents or Blog Posts, find and click on the draft, and then

click Edit. You can edit the content and save it again as a draft, or publish it. Drafts are not visible in any

streams.

Collaborating on Drafts

You can collaborate on drafts of blog posts or documents before you publish them. Just create the post

and save it as a draft. From there, click Share in the right sidebar. Select the people you want to share the

post with, include a message for them, and then click Share. The recipient(s) will be able to edit the post

and either save it as a draft or publish it.

Inviting New Community Members
Some communities allow you to invite your friends to join.

If enabled for your community, you can invite people from outside the community to join. When you invite

them, they'll receive an email with instructions on how they can set up their account in the community.

1. Click People.

2. In the left pane, click Send Invites. You won't see this option if your administrator has disabled the

ability to invite people from outside to join your community.

3. To add an email address to your list of recipients, type a complete email address and click the link that

Jive creates.

4. Edit the note if you want to tailor it for your friends, and then click Send Invitation.

Using Apps
Jive Apps are available in your community to help you get your work done faster and more effectively. For

example, an app could help you and your team to arrange travel and schedules. An app could remind you

to get up and stretch as you are working. An app could send a notification when your expenses have been

approved. Apps work within your community and can use its features directly as well as pull in third-party

systems to bring additional functionality.

What are Jive Apps?
You can use Jive Apps to accomplish focused tasks, integrate with other systems, or provide new

functionality to your Jive experience.

Jive Apps are lightweight applications that are hosted by Jive or a third-party, which means you don't have

to download anything to your computer and you are always looking at the latest version. When you install

an app in Jive, you connect to it and enable it to access information that helps you work more effectively.
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You can find Jive Apps when you click Apps at the top of your screen, where they'll always be when you're

logged into the community. Some apps can bring in information from outside of your community, while

others manage information within the community itself. You can also access some Jive Apps through

extension points throughout the UI. These extension points are known as app actions. For instance, some

apps are accessible from a menu item in the right sidebar when viewing content and some apps are

accessible from the create menu.

Contact your Community Manager for acquiring additional Jive Apps.

Using App Actions
Jive Apps can contribute app actions, which are extension points throughout the Jive UI.

Apps can be used in other places beyond the Apps menu at the top of the screen. These additional app

extension points are called app actions. An app action can appear in one of many different locations within

the Jive UI: as a menu item in the Create menu (within the APPS section), in the sidebar when viewing

a document (within the APP ACTIONS section), as a new tab in a group or project, when typing "!" while

editing content. It is up to the Jive App developer exactly which of these extension are accessible and

exactly what action occurs when you select this action.

How to Use Apps in Content
Using !App, you can bring links and images from a Jive App into your community so you can share them

with others.

Just like @mentions alert people and places, there's also a symbol you can use to invoke a Jive App from

any discussion, blog post, document, or comment in Jive. Just type "!" and you'll see a list of installed

apps.

When you create or comment on content in your community, you have the ability to !Apps. This is a way to

share app artifacts with others. This enables you to generate a conversation about the app artifact or just

share it with people. If they don't have the app, they will be invited to download it when they click the image

or link.

1. Type the "!" symbol (or click the "!" icon if it is available). A search dialog opens and suggests possible

matches.

2. Select the Jive App from the list and navigate to the image or content in the Jive App to produce a link.

Troubleshooting & FAQs for Jive Apps
Here are answers to some specific questions about Jive Apps and how they work.

I have a problem with my app: what should I do?

Jive Apps are supported by the developers who created them, just like apps you may have used on your

smartphone or another mobile device. To get support for an app, select the App Settings button and select

About. You'll be presented with a link to either the developer's support web site or a support email address.
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I can no longer use my app: what happened?

Sometimes apps become disabled when their data stream is interrupted, or when the app can't connect to

the Internet. Your community administrator can also disable an app if she decides it's not appropriate for

your community. Finally, for paid apps, billing issues like an expired credit card can result in the app getting

temporarily disabled. If a paid app is disabled, we will no longer charge your credit card for app usage. In

general, we try to give you detailed instructions on how to get your app started again. However, if you need

some help troubleshooting, you should reach out to your community administrator.

I'm leaving my community: what happens to my information?

If you leave your community, your credit card will automatically be disabled when your administrator turns

off your access to the community. If you still see charges on your card please contact Jive directly at app-

billing@jivesoftware.com.

What happened to the Apps Market?

You can now access Apps automatically when the Community Manager installs them into your community.

However, if the Apps Market is enabled, you can also install apps from the marketplace. For additional

documentation, refer to Apps Market information found in the Jive 7.0 Community User Help. Contact your

Community Manager for more information.

Using External Groups
You can use external groups to collaborate with users from outside your community.

When you create an external group, you can invite users from outside the community to work with

community users. These groups usually serve a specific purpose, such as working on a project with a

vendor. External contributors can see content only in groups they belong to.

The external contributor brings a fresh perspective and their expertise to an internal or employee

community where you would usually suffer the pains of long email threads or time-consuming conference

calls to get information from people outside your community. These users can provide quick answers,

share files, and collaborate on documents.

What Are External Groups?
External groups provide an area where standard community users can work with people from outside the

community, external contributors. Only secret or private groups can have external access.

You can use external groups to invite people from outside your community to collaborate with standard

community users. For example, a user in a music label company's community could create a private group

for a collaboration project they're working on. They could then enable external access to the group, invite

the external artists who will be participating, and use the group to post schedules and communicate ideas.

The external artists are limited to viewing and participating in this group only. They can't see anything else

going on in the community.

http://docs.jivesoftware.com/jive/7.0/community_user/index.jsp


 | Using a Jive Community | 119

Groups with external access are designated with visual cues such as either orange "Externally Accessible"

text or

the orange eye symbol that means people from outside your company are welcome in that group. You'll

find the following bright orange sign post at a group's home page.

 

 

Creating External Groups
When creating a group, you can select Enable external access to turn a community group into a place

where standard users can invite external contributors to extend their communication and collaboration to

the outside world.

To create a group with external access:

1. Click

 >

Group.

2. On the Create group page, enter the group name and details.

3. Select Enable external access to allow external contributors to be invited to and join the group.

Externally Accessible groups require that you select secret or private for the group type.

4. Specify a secret or private group. External groups are limited to secret or private groups to help protect

5. Select Box Storage Provider to store uploaded files in Box.

6. Click Advanced for more options, such as group features.

7. Select which features you want the group to have. People will be able to create the kinds of things you

select.

8. Click Apply.

Who Are External Contributors?
An external contributor can join a secret or private group when invited into the group by a group member.

External contributors can view and participate only in that group. They cannot see any other community

content or activity, and they can only join a maximum of 20 groups.

You can securely invite someone from outside your community to participate in an externally accessible

group. The standard community user can only see external contributors when they belong to the same

group.
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External Contributor or Standard User?
You can always tell the difference between standard community users and external contributors because

external contributors have either an orange icon or orange text near their name.

No matter where or how you look at it, there is a way to see whether a group or a user is using external

access. Look for these cues when you want to know which groups and users are accessing your

community externally:

Whether you are searching for users, browsing through community activity or looking at someone's profile

card, you can spot the external access symbol that helps you identify external contributors.
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An email notification also clearly indicates when you're replying to an external contributor.

 

 

How Do I Invite External Contributors?
When you belong to a group with external access, use the email addresses of users you want to invite from

outside your community to participate.

To invite external contributors to join an external group:

1. Go to the group's main page.

2. In the Actions list, click Invite people to join this group.

3. Enter the email addresses of people you want to invite. To invite several people from your email

address book, you can export a comma-, space-, or semicolon-separated list of addresses from the

email application and paste them in.

4. Edit the message you want potential group members to see with their invitation.
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5. Click Send Invitation.

What Can They See?
External contributors can't see everything in the community because they are limited to the content in their

groups and a few other restrictions.

External contributors can see:

• Groups they have joined.

• Content and projects within those groups.

• Other users who are also members of those groups.

External contributors cannot see:

• Spaces or projects besides those in their groups.

• Community Overview page found when you click Home.

• Global or public content, such as status updates, public bookmarks, or public documents and

discussions.

• Apps, but they can see images embedded by apps within their groups.

What's Unavailable to External Contributors?

External contributors see the community pretty much the same way a standard user with the following

exceptions:

• Update their status.

• Create public discussions and documents.

• See and work with private messages, only unauthorized messages are seen.

• See or use Jive Apps. External contributors can not see or launch Apps or App Actions.

• Use Connects Services. External contributors also cannot see Connects Services in their user's

Preferences page.

• See or use the Tools page, so they can't download modules like Outlook, Office and Jive Anywhere.

• Access public external URL bookmarks or social bookmarking. External contributors can create and

view internal bookmarks of Jive content.

• Become group owners.

Contributing to a Community
A company may invite you to join one of their groups and become part of their online community so they

can work closely with you, making you an external contributor. Becoming an external contributor is a way

to collaborate in a community on a limited basis. As an external user, you can view content and participate

only in the group you belong to.

Learn how to navigate a community as an external contributor.

Once you accept an invitation to join a community's external group, you can begin contributing in that

group. If you want some help, see the Where Do I Begin? topic.
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I'm Contributing to a Community, Where Do I Begin?

When you first join a community's external group as an external contributor, you can begin participating by

accepting invitations, setting up your profile, and addressing your actions.

The following tips help you fit right in and get started. Once you're set up, take a look at what else you can

do here!

Accept group invitations

The first thing that you should do when you sign into the community is to accept any group invitations.

You'll be doing all of your work in groups, so accepting invitations is how you can see group content and

activity. Go to Home > Actions and then accept group invitations that you see under Pending.

Note:  You can only belong to a maximum of 20 groups, so choose wisely!

Set up your profile

Your user profile provides community members with an easy way to learn about your experience, skills,

and interests. Your profile shows up in search results when community members search for keywords

contained in your profile. You can update your information at any time.

Check out your Actions

When you are assigned something to do, such as a task or something that's been Marked for Action for

you, you'll see an alert next to Actions in the left sidebar.

Use the following quick tips to use Actions effectively:

• Click Action Items to see a list of your Action Items. From here, you can Resolve them, or bring in

other participants. To see the Action Items you have already resolved, click Resolved.

• Click Tasks to see a list of tasks assigned to you, which you can sort by project. To see the tasks

you've completed, select View: Include completed. You can also Create a task from this page.

Customize email notifications

You can take advantage of custom email notifications if you feel like you might miss something important

when you're not signed in.

Set Up Your Profile

Setting up your profile is the first step to participating in the community.

Your user profile provides community members with an easy way to learn about your experience, skills,

and interests. Your profile shows up in search results when community members search for keywords

contained in your profile. You can update your information at any time.

To set up your profile:

1. Click your avatar in the upper right corner and then click Edit profile.
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2. Click the Avatar & Photos tab to change your photo and avatar. Your photo is a great way for people

to "meet" and recognize you in person. Your avatar lets community members quickly associate your

comments and status updates with a simple visual cue.

3. Click the Your Profile tab and fill in as much profile information as you like. Note that your profile will be

found when people search, so if you have professional roles or interests that would be useful for others

to know about, be sure to include them. You may not be able to edit certain fields, such as username.

Usually the community manager sets up these fields for you.

4. Click Privacy to edit your privacy settings. These control how different types of users see your profile.

For more information on privacy settings, see Securing Your Profile.

5. Click Save.

What Else Can I Do Here?

Jive is a place where you can build your network, come together as a team, share files, collaborate on

documents, and get answers fast.

The first thing you should do is jump in and start asking, or answering, questions! The group you belong

to looks forward to hearing your ideas, and they need your expertise to get work done. Think of the group

as a 24-hour hotline where you can communicate your concerns and give your opinion. Just start writing

documents and get input from all the experts without taking notes or sifting through long email chains.

Open your Inbox

Your Inbox shows the activity that's most you-centric—the information that's sent directly to you and has

your name on it. This automatically includes @mentions, replies to discussions you're participating in,

content people share with you, your latest acclaim, new follower notifications, and direct messages.

Use the following tips and tricks to get the most out of the Inbox:

• You can follow content items in your Inbox even if you haven't yet or don't want to participate directly.

From any of your streams, just click the content item, and then select Follow > Inbox > Done. All

updates and replies to that item will now flow into your Inbox.

• Use the Filter drop-down menu in Inbox to sort the view to @mentions, messages, notifications, or

shares. You can even use Filter by Participant to see only items including a certain person.

• Manage your unread communications and follow-ups using the blue dot toggle next to messages you

haven't read yet and clicking Unread Only to see only the messages marked with the blue dot.

• When you click the Split View icon in the top right of the Inbox stream and then select a message,

you'll see the content of the message in the lower pane and the list of messages in the upper pane.

• Get rid of activity on any item that no longer interests you by clicking Hide new activity in the lower

pane of the split-pane view. The current activity stays in your Inbox, but you'll see no more update alerts

for that item. (Click Start following in Inbox to restore Inbox notifications for that item).

Discover documents and discussions, and then comment and collaborate

Exchange ideas when you participate in discussions and documents:
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• Commenting is as simple as clicking Comment or Reply  at the bottom of a document, blog post, or

discussion. You can reply to an individual message in a thread or to the original post. Everyone reading

the thread will see your response.

• Documents have owners who control whether you can change the content of the document, comment

on it, or even see it. You may be able to see documents that you don't have permission to comment on

or participate in. If you think you should be able to comment on a document and you can't, contact the

author and ask for permission.

• If you can edit a document, you'll see Edit in the Actions menu in the right sidebar.

• A comment or reply may have a badge showing Decision, Action Item, or Success. These badges help

you avoid endless discussion and quickly determine the state or outcome of the conversation. To learn

more about this feature, be sure to read Using the Marking Feature on page 86.

Use an Attention stream

You'll see an update in the stream when someone creates a document, replies to a blog post, posts a

status update, and so on.

Here are some examples of activities that trigger new stream items for people, places, and content that

you're following in a stream:

• Content: someone modifies the content item (for example edits, comments on, or replies to it).

• People: someone posts a status update, creates a content item, or comments on a content item.

• Places: someone updates content in the place (for example publishes a new document, edits a blog

post, shares content with a place, or comments on a document that lives in the place).

• Tags: someone creates or modifies an item with a tag you're following in the stream, or adds the tag to

a content item.

What's My Role Here?

Don't be fooled. You're a crucial part of a community that needs your input. You may not be a community

member, but someone in the community invited you because they knew you'd add value. The benefit to

being an external contributor is that you only see the parts of the community that affect you. You don't have

to worry about seeing anything you shouldn't.

Your role is to help the community reach outside of its circle, and to share knowledge so both you and

other group members can work together successfully and efficiently. You can feel free to ask questions

in your group(s) and to post and comment on documents and discussions. When you become part of the

conversation, you'll improve how work gets done.

Reference and Advanced Topics
These topics address techniques for advanced users and administrators.
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Advanced Content Management
Managing your documents and discussions through permissions and archiving can help ensure effective

collaboration.

Document Approval

You can designate an approver for any document before you publish it, or a community administrator may

designate an approver for a space, so that all documents must be approved before they are published.

Note:  A space approver only approves documents. If you want to set approval on more than

documents, use the Moderation feature if your community supports it.

Assigning a Document Approver for a Space

Community administrators can designate a document approver for a space so that all documents created

in the space must be approved before they are published. To set up a space approver, see Setting a

Space Approver.

Add a Document Approver to a Single Document

You can designate an approver for a document when you are creating it or after you have saved it, but

not published it. While you're editing the document, click the Advanced Options link. Under Require

approval before publication, enter the name of the person you want to approve the document. You can

also click Select People to browse for the person's name.

Note:  If the place that contains your document has moderation enabled (if your community

supports it), then the approver(s) must approve the content before it will be sent to the moderator's

queue.

What happens when I submit a document for approval?

1. When someone has been assigned a space approver role, documents created in the space are

submitted for approval before they are published in the community. If moderation is also enabled for

documents in the containing space, then new documents must be approved before they're sent to the

moderation queue.

2. After submitting a document for approval, the document page will display a status box showing you a

list of people who must approve. (While awaiting approval, you can see the document in your Drafts by

going to Content > Drafts).
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3. If the approver rejects the document, they're prompted to include a message to go with their rejection.

That message is added to the document's Author Discussion area, where comments go under the

document's content. A rejected document must be resubmitted (by anyone who can edit the document)

for approval before it can be published.

4. If there are multiple approvers, all of them must approve a document before it can be published. After

the last person approves the document, it is automatically published (or submitted for moderation if

moderation is enabled in the containing space).

How do I convert a discussion thread to a document?

Sometimes an important discussion needs to become a document.

There may be times when you want to convert a discussion into a document. When you do this, you'll

create a new document that contains the original post and all replies in the discussion. Then, you can edit

the new document and save it. The discussion itself will not be removed.

To convert a discussion to a document, navigate to the discussion, then click Convert to document. 

Moving Discussions and Documents

You can move discussions and documents from one place to another.

To move a discussion or document from one Jive place to another, navigate to the item and click Move

from the Actions menu in the right sidebar. Select the new place and then confirm the move.

Note:  Depending on how your community is set up, you may or may not see the Move option in

the Actions menu. If you want to move something but don't see the Move option, ask the content's

author or the owner of the place where the content is posted to move the item for you.

Locking Discussions

You can lock discussion threads so that no more replies are allowed.

If you're an administrator, place owner, or moderator, you can ensure that no one will be able to add more

replies to a discussion thread. Navigate to the discussion thread and click Lock Thread.

Note:  Depending on how your community is set up, you may or may not see the Lock option in

the Actions menu. If you want to lock something but don't see the Lock option, ask the owner of the

place where the content is posted to lock the item for you.

What Are Feeds?

Feeds are a way for you to keep track of Jive content updates without having to visit the application. (RSS

is a popular feed type; "RSS" stands for "Really Simple Syndication.") By "subscribing" to the content feed,

you're asking to have easy access to information about content changes or additions. A feed brings you a

list of updates that you can view in a feed reader (also known as an aggregator). Subscribing to feeds is an

alternative to receiving email notifications, in which an email is sent each time content is changed or added

(although you can also do both). You might prefer email notifications if you want to receive updates in a

more "passive" but immediate way. (Set email notifications on individual items, or customize your email

notification settings to get email about particular kinds of activity.

http://en.wikipedia.org/wiki/Aggregator
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You can subscribe to feeds for content lists (such as a list of blogs, discussions, documents, or status

updates you'd view), spaces, or discussion threads.

Content Visibility Options

You can limit to selected people the visibility of content that you create, or hide it completely from other

people. Here is a reference of the visibility options of all content types.

Note:  Externally-facing communities (those serving customers, partners, and vendors), do not

have the Personal Content (Hidden) feature.

Your Personal Content

Content Item Description Are streams

updated?

To set the item as

Personal:

To find the item later:

Documents

and Uploaded

Documents

When you

publish a

document

as Hidden,

it is stored in

your personal

container and is

private to you.

You will see a

stream update

when you

publish, but

other users will

not.

Before you publish the

document, set its visibility

option to Hidden. You

might want to read How

Can I Create a Document

Just for Myself?

Go to Content >

Authored > Documents

and then select Filter by

personal content. The

dark lock icon next to the

document indicates it is

limited to you.

External

Bookmarks

Your private

bookmarks

are stored in

your personal

container and

are private to

you.

You will see a

stream update

when you save

the bookmark,

but other users

will not.

Go to

 >

Bookmark and paste

in the external URL.

Then, select Make this

bookmark private before

you Save it.

Click in the Spotlight

Search box and select

Bookmarked > Show

all bookmarks. In the

top navigation bar, filter

by External URL. The

dark lock icon next to the

bookmark indicates it is

limited to you.

Personal

Tasks (tasks

you assign to

yourself)

You can assign

yourself personal

tasks so that no

one else can see

them.

You will see a

stream update

when you add or

edit the task, but

other users will

not.

Go to

 >

Task and select Project >

None (personal task).

Go to Actions > Tasks.

In the Project drop-down

menu, select Personal.
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Content Limited to Specific People

Content Item Description Are streams

updated?

To limit the item to

Specific People:

To find the item later:

Documents

and Uploaded

Documents

When you

publish a

document limited

to Specific

People, it

is stored in

your personal

container and

is private to you

and the other

people you

designated.

You and the

other Specific

People will a

stream update

when you

publish, but

other users will

not.

Before you publish the

document, set its visibility

option to Specific People.

Go to Content >

Authored > Documents

and then select Filter

by personal content.

The light lock icon next to

the document indicates

it is limited to you and

the other people you

designated.

Discussions When you

publish a

discussion

limited to

Specific

People, it

is stored in

your personal

container and

is private to you

and the other

people you

designated.

You and the

other Specific

People will a

stream update

when you

publish, but

other users will

not.

Before you post the

discussion, set its visibility

option to Specific People.

Go to Content >

Authored > Discussions

and then select Filter by

personal content. The

light lock icon next to the

item indicates it is limited

to you and the other

people you designated.

Messages You can send

one or more

other users a

private message.

Messages are

listed in the

Inbox. They do

not appear in

streams.

Go to

 >

Message and select

the person(s) to whom

you want to send the

message.

Go to Inbox. In the Filter

drop-down menu, select

Messages.

Content You Cannot Hide

• Blog Posts

• Discussions
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• Polls

• Status Updates (however, you can limit your status update to a group if you want to limit its audience)

• Projects

Remote Access
If you aren't sitting at a computer, you still have options for accessing and interacting with a community.

Accessing the Community From a Mobile Device

Jive is accessible from mobile devices using the mobile Safari browser or by installing the Jive for iOS app

from the Apple store onto an iPhone or iPad. For help using the iOS app, see the linked documentation.

Posting a Reply Without Logging In

Reply to a community email from your email program and your reply will post directly into your community.

If your community manager has turned on this feature, you can post a reply to something by replying to a

notification email. You first need to set your user Preferences to receive email notifications on a particular

stream, so that when someone updates something you follow in that stream, you'll get an email about it.

(To understand how email notifications work, see Customizing Email Notifications on page 31).

To reply by email, just click Reply in your email program and then type your discussion reply just as you'd

type a reply to any email; then send the email. If the community is set up to receive replies via email, your

reply will be posted as if you'd logged in to your community and posted it from there.

Creating New Content Without Logging In

If your community supports it, you can post new content simply by sending an email to the community.

This feature can be especially handy for posting when you can't reach the community using a browser. For

example, you can email content from a cell phone that sends email.

Each place in your community provides email addresses for the content you can post via email. For

example, you can send an email to the address corresponding to documents in a place, and a new

document will be created there. Use the email addresses for the specific content you want to post. The

subject line of your email will be the document's title, while the email's body will be its content body. For

status updates, you can include a subject line and/or content in the email body. If you include both, the

subject line and the email body content will be separated by a line break in your posted status update; if

you include only a subject line or only email body content, then that is the only content you will see in your

status update.

To create community content with email:

1. Click your avatar in the top right and then View Profile to open your profile.

2. Click Actions > Create content by email. You won't see this option if your administrator has not

activated the ability to create content by email.

3. Select the types of content you want to create.
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4. Click Actions > Email vCards. You should receive an email from your community that includes this

vCard.

5. In your email or address book program, save the vCard as one of your Contacts. For example, in

Microsoft Outlook you can drag the vCard to your Contacts folder. On a Macintosh, you can double-

click the vCard to add it to your address book.

6. In your email application, create a new message and select the address you just added from the vCard.

7. In the email's subject, type the title you want your content to have in Jive.

8. In the body of the email, type the main part of the content. If you want to include tags, in the last line of

your email type Tags: tag1here tag2here tag3here. This will tag your content so that people can find it

more easily later.

9. Send the email to create the content in Jive.

How Do I Use Feeds?

Use RSS feeds to get content updates without having to visit the Jive application.

Like many Web sites and applications, the Jive application provides the ability to subscribe to a content

digest by using an RSS feed. By subscribing to a feed and using a feed reader (also known as an

aggregator), you can discover what has changed in the application without having to visit it. To learn more

about feeds, see What are feeds?.

Note:  RSS subscriptions are not supported if you have SSO enabled in your community because

the RSS reader cannot follow HTTP redirects for authentication.

Typically you would subscribe to Jive content using your Google, MyYahoo, Safari, Firefox, or Internet

Explorer account. After you have subscribed, you'll be able to see Jive content updates in the application

you selected. There are also reader applications specifically designed to help you collect feeds.

You can subscribe to feeds for places, discussions, or blogs.

To subscribe to an RSS feed for a specific discussion, go to the discussion and click the RSS feed icon

next to the content author's name and time stamp, like this:

 

 

To subscribe to an RSS feed for a space, group, or blog, go to its home page and click the feeds icon

under the Actions menu, like this:

 

http://en.wikipedia.org/wiki/Aggregator
http://en.wikipedia.org/wiki/Aggregator
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For groups, spaces, and blogs, after you click the RSS feed icon, you'll see a list of available feeds for that

place. You can subscribe to one or more content types that are posted in that group, space, or blog. For

example, you may want to subscribe to only discussions posted in a group or only the comments of a blog.

To subscribe, click on the content type you want.
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Next, select the application you want to use as your feed reader (typically Google, MyYahoo, Safari,

Firefox, or Internet Explorer) and click Subscribe Now.

Note:  When you subscribe, you may need to associate your user name and password with the

subscription. That's because the feed reader is getting information from Jive on your behalf.

Jive needs to know it's not giving the information to just anyone. Please note that the need to

authenticate means that feeds are not supported for Outlook 2007, which does not support feeds

that require authentication. Microsoft provides a limited workaroundif you use Internet Explorer.

Advanced Group Management
Group owners have a number of permissions that can help them effectively manage groups and group

membership.

Group Owner and Administrator Permissions

A group's administrator has almost all the same abilities to manage a group as the group's owner (the one

who creates the group), except a group administrator cannot delete the group unless they are also the

Community Administrator.

Besides deleting the group, Group owners and administrators can also customize the group Overview

page or manage group members, which includes actions such as disabling them, deleting them, or sending

them messages.

http://support.microsoft.com/kb/917125
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How Do I Change a Group's Details?

You can edit group details to customize your group name, description, image, type and so on.

If you're a group owner or administrator, you can edit details such as the group's name, description, type,

and so on — the same things you entered when you created the group. These details help people find your

group and know exactly what your group is up to. Think of the group's details as a book cover that potential

members can glance at to decide whether the group is something they need follow to get the latest news.

1. Go to the Overview page for your group, and then click Manage > Settings.

2. Change to update your group information like you did when you created the group.

Managing Group Members

By managing group members, you can make changes like disabling them, deleting them, or sending them

messages.

Managing group members enables you to ban/disable members, delete members from the group, send

messages to members, and more. You can also export member information as a contact list which can be

imported into another application, such as an email address book.

This is also the place to change a selected member's role from administrator to member, or back the other

way. An administrator role lets the member make the same kinds of changes you can make as the group's

owner.

To manage group members:

1. Go to the group's main page.

2. Click Manage > Members to the top right.

To manage multiple members at once, select all members you want to modify and then use the Modify

selected drop-down list to select the action you want to apply to all selected members.

3. Click Change > Change Role, Disable or Delete next to the members you want to manage.

4. Click OK.

Customizing the News Page
Users with Manage Community or Manage News Streams permissions can configure the News page of

the community, which features a variety of configurable tiles and subscription streams curated for specific

users or groups of users.

What Is News?

News is the central place for you to see what's happening in the community.

The News page features a variety of streams created for you by your community manager, designed to

direct you to content, people, and places that pertain directly to you. You'll also see your Connections

stream, any custom streams you have created, the Top & Trending stream, and the Most Recent stream,

which shows recent activity from all over the community that you have permission to see.
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You can pin any of the streams listed on your News page to the News button. Just click News and then

the pin icon or triangle next to your desired page's name in the left sidebar. Now when you click News from

anywhere in the application, you'll be taken right to the page you pinned.

The News page also features a variety of tiles to help you find important people, places, and content

quickly. The Trending Content and Trending People tiles are included by default, but may be removed by

your community manager.

Here's an overview of what you'll see on the News page. For a quick visual tour of the News interface, click

here.

News (top-level view) The News view aggregates and displays only new

content posted in your News and Connections

streams. However, unlike your other streams, News

will not show content updates and comments in the

stream. In addition, content that gets updated or

interacted with is not bumped to the top of the News

view. So, to repeat, the News view shows only new

things.

Because the News view aggregates new posts

from your News and Connections streams, content

is pulled in and displayed in the News view in the

order in which your streams are displayed in the

left sidebar. Six items from each stream are pulled

in and shown in creation-date order. Duplicated

content is removed if it's already being pulled in

from a higher-order stream. Content you've read (by

clicking-through to it either from your desktop or a

mobile version of Jive) will stay in News for three

days before going away. Content you haven't yet

read will stay for seven days. Because the News

streams are designed just for you, you won't see

the same content pulled into the News view that

others will see.

News streams These are the streams you see listed above

the Connections stream. They are created and

managed by your community manager or people

with Manage News Streams permissions. Because

these streams are designed just for you, you may

not see the same News streams or the same

content in them that others see. To learn more, be
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sure to read What Are News Streams? on page

25

Connections stream This is a built-in stream where you are automatically

following some of your colleagues, but you can

add to or delete content, people, and places from

it. This stream can be a good way to avoid stream

proliferation if you just want to check in throughout

the day with things that interest you without having

to create a lot of custom streams.

Your custom streams If you've created any custom streams, you'll see

those listed below the Connections stream. Custom

streams can be a great way to keep up with the

content, people, and places that matter most to

you in your community. Here are some examples

of custom streams you might want to create for

yourself.

For a quick visual tour of the custom streams

interface, click here.

Top & Trending stream Check out this stream to get a feel for what's

happening right now. The Recommended

Content and People widgets, as well as the

Trending Content and People widgets, show you

what's generating a lot of interest around the

community. To learn more, take a look at Using

Your Recommendations on page 42.

Most Recent stream This stream shows you all community updates that

you have permission to see as they are posted

in real time. Scrolling through this stream can be

useful for adding new people and content to your

Connections or custom streams.

What Are News Streams?

News streams are configured for you by your community manager and are designed to bring you the latest

news from your organization, department, team, or product.

News streams are listed above the Connections stream. Because they are designed just for you, you may

not see the same News streams or the same content in them that others see.

For example, everyone in your community may see the "CEO's Blog" stream that shows the latest blog

posts from your organization's CEO. However, only people in the Marketing department may have a

stream called "Marketing News" that shows activity from the Marketing space.
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In addition, you might have a news stream based on your role in the community. For example, let's say

everyone has a stream called "What’s New," but what is displayed there will be different depending on your

role. So Customers might see content pulled from the Special Promotions blog in their What's New stream,

but vendors might see content pulled from the New Solutions group.

To learn more about streams and how they work, be sure to read What Are Streams?

Tips for Creating News Streams

Before you create a news stream, here are some questions to consider.

Does absolutely everyone need this

information?

News streams created for Everyone will display

on the News page for all registered community

users. If you work in a large organization, this could

include all people across a wide variety of job roles,

divisions, and locations. If you're confident the

information will be relevant to all of these users,

follow the instructions in  Creating a News Stream

for Everyone.

How much traffic is generated by the place or

blog I want to share content from?

Be sure that the place you select for the news

stream isn't too noisy for the intended audience.

For example, if your Sales group sometimes

contains social chatter, consider creating a more

controlled group or blog that contains only key

communications, and use that one for the News

stream.

Who, exactly, needs this News stream? You can define audiences by selecting individual

people, by filtering on profile fields, and/or by

selecting a user permissions group defined in Jive.

The last two choices may require some preparation

on your part: to make sure you're using profile fields

consistently, and to create any permissions groups

you need for targeting an audience. Note that the

system-defined groups in Jive (under People >

Management > User Group Summary) cannot

be used to target audiences. You can use any

custom-defined groups shown in this screen. These

groups may be created manually or synced from

an SSO provider. You may need to work with your

community manager to define user groups.

What are some examples of News streams I

might create?

For a detailed example of how you might create

News streams for your community, be sure to read
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this article in the Jive Community. You must be a

registered community user to see this content.

Creating a News Stream for Everyone

Here's how to create a News stream for all registered users to see.

Users see News streams listed above the Connections stream. You must have Manage News Streams or

Manage Community permissions to create, modify, or delete News streams.

For a detailed example of how you might create News streams, be sure to read this article in the Jive

Community. You must be a registered community user to see this content.

To create a News stream for everyone in the community:

1. Go to the News page and click

.

Restriction:  You'll only be able to see this icon if you are a community manager or have

Manage News Streams permissions.

2. Click Everyone.

3. Give the new stream a title, for example, "Executive News" or "CEO Blog." This is the stream name

users will see on the News page.

4. Under Places/Blogs, enter or select the place or blog you want the stream to pull content from.

Tip:  If you see both a place and the place's blog listed, keep in mind that selecting the blog

would post less content in the stream. In other words, selecting a place means any new content

created there will show up in the stream. Selecting the blog means only blog posts will show up.

5. Under Audience, decide whether you want guest users (users who have not registered) to be able to

see the stream. This is only relevant if your community is visible to unregistered users.

6. Under Email Options, select whether you want the stream's users to receive email or mobile

notifications every time new content is posted in the place or blog.

Tip:  Generally speaking, we recommend setting this to Off. However, you'll likely want to

enable notifications on the most important content that your users cannot miss. Just keep in

mind that if notifications get noisy, users may stop reading the content.

7. Click Save, then Publish Layout.

You can create up to ten news streams, which will display on the News page in the order listed. You can

reorder the list by dragging a stream to a new position.

Creating a News Stream for Specific Users

Create a News stream to show a different selection of content to different audiences.

You must have Manage News Streams or Manage Community permissions to create, modify, or delete

News streams.

To create a News stream so that specific users will see content relevant to them:

https://community.jivesoftware.com/docs/DOC-145072
https://community.jivesoftware.com/docs/DOC-145072
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1. Go to the News page and click

.

Restriction:  You'll only be able to see this icon if you are a community manager or have

Manage News Streams permissions.

2. Click Specific Users.

3. Give the new stream a title, for example "Management Ideas" or "My Team News." This is the stream

name users will see on the News page.

Tip:  Make the stream title work for every rule you are going to create for this stream. For

example, you could create a heading called "Management Ideas" and then create different rules

that direct new content from Finance groups to the Finance managers, blog posts from the

Technical Managers group to Engineering managers, and so on. You could then add a stream

rule targeting content from Human Resources management groups to all these management

groups, because those management ideas can apply to any manager.

4. Select Create Stream Rule.

5. Under Places/Blogs, enter or select the place or blog you want the stream to pull content from.

Tip:  If you see both a place and the place's blog listed, keep in mind that selecting the blog

would post less content in the stream. In other words, selecting a place means any new content

created there will show up in the stream. Selecting the blog means only blog posts will show up.

6. Under Audience, enter the users and group of users who will be able to view the stream. You can also

enter profile field values.

Note:  For more information on filtering based on a profile field, be sure to read this article in the

Jive Community. You must be a registered community user to see this content.

You also have the option to select Create profile filter so that you can filter your audience based on a

combination of profile fields.

7. Click Save.

8. Under Email Options, select whether you want the stream's users to receive email notifications every

time new content is posted in the place or blog.

Tip:  Generally speaking, we recommend setting this to Off. However, you'll likely want to

enable notifications on the most important content that your users cannot miss. Just keep in

mind that if notifications get noisy, users may stop reading the content.

9. Click Save.

10.Click Publish Layout.

You can create up to ten news streams, which will display on the News page in the order listed. You can

reorder the list by dragging a stream to a new position.

For a detailed example of how you might create News streams, be sure to read this article

in the Jive Community. You must be a registered community user to see this content.

https://community.jivesoftware.com/docs/DOC-145072#jive_content_id_Creating_an_AudienceSpecific_News_Stream
https://community.jivesoftware.com/docs/DOC-145072
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News Page Tile Reference

Here's a complete list of the tiles available on the News page.

To learn more about using tiles, be sure to read Using Tiles.

Table 7: Your Tiles

Tile Description Dependencies

Your Custom

Tile Name

Any custom tiles you have created will be

listed here.

You must first Create New Tile to see the

Your Tiles option under Categories.

Table 8: Content Tiles

Tile Description Dependencies

Document Viewer Shows a full preview of a document you choose to display. Content added

manually.

Helpful Links Build a list of key items for quick reference. Links can be

internal to your community or external URLs.

Content added

manually.

Key Content and

Places

Displays a list of content and places that you can edit and

manage yourself.

Content added

manually.

Featured Video Shows a manually selected video from an external, non-

community source.

Content added

manually.

Image Gallery Create a slideshow with images and captions. Content added

manually.

Tagged Content Displays content that matches specific tags. Relies on content

being tagged.

Expandable

Sections

Shows links to community content under collapsible headings. Content added

manually.

Latest Blog Posts Shows the newest blog posts in your community. (You won't

see this tile if your community manager has disabled blogs in

your community.)

Content added

manually.

Carousel Link a rotating image carousel to key destinations. Content added

manually.

Trending Content Shows content that's attracting views and interactions. This tile

appears by default on the News page. You can remove it by

clicking the garbage can icon.

Relies on an

algorithm.

Ask a Question Find a previously asked or answered question, or ask a new

one.

Content added

manually.
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Table 9: People Tiles

Tile Description Dependencies

Featured People Build a list of important people for your place. Content added

manually.

Trending People Displays the avatars of people trending in the community. This

tile appears by default on the News page. You can remove it

by clicking the garbage can icon.

Relies on an

algorithm.

Table 10: Places Tiles

Tile Description Dependencies

Similar Places Shows places with the same tags. Relies on content

being tagged.

Key Content and

Places

Displays a list of content and places that you can edit and

manage yourself.

Content added

manually.

Table 11: Other Tiles

Tile Description Dependencies

Key Dates Show selected dates for your team. Content added

manually.

Featured People Build a list of important people for your place. Content added

manually.

Key Content and

Places

Displays a list of content and places that you can edit and

manage yourself.

Content added

manually.

Featured Video Shows a manually selected video from an external, non-

community source.

Content added

manually.

Image Gallery Create a slideshow with images and captions. Content added

manually.

Carousel Link a rotating image carousel to key destinations. Content added

manually.

Featured Video

(internal)

Display a video from your community. Content added

manually.

Configuring News FAQ

Here are some frequently asked questions and answers about configuring the News page and News

streams.
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Who can create and modify the News page and

News streams?

People with Manage News Streams permissions

have the rights to modify the News page and

create, modify, or delete News streams, including

those set up by other people with Manage News

Streams permissions. People with Manage

Community permissions already have these rights.

Community managers can give someone Manage

News Streams permissions, by going to People >

Permissions > System Administration and

creating a user override to assign the user Manage

News Streams permissions.

Can I add a secret place to a News stream? Yes, if you are an owner or member of the secret

place. Be aware when adding a secret place to a

News stream that other users with Manage News

Streams or Manage Community permissions will be

able to see this stream greyed-out when configuring

News. They will not be able to modify or delete a

News stream that has a secret place to which they

are not an owner or member.

Is there a limit to the number of News streams

the community can have?

There can be up to 10 News streams configured

in your community. (This does not include each

user's ability to create up to 10 custom streams of

their own; so in theory, a user could see 10 News

streams and 10 of their own custom streams listed

in the left sidebar).

How many rules can I have per news stream? You can have 100 rules in a news stream. Within

each rule, audiences and places are essentially

unlimited.

Can I change the name of the News button on

the navigation bar?

Yes. Just use the Single custom links feature in the

theming interface. To learn more, be sure to read

Main Navigation Options Reference.

News Streams Administration

News is a newly added set of features that is enabled by default in new communities. The News page

functions as a central news page for your community. It is enabled by default. In the next release, News

will be enabled for all communities, and you won't be able to turn it off.

News is deeply integrated into your community's architecture, so turning it on and off has significant

effects on how users navigate around the community. With News enabled, users will see News in the main

navigation. By default, it is the landing page for users when they log in. But the News feature is also linked



 | Using a Jive Community | 143

to a large number of navigation changes that determine how end users find and interact with content. You

shouldn't turn News off in a working community, because you'll risk confusing your users.

For more information about setting up News, see Customizing the News Page on page 134.

Designing Activity Pages for Places
To customize a space, group, or project with a preconfigured set of content options designed for specific

collaboration goals, select an Activity page as the landing page and then apply and configure a Place

Template.

An Activity page shows a real-time activity stream of updates happening in the place, such as status

updates and replies to content. Place templates are the starting point for setting up an Activity page: each

template contains an activity stream, plus a configurable group of tiles that reflect typical collaboration

goals. When you edit an existing place, create a group, start a project, or (if you have permission) create a

new space, you'll choose from a list of pre-designed Place Templates. Just quickly set up a few key tiles to

start collaborating in reality-tested environments such as:

• A Deal Room for building out a sales opportunity with your team

• A Vendor Collaboration place for partnering with external talent

• A private Pre-Hire Collaboration place for discussing potential job candidates

When you use a place template you can add and remove any of the tiles and move them around within the

layout. Tiles are visual building blocks of information. They may dynamically pull data either from around

your Jive installation or from a third-party service, or they may be configured with information you've hand-

selected.

Assigning a Place Template

When you assign a Place Template to an existing project, space, or group, you get a preconfigured Activity

page that contains the tiles and layout included in the template.

Assigning a Place Template to a place only affects the Activity page in that place. It changes the selection

of tiles on the Activity page and the order they're displayed in.

Warning:  When you assign a new Place Template to a place whose tiles have been configured,

you lose any configuration in the tiles. For example, if you created a People list, it will be wiped out

and replaced with empty, unconfigured tiles, even if the new Place Template includes a People tile.

The exception is that Salesforce authentication will persist if you apply a different Place Template

that uses a Salesforce connection.

To assign a new Place Template to an existing place:

1. Navigate to a place you have rights to modify.

2. Click Manage > Settings to enter the edit view of the place.

3. Once in edit view, you can click Browse Templates in the top left just under Home.

4. Choose a Place Template for this place. Place templates determine what tiles and streams will

provide the layout and data for your group's Activity page. Choose the one that's right for the kind of

collaboration that will happen here.
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5. Click Apply Template.

6. Click

and configure each tile that requires it.

7. Click Apply in the tile dialog.

8. Click Save to update the place with your changes.

Creating a New Place Template

You can create a new place template based on a currently configured place using the settings under

Manage > Save as new template. Only edited templates have the option of being saved as new ones.

If you want to create a new Place Template, you can base one on the tiles included in an existing place

you've configured and saved. For example, if you create a group using the General Collaboration template,

but add and delete some tiles to include different information in that group, you can use Save as new

template to save the layout of the tiles as a Place Template. Then you can assign that template to other

places you create.

Note:  If you have Community Manager rights, you can save Place Templates as Community

templates so that other people in the community can use them. If you're not, only you will see your

saved templates in My Templates.

A template saves the type, order, and layout of tiles for a place. It does not save the configuration of those

tiles. If you've created lists of links using the Helpful Links tile, for example, and saved a template based on

that place, places with that template assigned will have the Helpful Links tile in the same position. But they

will not include the link list you created. This is true even if you later reassign that template to the same

group.

To create a template based on an existing place:

1. Go to the place you want to base the template on. You need to have rights to a place to save it as a

template.

2. Modify the current place's Activity page by selecting Manage > Settings. Make sure the tiles and

layouts are customized the way you want them before you create a template.

3. If you've made revisions to the current place's template, click Save to save them to the current

template.

4. In the Manage menu, click Save as new template and specify a name and description for the new

template. You'll only see this option if you have customized the current template.

5. Provide a name and some tags for the new template. Tags will be used to populate the Similar Places

tile.

6. Click Save.

7. If you want to apply the new template to a place, click Manage > Settings, and then select the new

template from Browse Templates > My Templates to select and apply it.
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Place Template Reference

Each Place Template contains a unique selection of tiles customized for a specific collaborative activity,

such as Sales or IT.

Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.

It's possible to develop custom tiles that aren't included in the product, including tiles for third-party

integrations. Check out developers.jivesoftware.com for the latest developer information and programming

tutorials to get you started.

Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.

General Place Templates

General Place Templates are useful for general collaboration cases not focused on a specific business

function, and can easily be used as the base for custom templates.

Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.

Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.

https://developers.jivesoftware.com/
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Table 12: Available in Internally-facing Communities

Place Template Tiles Features Default Type Default Tag(s)

Team Collaboration Top Participants

Key Content

and Places

Featured

Content

Recent

Decisions

Finalized

Content

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open —

Best Practices Sharing Featured

Content

Popular Content

Image Gallery

Top Participants

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open best practice
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Place Template Tiles Features Default Type Default Tag(s)

Customer 360 Gauge

Featured

Content

Helpful Links

Featured

People

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open —

War Room Gauge

Finalized

Content

Action Items

Top Participants

Featured

Content

Documents

Discussions

Projects

Status Updates

(in groups only)

Open —

Table 13: Available in Externally-facing Communities

Place Template Tiles Features Default Type Default Tag(s)

Community Member Group Key Content

and Places

Popular Content

Top Participants

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Open —
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Place Template Tiles Features Default Type Default Tag(s)

Video Channel Featured Video

(3)

Featured

Content

Videos

Discussions

Open video

Blog Central Top Participants

Featured

Content

Popular Content

Blogs Open blogs

Corporate Communications Place Templates

Corporate Communications Place Templates include selections of tiles focused on sharing videos, live

events, communications planning, and blogging.

Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.

Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.

Place Template Tiles Features Default Type Default Tag(s)

Blog Central Top Participants

Featured

Content

Popular Content

Blogs

Status Updates

(in groups only)

Open blogs
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Place Template Tiles Features Default Type Default Tag(s)

Communications Planning Key Dates

Featured

Content

Action Items

Recent

Decisions

Finalized

Content

Image Gallery

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Private corp comms

Live Event Activity Streaming Top Participants

Key Dates

Documents

Status Updates

(in groups only)

Open event, stream

Customer Service Place Templates

Customer Service Place Templates include selections of tiles focused on finding information and

supporting customers.

Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.

Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.
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Place Template Tiles Features Default Type Default Tag(s)

Knowledge Management Key Content

and Places

Featured

Content

Finalized

Content

Documents Open help, knowledge

base,

documentation

Customer Support Featured

People

Action Items

Recent

Decisions

Finalized

Content

Popular Content

Documents

Discussions

Secret —

Support and Community Team

Backchannel (private discussions)
Featured

Content

Recent

Decisions

Top Participants

Documents

Discussions

Ideas

Secret backchannel

Project Management Gauge

Key Dates

Key Content

and Places

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Secret —

Human Resources Place Templates

Human Resources Place Templates include selections of tiles focused on HR team communications and

pre-hire communication with future employees.
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Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.

Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.

Place Template Tiles Features Default Type Default Tag(s)

Best Practices Sharing Featured

Content

Popular Content

Image Gallery

Top Participants

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open —

Pre-Hire Collaboration Featured

People

Key Content

and Places

Helpful Links

Action Items

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Private

Externally-

accessible

pre-hire
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IT Place Templates

Information Technology Place Templates include selections of tiles focused on technology rollouts,

helpdesk support, and upgrade planning.

Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.

Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.

Place Template Tiles Features Default Type Default Tag(s)

Best Practices Sharing Featured

Content

Popular Content

Image Gallery

Top Participants

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open best practice
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Place Template Tiles Features Default Type Default Tag(s)

Technology Rollout and Support Featured Video

Featured

Content

Finalized

Content

Key Dates

Helpful Links

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open technology

IT Helpdesk Collaboration Featured

Content

Popular Content

Helpful Links

Action Items

Recent

Decisions

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open helpdesk
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Place Template Tiles Features Default Type Default Tag(s)

IT Upgrade Planning Key Dates

Action Items

Featured

People

Helpful Links

Image Gallery

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open it, upgrade

RFP Workgroup Key Dates

Popular Content

Finalized

Content

Top Participants

Key Content

and Places

Gauge

Documents

Discussions

Projects

Status Updates

(in groups only)

Private request_for_proposal,

rfp

Marketing Place Templates

Marketing Place Templates include selections of tiles focused on assembling marketing campaigns and

collateral.

Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.

Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.
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Table 14: Available in Internally-facing Communities

Place Template Tiles Features Default Type Default

Tag(s)

Event Planning Key Dates

Featured Content

Gauge

Popular Content

Recent Decisions

Documents

Discussions

Ideas

Projects

Status

Updates (in

groups only)

Private event

Customer, Partner, or

Vendor Collaboration
Key Dates

Top Participants

Helpful Links

Finalized Content

Action Items

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status

Updates (in

groups only)

Private

Externally-

accessible

agency,

customer,

partner,

vendor
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Place Template Tiles Features Default Type Default

Tag(s)

Campaign Planning Top Participants

Finalized Content

Action Items

Key Content and Places

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status

Updates (in

groups only)

Private assets,

campaign

Customer Success Stories Top Participants

Featured Content

Popular Content

Blogs

Documents

Status

Updates (in

groups only)

Open success_stories,

win

Table 15: Available in Externally-facing Communities

Place Template Tiles Features Default Type Default Tag(s)

Event Planning Key Dates

Featured

Content

Gauge

Popular Content

Recent

Decisions

Documents

Discussions

Ideas

Projects

Secret event
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Place Template Tiles Features Default Type Default Tag(s)

Customer, Partner, or Vendor

Collaboration
Key Dates

Top Participants

Helpful Links

Finalized

Content

Action Items

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Secret partner

Customer Event Key Dates

Key Content

and Places

Top Participants

Events

Blogs

Documents

Discussions

Open —

Partner Enablement Popular Content

Key Content

and Places

Featured Video

Featured

Content

Featured

People

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Open —

Products Place Templates

Products Place Templates include tiles for information used to launch and manage products.

Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.
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Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.

Place Template Tiles Features Default Type Default Tag(s)

Product Launch Planning Top Participants

Finalized

Content

Action Items

Key Content

and Places

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Private assets,

campaign

Product Launch — Documents

Discussions

Blogs

Open assets,

campaign

Product and Services Feedback Featured

Content

Action Items

Ideas

Documents

Discussions

Polls

Blogs

Open feedback

Beta Testing Featured

Content

Action Items

Recent

Decisions

Top Participants

Ideas

Documents

Discussions

Polls

Blogs

Secret —

Research and Development Templates

Research and Development Place Templates contain selections of tiles focused on innovation and

collaboration R&D organizations, including FAQ and vendor collaboration.
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Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.

Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.

Place Template Tiles Features Default Type Default Tag(s)

Best Practices Sharing Featured

Content

Popular Content

Image Gallery

Top Participants

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open best practice

R&D Planning Action Items

Popular Content

Top Participants

Recent

Decisions

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open development,

research
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Sales Place Templates

Sales Place Templates include tiles for information used to plan and close deals, including some

integrations with Salesforce.com.

Templates are organized according to the kind of workgroup that typically uses them, but you can rename

and customize any template. The right template contains more or less the tiles that you need. For example,

if you want to set up a place to track items identified for quick follow-up, you could pick the Sales Answer

Desk template when creating the place, even if Sales isn't your main goal. This template includes a

Featured People tile to identify people you can direct questions to, tracks items marked for Action and

recent decisions, and surfaces popular content. For more information about data tiles and the information

they're based on, see the Tile Reference.

Note:  You may not see events or ideas as feature options in a template if your community does not

have these additional modules enabled. In addition, externally-facing communities (those serving

customers, partners, and vendors), do not have the Corporate Communications, HR, IT, or R&D,

or Sales templates. Internally-facing communities (those serving employees), do not have the

Customer Service, Other, or Products templates.

Place Template Tiles Features Default Type Default Tag(s)

Sales Home Popular Content

Key Content and

Places

Featured Video

Featured

Content

Featured People

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open sales

Sales Answer Desk Popular Content

Helpful Links

Featured People

Action Items

Recent

Decisions

Videos

Discussions

Blogs

Documents

Projects

Open questions, sales
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Place Template Tiles Features Default Type Default Tag(s)

Deal Room Generic Top Participants

Popular Content

Action Items

Finalized

Content

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open deal_room, win

RFP Workgroup Key Dates

Popular Content

Finalized

Content

Top Participants

Key Content and

Places

Gauge

Documents

Discussions

Projects

Status Updates

(in groups only)

Private request_for_proposal,

rfp

Competition Featured People

Top Participants

Featured

Content

Popular Content

Key Content and

Places

Documents

Discussions

Blogs

Projects

Status Updates

(in groups only)

Secret competition



 | Using a Jive Community | 162

Place Template Tiles Features Default Type Default Tag(s)

Customer 360 Gauge

Featured

Content

Helpful Links

Featured People

Key Dates

Videos

Documents

Discussions

Ideas

Polls

Events

Blogs

Projects

Status Updates

(in groups only)

Open —

Designing Place Overview Pages
You can define the content and layout of place Overview pages for which you have administrator rights.

Places (social groups, projects, and spaces) become more inviting when you customize their overview

pages to display the items members care about most. Depending on your overview page customization

rights, you can easily get these pages to look the way you want by using widgets that help you choose and

arrange content. Each widget displays content of a particular kind — for example, HTML, recent content, or

feed subscription results — in a box that you can drag into position on a page. After you publish the page,

you can always come back and update its content or design. A complete reference to available widgets

can be found here. The steps for customizing overview pages are here.

This topic offers a few key guidelines for designing pages with widgets. A good starting point for thinking

further about designing Overview pages is this blog post in the Jive Community: Extreme Makeover:

Widget Edition.

Overview Page Best Practices

• What is the purpose of your site, space, or group? Make sure the widgets you choose help users

identify the purpose of the place and quickly find the information they need.

• Keep in mind that with widgets, less is more. Highly complex pages can lead to performance challenges

as well as user confusion. You should use only as many widgets as you need to provide key information

for the place without overloading it.

• Make sure you also limit the number of images on the page. Loading many images on every page load

can make your page slower and create visual clutter.

• Limit group and space ownership to one or a very few users to safeguard your design and protect

security.

https://community.jivesoftware.com/community/deprecated/community-management/blog/2012/12/05/extreme-makeover-widget-edition
https://community.jivesoftware.com/community/deprecated/community-management/blog/2012/12/05/extreme-makeover-widget-edition
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Setting Up a Place's Overview Page

To begin customizing the Overview page of a place, navigate there and click Manage > Overview Page.

When you customize the Overview page for a place, you decide on a column view, then drag widgets into

the layout. If you've chosen widgets that require further configuration, you'll then edit them to ensure the

correct activity flows into them, or populate them with content.

Note:  You can see the Overview page as an option in a place only if it is selected from the

Advanced Options in the place's Settings (Manage > Settings > Click the place's Name).

To customize the Overview page:

1. Go to the Overview page for the place you want to customize and click Manage > Overview page.

You'll see a layout interface with the available layouts and widgets listed at the top.

2. Select a layout from the Layout column.

 

 

3. In the widgets list, find the widgets you want and drag them into the layout area.
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4. After the widget is in the layout area, you can customize it by clicking the Edit this widget link (it's

under the little arrow in the widget's upper right corner).
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5. If you want to remove any widgets, click the Remove this widget link (it's under the arrow in each

widget's upper right corner).

6. To save all your changes to the layout and make them visible to other users, click Publish Layout.

Updating Places That Have an Overview Page

Places created in an earlier version have an old-style Overview page, not a dynamic Activity page. You can

easily change them to use an Activity page.

Existing places will keep their old-style Overview pages after an upgrade, but will also be assigned the

General > Team Collaboration Place Template by default. However, you'll see this template only if you

have set the Activity page to be displayed. If you want to keep the old Overview page and not display

the Activity page, do nothing. If you want to create a new Place Template-driven Activity page, which

leverages data streams and uses more performant data tiles, you can configure the Team Collaboration

template to include the data you want to show, or choose a different one. See the instructions in this topic

for showing and hiding the Overview and Activity Pages the way you prefer them. You can choose to show

only one or both of these pages, but only one can be the default landing page (the place where visitors to

the place land by default when they navigate to the place). For more about Place Templates, see Using

Place Templates.

To set the visibility of the Activity Page as well as the old-style widgetized Overview Page for an existing

place:

Note:  If you use the checkpoint and status functionality for tracking project tasks, you may want

to stick with the old-style Overview page rather than updating to the Place Template format. The

widgets in the Overview page more effectively support Projects at this time.
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1. Navigate to the place you own and click Manage > Settings to enter the edit view of the place.

2. Click the group name to open the Edit Group dialog.

3. Click Advanced options at the bottom.

4. Under Enable, click Overview Page, Activity Page, or Both. Selecting Both lets you show the

Overview page alongside the Activity page. If you selected either Activity Page or Overview Page,

that page will be the default home page, or the first page users see when they navigate to the place.

5. If you selected Both, you'll see an option to set the default landing page under Set landing page.

6. Click OK when you're finished. These changes won't take affect until you Save the changes you've

made to the place.

Setting Up Image Navigation

You can configure any place's Overview page, including the community Home page, with image-based

navigation to quickly direct your users to useful pages. First, you'll add the Image Navigation Widget to

your place's layout, then add images and links to the widget.

Add the Image Navigation Widget to Your Place's Layout

1. Go to the place you own and click Manage > Overview Page to begin editing the place's Overview

page.

2. From the widgets list, select Other > Image Navigation Widget.

3. Drag the widget down into your layout area and drop it where you want it.

4. Click the small triangle in the upper right corner of the widget and select Edit this widget.

5. Change the widget's title or leave that field blank if you do not want any title.

6. Select whether you want the header and border to be displayed.

7. Click Save Properties.

Add Images to the Widget

After you've added the Image Navigation Widget to your place's layout, you'll add images and links to the

widget, then publish the updated layout of the place.

1. Click the small triangle in the upper right corner of the Image Navigation Widget and select Edit this

widget.

2. Click Add a new image link.

3. In the "Provide a Target Link" field, type in the URL that you want the image to link to.

4. Provide a caption for the image. You can use the caption Jive provides automatically, or overwrite it

with your own.

5. Select the image you want to use for this link, and then click Save.

6. Repeat these steps until you have all the images you want to display in the widget. The limit is 8. You

can move them around to change the order in which they are displayed by dragging and dropping them.

7. When you're finished, click Publish Layout on the editing page.
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Setting Up the Search Widget

The Search widget allows your users to quickly search a specific space or group in your community, or the

entire community.

1. Go to the place you own and click Manage > Overview Page to begin editing the place's Overview

page.

2. From the widgets list, select Content > Search Widget.

3. Drag the widget down into your layout area and drop it where you want it.

4. Click the small triangle in the upper right corner of the widget and select Edit this widget.

5. Use the title "Search Widget" or create your own, for example, "Search this Group" or "Search Me!"

6. Select the number of results to return in the search.

7. Select the place to perform the search. This can be any place in the community, or the entire

community (which would be your "root" space).

8. Click Save Properties.

9. When you're finished making changes to your place's layout, click Publish Layout.

Setting Up the Ask Widget

The Ask (a place) widget allows users to quickly ask a question in a specific space or group in your

community, or the entire community. After the user types a question into the Ask widget, the search

function displays possible answers based on matching keywords. If the user doesn't see the correct

answer in the results list, they can create a discussion right from the widget. This can be very helpful in

places designed to support customers or employees.

1. Go to the place you own and click Manage > Overview Page to begin editing the place's Overview

page.

2. From the widgets list, select Content > Ask (place).

3. Drag the widget down into your layout area and drop it where you want it.

4. Click the small triangle in the upper right corner of the widget and select Edit this widget.

5. Use the title "Ask (place)" or create your own, for example, "Ask Us a Question". You can also change

the text that will be displayed on the actual Ask button, for example, instead of "Ask It," you might want

"Submit Your Question".

6. Specify the place you want to perform the search. You can search in the current place, a single place

that you specify, or all public places in the community (this would be your "root" space).

7. Select the number of results to return in the search.

8. You have some options for what will be displayed in the search results. You can select one, some, or all

of these options:

Option Description

All Questions Displays in search results all questions that have

been asked, whether or not they have been

answered.
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Option Description

All Discussions Displays only discussions in search results.

Answered Questions Displays only Answered Questions in search

results.

Documents Displays only documents in search results.

9. Select the place you want questions posted to. This can be different from the place where the Ask

widget is located. For example, you could put the Ask widget in an "Employee Questions" group, but

post the questions to the "Employee Q&A" group.

10.Click Save Properties.

11.When you're finished making changes to your place's layout, click Publish Layout.

Setting Up the Answered Questions Widget

The Answered Questions widget allows your users to quickly see a list of questions that have been

answered in a specific space or group in your community, or the entire community. Answered questions

displayed in this widget are those that include a reply or comment marked as a "Correct Answer".

1. Go to the place you own and click Manage > Overview Page to begin editing the place's Overview

page.

2. From the widgets list, select Content > Answered Questions.

3. Drag the widget down into your layout area and drop it where you want it.

4. Click the small triangle in the upper right corner of the widget and select Edit this widget.

5. Use the title "Answered Questions" or create your own, for example, "Recently Answered".

6. Select the number of answered questions to display in the widget.

7. Select the order in which you want the answered questions to be displayed.

8. Specify the place you want to pull the answered questions from. Typically, you'll want this to be the

current place, but it could be any other place in the community as well, or the entire community (this

would be your "root" space).

9. Click Save Properties.

10.When you're finished making changes to your place's layout, click Publish Layout.

HTML and Formatted Text Widgets

The HTML and Formatted Text widgets are extremely flexible, but should be used carefully to ensure

effective, performant pages.

The HTML and Formatted Text widgets are designed to display customized information on Overview

places, including the community Home page. You can use them to embed all kinds of assets, including

images. These widgets are often used to provide visual orientation or branding to the site or the place. The

HTML widget also allows you to add JavaScript and CSS elements, with certain security limitations, which

are described later in this topic.
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Uploading Resources to a Widget

You can use the Formatted Text and HTML widgets to upload up to 10 file resources per place. (Spaces

can include any kind of files: groups and projects are limited to GIF, JPEG, PNG and BMP files.) Files

you upload will be stored as part of your community so you don't have to retrieve them from an external

location, which can improve performance and saves you the trouble of hosting them elsewhere. You

can then refer to these resources in any Formatted Text or HTML widget you have access to edit. For

instructions, see Uploading Static Resources to a Widget.

Warning:  Keep in mind that resources you upload this way are posted on the Internet and can

be viewed by anyone with access to the network. By design, they don't inherit the authentication

requirements of your site or the permissions to the place where you upload them.

Managing Performance

Uploading resources is a good way to limit the performance impact of resource loading from your widgets:

uploaded resources don't need to be authenticated on page load. However, you'll still want to consider user

page loads when determining the number and content of widgets.

Managing HTML Widget Security

To ensure security and prevent problems that can corrupt your pages and keep them from loading, any

HTML widget code that calls a <script> tag will be contained in an isolated iFrame. This is known as

"safe mode." If you want to include CSS or other styling in the widget, you can include it in the same

location as your HTML code. Isolation of the HTML widget also means that the widget can't borrow

JavaScript from the Overview page, and that visual components cannot extend beyond the perimeter of the

iframe. Simple HTML, JavaScript, and CSS continue to be supported.

In safe mode, you can still call the assets associated with the core Jive installation as follows: <script

src="/resources/scripts/jquery/jquery.js"></script>  <link rel="stylesheet"

href="/styles/jive.css" media="all">

It's possible for your site administrator to use a system property to override the default "safe mode"

behavior (iFrame isolation) and allow external JavaScript access from the HTML widget. However, this

approach requires caution and is not recommended. In previous versions, before the safe mode was

implemented for widgets, it was possible for corrupted widget code to cause serious problems that affected

the database.

Widget upload access should be limited to users you trust. Because any social group owner can upload

resources to these widgets, it's possible for users to make incorrect judgments about appropriateness and

security, so make sure group owners are carefully chosen.

Uploading Static Resources to a Widget

You can use the Formatted Text and HTML widgets to upload file resources into Jive, so you can link to

them directly using a URL.
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You can upload any kind of static file from a menu inside the Formatted Text and HTML widgets. You can

also see the available uploaded resources and copy their URLs so you can use them in your widget code.

You can upload up to 10 files per place.

Warning:  Keep in mind that resources you upload this way are posted on the Internet and can

be viewed by anyone with access to the network. By design, they don't inherit the authentication

requirements of your site or the permissions to the place where you upload them.

To upload a static resource:

1. Go to any Overview page you have the rights to edit.

2. Click Manage > Overview Page

3. Under Layout, click Widgets > Other > HTML or Widgets > Other > Formatted Text.

4. Click Manage Files.

5. Click Upload a File. Keep in mind that only image files are supported in for upload in groups and

projects.

Your file will be added to the Your uploaded files list.

6. To copy the URL so you can use it to refer to the file in this or another widget, click Copy to Clipboard.

7. If you want to delete the file later, you can return to the Manage Files dialog and click the x next to a file

name. Make sure you're not using the file in any widgets, because links and references to a deleted file

will be broken.

Overview Page Customization Permissions

You can customize the Overview page of places. Here is a table that lists who can change what on place

Overview pages.

Page Description Who Can Customize

Space Overview Displayed on the Overview

tab for space

An administrator for the space.

Project Overview Displayed on the Overview

tab for a project

The project's creator. Space and Group owners can

edit the Projects that live in the space/group.

Group Overview Displayed on the Overview

tab for a group

All group owners.

Community

Overview (Home)

Displayed on the front page of

your community (if configured)

Your Community Manager.

Note:  If your community is connected to another community (via what's called a "bridge"), then

you might also be able to use widgets that live in the other community. Members of both the current

community and the remote (or bridged) one can use remotely available widgets to enable viewing

content and activity on the other community.
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Available Widgets Reference

Different widgets are available in different types of pages.

The following tables show the types of widgets that can be used to customize place overview pages.

Table 16: Content Widgets

Name Description Used In

Answered Questions Shows questions that have had a reply marked as

the Correct Answer.

All

Ask (place) Allows a user to ask a question while type-ahead

search tries to answer it with a link to content in the

place. If search does not find a match, it prompts

the user to ask the question by creating a new

discussion in the place.

All

Event Calendar Displays upcoming events for the space or group

in a calendar format. Note that you must have the

Events plugin installed to see and use this widget.

Group Overview, Space

Overview

Event View Displays a specific event from any place. The event

ID is located in the URL for the event, for example,

"http://yourcommunity/version/events/1000". In this

case, the ID is 1000. Note that you must have the

Events plugin installed to see and use this widget.

All

Featured Content Shows the featured content (place owners can

designate content items to feature).

All

Featured Video Shows a featured video. Note that you must have

the Video plugin installed to see and use this

widget.

Group Overview, Project

Overview, Space

Overview

Latest Poll Shows the most recent poll created in the current

place.

All

Popular Content Shows the most liked content. Can be customized

to show any combination of recent discussions,

documents, polls, and/or blog posts from the

current place.

All

Popular Videos Shows the most liked videos. Note that you must

have the Video plugin installed to see and use this

widget.

All

Popular Tags Shows the most commonly used tags in the current

place.

All
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Name Description Used In

Recent Activity Displays a list of the most recent activity to show

what people are doing.

All

Recent Blog Posts Shows the first 200 characters of a specific user's

blog posts, plus images from the blog.

All

Recent Content Can be customized to show any combination of

recent discussions, documents, polls, blog posts,

and/or bookmarks from the current place.

All

Recent Ideas Displays the place's recent ideas. Note that you

must have the Ideation plugin installed to see and

use this widget.

All

Recent Videos Displays the place's recent videos. Note that you

must have the Video plugin installed to see and use

this widget.

All

Search Allows user to search a place. Note that you

can point this widget to any other place in the

community, not just its containing space. For

example, your Human Resources space could

search the Wellness group from this widget.

All

Tagged Event Displays the most recent event that uses a specific

tag that you define. Note that you must have the

Events plugin installed to see and use this widget.

All

Tasks Displays the upcoming tasks in this project. Project Overview

Top Ideas Shows the top ideas in the community. All

Top Liked Content Shows the content with the most likes in the current

place.

All

Top Rated Content Shows the content with the highest rating in the

current place.

All

Unanswered Questions Shows discussions in the current place that have

been marked as a question, but have not yet been

marked Answered.

All

Upcoming Events On the Home page, displays all visible upcoming

events in the system. For all other places, displays

the upcoming events for the place. Note that you

must have the Events plugin installed to see and

use this widget.

All
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Name Description Used In

View Blogs Shows blog post titles, a 200-character excerpt, or

the full content of blog posts in a specified place.

All

View Document Displays a document you select. All

Watch a Tag Shows community content that is tagged with the

tag(s) that you specify when setting up this widget.

This widget is keyed to the official Tag(s) of content;

in other words, this widget does not show content

with inline #hashtags or @mention text in the body

of the content.

All

Table 17: Place Widgets

Name Description Used In

Featured Places Shows a list of community places that you

designate.

All

Groups Shows similar groups to the current group. All

Places Shows the places around the community in a list

view sorted by place type.

Home Page

Projects Shows the place's associated projects. Group Overview, Space

Overview

Related Groups Shows a list of groups similar to the current group. Group Overview

Related Projects Shows a list of projects similar to the current

project.

Project Overview

Space Grid Shows the sub-spaces of the current space in a grid

view.

Home Page, Space

Overview

Space Tree Shows the sub-spaces of the current space in a

tree view.

Home Page, Space

Overview

Spaces Shows the sub-spaces of the current space in a list

view.

Home Page, Space

Overview

Table 18: People Widgets

Name Description Used In

Featured User Displays the selected user's profile image and basic

information with an optional description.

All

Members Shows the people who have joined the project. Project Overview



 | Using a Jive Community | 174

Name Description Used In

Newest Members Shows the people who most recently joined the

community.

Home page

Recent Activity Displays a list of the most recent activity to show

what people are doing.

All

Recently Joined Shows the people who most recently joined the

group.

Group Overview

Top Participants Show the people who created or replied to the most

activity. (Note that a user's status points displayed

in this widget refer to points earned in the given

place only.)

All

Table 19: Other Widgets

Name Description Used In

Actions Displays the Action links through which people can

create content for a place.

All

Categories Displays the administrator-defined categories for a

place.

Group Overview, Project

Overview, Space

Overview

Checkpoints Shows project milestones. Project Overview

Formatted Text Displays your text with formatting, links, and

images.

All

Group Overview Displays an image and description for the group. Group Overview

HTML Renders your HTML with JavaScript or even CSS.

You can add custom buttons to this widget using

the <button> class.

All

Image Navigation Displays a clickable menu of images and captions

linked to locations you select.

All

Project Calendar Shows checkpoints and tasks due in coming weeks. Project Overview

Project Overview Shows the project's graphic, owner, and creation

date.

Project Overview

Project Status Shows an owner-determined status for a project. Project Overview

Quick Tips Displays a random quick tip about using the

community.

Home page
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Name Description Used In

RSS Subscription Displays results of a feed from another part of the

community or from another web site.

All

Slideshow Carousel Embeds rich images and news content into a

carousel widget.

All

Social Sharing Allows one-click sharing of the place page in social

media outlets. Note that Social Sharing must

be enabled in the community by the community

manager to see this widget.

All

Space Overview Shows the space's graphic, description, tags, and

creation date.

Space Overview

Sharing Exchange Calendars in an HTML Text Widget

Using an Exchange 2010 SP1 or later email server, you can set up a community widget to show users'

Exchange calendars, with customizable levels of visible calendar details.

Caution:  Calendar sharing uses Exchange Web Services to make HTML and iCal versions of

the users' calendars available. Depending on your Exchange topology, this can (and will) publish

calendar URLs to the Internet, where they could be viewed by anyone. If you want to prevent this,

make sure you have a secure firewall in place.

To get started, set up the following on your Exchange server:

• Create a calendar sharing profile

• Enable the calendar sharing profile for each user for whom you want to have a visible calendar in the

community

Note:  You cannot share calendars contained in public folders. A shared calendar must be a user

mailbox.

Next, follow these steps to publish shared calendars in your community:

1. Ensure that calendar publishing is enabled on your Exchange server. To do this, you can use the

following Exchange PowerShell commandlet:

Get-OwaVirtualDirectory | ft server, Name,
                        CalendarPublishingEnabled

2. Enable calendar publishing with:

Set-OWAVirtualDirectory "SERVER\owa
                        (Default Web Site)" –CalendarPublishingEnabled:
$true 

3. From the Exchange Management Shell, create a new calendar sharing profile and enable anonymous

shares:

New-SharingPolicy -Name "Calendar Sharing



 | Using a Jive Community | 176

                        Policy"

4. Set the sharing policy on user mailboxes who wish to share their calendars:

Set-Mailbox -Identity User.Mailbox -SharingPolicy "Calendar Sharing
                        Policy"

5. Tell the target users to share their calendars either via Outlook 2010 or via Outlook Web Access.

6. When the user publishes a shared calendar, gather the full text of the "Link for viewing calendar in a

web browser." This link will look something like this:

https://YOUR.MAIL.SERVER/owa/calendar/GUID@YOURDOMAIN.PUBLIC/
DIFFERENT_GUID/calendar.html

7. In the community place where you want to share calendars, edit the place to include an HTML widget.

8. In the widget, include the link from above. This link must be contained in an iframe tag. Here is an

example:

<iframe src="https://YOUR.MAIL.SERVER/owa/calendar/GUID@YOURDOMAIN.PUBLIC/
DIFFERENT_GUID/calendar.html" width="1200" height="800"></iframe> 

9. Save and publish your changes to the place.

Your results in the space will look something like this:

 

 

Advanced Project Management
If you administer projects in Jive, you may be called upon to move, archive, or transfer ownership of

projects and the tasks they contain.
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How do I move a project?

Jive provides the ability to move a project from one place to another. You need to own the project in order

to move it, and you must have the appropriate permissions for the place you are moving it into.

To move your project:

1. Select the project by finding it on the Projects tab of the place where it was created, or searching for it in

Places > Projects.

2. From the project's home page, select Manage > Move Project at the upper right of the page.

3. Navigate to the new project location.

4. Confirm the move by clicking Yes - move it here.

How can I archive a project?

You can archive a project, which removes it from the active projects list of its parent space and prevents

new content from being added to the project, such as tasks, discussions, and documents. You need to own

the project to archive it, and you must have the appropriate permissions for its parent place as well.

To archive your project:

1. Select the project by finding it on the Projects tab of the place where it was created, or searching for it in

Places > Projects.

2. When the project opens, select Manage > Archive Project at the upper right of the page.

3. Confirm by clicking Archive.

You can see archived projects by going to Places > Projects and then selecting Show archived projects.

How can I restore an archived project?

Restoring an archived project adds it back to the active projects list and allows new content to be added to

it, such as tasks, discussions, and documents. Remember, you need to own the project in order to restore

it.

To restore an archived project:

1. Select the project by finding it on the Projects tab of the place where it was created, or searching for it in

Places > Projects.

2. When the project opens, select Manage > Unarchive Project at the upper right of the page.

3. Confirm archiving the project by clicking Restore from archive.

How can I transfer ownership of my projects to someone else?

If you own a project, you can pass that responsibility along to someone else. If the container for the project

is restricted to members, the new owner must have access to that space or group.

Note:  In addition to the project owner, the space or group admin of the place where the project

resides can also edit the project details.

To transfer project ownership to someone else:
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1. Select the project by finding it on the Projects tab of the place where it was created, or searching for it in

Places > Projects.

2. When the project opens, select Manage > Settings at the upper right of the page.

3. Click the delete icon in the Project Owner section.

4. Either start typing the new project owner's name or click Select Person to browse a list of all users.

5. Click Save.

Why can't I access a project anymore?

The following actions may prevent you from accessing your project:

• Transferred project ownership to someone else.

• Moved the project to a place you can no longer access.

• Archived your project. You should be able to see an archived project by going to Your Places > All >

Projects and then selecting Show archived projects.

Using Email

Note:  The documentation for Jive for Outlook is listed separately on the main documentation page.

Email or Stream Notifications?

Here are some real-world examples that explain why you might want to turn email notifications on for some

of your streams, but off for others.

Email or No Email?

Part of the power of your community is the ability to "live" in it for most of your working hours and, as a

result, reduce your email. In Jive, you can customize your notifications so that you receive an email, or

not, when a person, place, or item posts an update in one of your streams. If your community is busy,

you may find that you rapidly accumulate hundreds of email messages from any streams that have email

notifications set to On.

Here are some good email notification strategies:

• Turn off all email notifications and live in your Jive community 100%. You will never get an email when

your followed people, places, or items post updates in the community.

• Create an Email Watches stream and set email notifications to On for only that stream. Then, only

follow critical items in your Email Watches stream. This stream can be helpful when you're away from

the community for a few days or if you want to watch something that you haven't directly participated in

(if you had, you'd see those updates in your Inbox).

Be aware that if you set email notifications to On for Inbox (everything in my Inbox page), you will receive

an email each time someone posts an update to an item in which you were previously @mentioned or that

you participated in. This can get overwhelming quickly; we recommend setting email notifications to Off for

Inbox (everything in my Inbox page).
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Note:  The email notifications for news streams (those listed above Connections) are set by the

community manager or person who created the stream. You cannot change the email notification

setting on these streams.

Community Digest

You can set your Preferences by going to the top right and selecting your avatar > Preferences and

then choose a Community Digest option so you'll receive an email with a summary of community news.

The links in the digest open the content right in the community. If you're already getting a digest, you can

cancel it or change its frequency here.

The digest includes:

• Your status. If you've entered a status message, it'll be here.

• A list of activity around your content. If you've created or commented on content, for example, it'll be

listed here. This list will also include notes about content of yours that was viewed or commented on by

others.

• A list of activity by people connected to you.

• A list of popular content in the community.

Customizing Email Notifications

You can set email notifications on any of your custom streams, your Connections stream, and your Inbox,

so that you receive an email each time a person, place, or item posts an update in that stream.

There are a few ways to turn email notifications off or on:

From the unsubscribe link in the email If your community manager has enabled this

feature, you can click the unsubscribe link to

turn all email preferences to the off setting. It

switches the Receive Email option to No. You can

also find this option when you click your avatar >

Preferences.

When you're editing a stream Click the triangle next to the stream name and

select Edit Stream. At the top of the stream, switch

Email Updates to Off or On and then Done next to

the stream's title in the left sidebar.

From your Preferences page Click the triangle next to your avatar in the upper

right corner and select Preferences. From there

you can turn Email Preferences to Off or On for

each stream, including your Inbox. Click Save when

you're done.

Caution:  When you turn On email updates for a stream or your Inbox, you will get an email every

time that stream or Inbox is updated. This can get overwhelming quickly; we recommend setting

email updates to Off whenever possible.
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You cannot set the email notifications on the streams listed above the Connections stream. Your

community manager sets the email notifications for these streams.

Use the following settings to understand when you'll receive an email:

Table 20: Email Settings

Setting When Email Notifications are ON you will:

Inbox (things you've followed in

your Inbox)

Receive a separate email each time someone posts an update to an

item you've selected to follow in your Inbox.

Inbox (@mentions, messages,

and shares)

Receive an email each time someone @mentions you, shares

content with you, or sends you a message in the community.

Inbox (tasks, connections, and

skills endorsements)

Receive an email each time you have a new task, a new connection,

or a new skills endorsement.

Moderation Receive an email when you have content to moderate (if you're a

content moderator).

Connections Stream Receive an email each time a followed person, place, or item posts

an update in this stream.

Your Custom Streams Receive an email each time new activity is posted in your custom

stream(s).

Community Digest Receive a community digest email every day, once or twice a week,

or never. To learn what is included in the digest, see Community

Digest.

Include body of content in email You can select whether or not you'd like your email notifications to

include the full text of the community item you're being notified about.

Creating New Content Without Logging In

If your community supports it, you can post new content simply by sending an email to the community.

This feature can be especially handy for posting when you can't reach the community using a browser. For

example, you can email content from a cell phone that sends email.

Each place in your community provides email addresses for the content you can post via email. For

example, you can send an email to the address corresponding to documents in a place, and a new

document will be created there. Use the email addresses for the specific content you want to post. The

subject line of your email will be the document's title, while the email's body will be its content body. For

status updates, you can include a subject line and/or content in the email body. If you include both, the

subject line and the email body content will be separated by a line break in your posted status update; if

you include only a subject line or only email body content, then that is the only content you will see in your

status update.

To create community content with email:
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1. Click your avatar in the top right and then View Profile to open your profile.

2. Click Actions > Create content by email. You won't see this option if your administrator has not

activated the ability to create content by email.

3. Select the types of content you want to create.

4. Click Actions > Email vCards. You should receive an email from your community that includes this

vCard.

5. In your email or address book program, save the vCard as one of your Contacts. For example, in

Microsoft Outlook you can drag the vCard to your Contacts folder. On a Macintosh, you can double-

click the vCard to add it to your address book.

6. In your email application, create a new message and select the address you just added from the vCard.

7. In the email's subject, type the title you want your content to have in Jive.

8. In the body of the email, type the main part of the content. If you want to include tags, in the last line of

your email type Tags: tag1here tag2here tag3here. This will tag your content so that people can find it

more easily later.

9. Send the email to create the content in Jive.

Posting a Reply Without Logging In

Reply to a community email from your email program and your reply will post directly into your community.

If your community manager has turned on this feature, you can post a reply to something by replying to a

notification email. You first need to set your user Preferences to receive email notifications on a particular

stream, so that when someone updates something you follow in that stream, you'll get an email about it.

(To understand how email notifications work, see Customizing Email Notifications on page 31).

To reply by email, just click Reply in your email program and then type your discussion reply just as you'd

type a reply to any email; then send the email. If the community is set up to receive replies via email, your

reply will be posted as if you'd logged in to your community and posted it from there.

Why Does My Email Content Look Funny?

There are several different kinds of supported email clients that your community administrator can tie into

Jive, such as Microsoft Windows Outlook, Mac Mail, Gmail, and so on. Each of these email clients creates

emails in its own unique way. Because of this, you may notice inconsistent results when creating Jive

content by email. For this reason, do not use styles or images in email content that you post to Jive.

Generally speaking, the incoming and outgoing email features of Jive were designed to handle simple

replies to content and creation of content in Jive.

Jive only creates content from the "plain text" version of an email, which may look significantly different

than the "rich text" version of the email you created or can view in your email application.

In addition, Jive will add email attachments as content attachments if the created content item supports

attachments (for example, a new discussion supports attachments, but a comment on a document does

not).
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Therefore, keep your emails simple. Do not use styles or embed images. If you want to do fancy things, it's

better to do them in Jive.

How Do I Use Feeds?
Use RSS feeds to get content updates without having to visit the Jive application.

Like many Web sites and applications, the Jive application provides the ability to subscribe to a content

digest by using an RSS feed. By subscribing to a feed and using a feed reader (also known as an

aggregator), you can discover what has changed in the application without having to visit it. To learn more

about feeds, see What are feeds?.

Note:  RSS subscriptions are not supported if you have SSO enabled in your community because

the RSS reader cannot follow HTTP redirects for authentication.

Typically you would subscribe to Jive content using your Google, MyYahoo, Safari, Firefox, or Internet

Explorer account. After you have subscribed, you'll be able to see Jive content updates in the application

you selected. There are also reader applications specifically designed to help you collect feeds.

You can subscribe to feeds for places, discussions, or blogs.

To subscribe to an RSS feed for a specific discussion, go to the discussion and click the RSS feed icon

next to the content author's name and time stamp, like this:

 

 

To subscribe to an RSS feed for a space, group, or blog, go to its home page and click the feeds icon

under the Actions menu, like this:

 

http://en.wikipedia.org/wiki/Aggregator
http://en.wikipedia.org/wiki/Aggregator
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For groups, spaces, and blogs, after you click the RSS feed icon, you'll see a list of available feeds for that

place. You can subscribe to one or more content types that are posted in that group, space, or blog. For

example, you may want to subscribe to only discussions posted in a group or only the comments of a blog.

To subscribe, click on the content type you want.
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Next, select the application you want to use as your feed reader (typically Google, MyYahoo, Safari,

Firefox, or Internet Explorer) and click Subscribe Now.

Note:  When you subscribe, you may need to associate your user name and password with the

subscription. That's because the feed reader is getting information from Jive on your behalf.

Jive needs to know it's not giving the information to just anyone. Please note that the need to

authenticate means that feeds are not supported for Outlook 2007, which does not support feeds

that require authentication. Microsoft provides a limited workaroundif you use Internet Explorer.

How Do I Make and Manage Announcements?
Announcements can be an effective way to get people's attention.

You can post an announcement when you are the owner of a place (space, project, or group).

Announcements appear in the Inbox of users following the place, and in a banner on the home page of the

place.

Caution:  Users may also get an email when a new announcement is posted if they have their

email notifications turned on for Inbox updates. For more about that, be sure to read Customizing

Email Notifications. If you do not want notifications (Inbox and email) sent when you create an

announcement, be sure to uncheck the Send Inbox notifications box (checked by default).

http://support.microsoft.com/kb/917125
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Creating an Announcement

1. Navigate to the home page where you want the announcement to appear. This can be the home page

of a space, project, or group that you own.

2. Click Manage > Announcements.

3. Click Add a new announcement.

4. Enter the details of your announcement and specify the beginning and expiration dates. Decide how

long the announcement should be displayed by selecting a start and end date. Announcements start at

12:00 (AM) on the start date and expire at 23:59 on the end date, in the announcement creator's time

zone. If you do not want notifications (Inbox and email) sent when you create an announcement, be

sure to uncheck the Send Inbox notifications box (checked by default).

5. Click Save.

6. To share, edit, expire, or delete an announcement, click Show Details on the announcement or navigate

to the home page of the space, project, or group where the announcement appears and click Manage >

Announcements. Note that when you Expire an announcement, you are saving and hiding it, but not

deleting it. This is useful if you want to repost the announcement at a later date.

Bridging
If you work in two connected communities, such as a public and private community associated with

the same company, you may be able to view or publish content in both places through bridging if your

community administrator has set up this feature.

If you're a member of more than one community, those communities might be connected to each other.

If they are, while you're in one community you can see into the other through widgets. Communities are

connected to each other by a community administrator. If your communities aren't connected, you won't

see ways to view content from one inside another.

If you're a member of two communities that are connected using a bridge, you can have content from

one community appear in the other. (A bridge is something set up by your administrator. You'll know your

community is bridged if you can set its preferences by clicking Your Stuff > Preferences.) When you bridge

content from one community to another, a copy of the bridged content appears in the destination.

For example, imagine you work for a company that has an internal employee community where you

and your coworkers talk about the work (and maybe fun things) you do. But the company also has a

public community that its customers use to get information and support about your products. If the two

communities are bridged, you can have content from one community appear in the other. The kinds of

content that you can bridge include discussions, documents, and blog posts.

Suppose a customer posts a request for a new product or feature on your public community. Because they

include a lot of specific information about what they want and why, you want to make their post visible to

people on your employee community. That way, you and your coworkers can have a separate, behind-

the-scenes discussion about the feature request. You might even want to make parts of your internal

discussion visible to people on the public community (such as a description of the new product as you

eventually design it).
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Note:  When you bridge content, you're copying content from one place to another rather than

linking a live version. That means that the version at the destination (here, the internal community)

isn't updated as its source counterpart changes. Even so, you'll get cues when the source changes,

such as with new replies.

To start bridging content, you'll first need to let the community know that you're a member of both.

1. Click the down arrow next to your avatar at the top right of the screen and select Preferences.

2. Click the Bridge Preferences tab.

3. Find the community with which you want to create a bridge.

4. Next to Account credentials, click the Connect in with Your... link.

5. Enter the user name and password you use for the other community, then click Send.

The basic steps for bridging content are essentially the same whether you're bridging a discussion,

document, or blog post (be sure to use the helpful links along the way in the user interface for guidance!).

Here's how to bridge a discussion, where you want to bridge a discussion from an external public

community to an internal employee community.

1. In the public community, go to the discussion you want to bridge.

2. In the bridge menu at the bottom of the page, click the tab that has the name of the employee

community (you can see this because you connect with your account credentials earlier).

On the bridge menu, you'll see whether any other content is already bridged from this one, as well as a

link back to where you can adjust your bridge preferences.

3. Click the Discuss this link.

4. Under Choose location, choose the place on the employee community where you want to create a

discussion that has content from the one you're bridging.

5. Under Select which part, select check boxes for the parts of the discussion you want to copy to the

employee community. Only those you select will be copied over. You can hover your mouse over View

excerpt to see what each one says.

6. Click Continue.

7. Enter a title for the discussion you're creating. Because you're actually creating a new discussion on

the employee community that embeds content from a discussion on the public community, you need to

enter a title for the new one here.

8. Enter other content if you like.

9. To see a preview of the bridged content, click Preview embedded content. In the preview, be sure

to click View the rest of this bridged content if you want to see everything you selected. If you've

changed your mind about what you want to include, after you close the preview click the Selected

button in the upper right corner of the page.

10.Click Post Message.

11.After the discussion you're bridging has been uploaded to the other community, under Go to the new

message, click the link to see the new discussion message you've posted. You'll be taken to the other

community—here, the employee community.
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12.Notice that your new post embeds the content you selected from the original. From here you can:

• View the original discussion in the other community.

• View the rest of the content, such as the replies to the discussion.

• View content information, including where it came from and what its current condition is. So while the

embedded content won't change as its original changes, you can still see here whether the number

of replies and views has changed.

• See information about bridged content and how it works.

If you've had some discussion around a bridged piece of content, you might want to get some of that

discussion back into the original content. For example, imagine you've bridged a customer discussion

into your employee community, where you and others have discussed the embedded original, replying to

the employee message you created. You arrived at something that you want to communicate back to the

public community. In a reply to the original public discussion, you can include excepts from the employee

discussion—without showing the employee discussion to the public.

To reply with content from the other side of a bridge:

1. Go to the original discussion thread.

2. At the bottom of the thread, click Reply to original post.

3. At the bottom of the content window, click the Quotes from link to view a list of content from the

discussion you created earlier to embed the bridged content.

4. Under Insert a quote, select check boxes for the parts of the content you want to copy into the original

discussion, then click Insert.

5. Notice that the text from the content parts you selected has been pasted into the new reply you're

writing. There's no other sign that the employee discussion exists.

6. Finish your reply using the content copied from the other discussion.

Keyboard Shortcuts

You can use the following keyboard shortcuts when using the content editor in Jive.

Note:  Formatting characteristics are not retained when you copy and paste content from Microsoft

Office applications into Jive.

Table 21: Content Editing Shortcuts

Key Combo Action

Ctrl-c Copy

Ctrl-x Cut

Ctrl-v Paste

Ctrl-z Undo

Ctrl-y or Ctrl-Shift-z Redo
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Key Combo Action

Ctrl-b Bold

Ctrl-i Italic

Ctrl-u Underline

Ctrl-1, -2, -3, -4, -5, or -6 Heading levels 1-6

Ctrl-7 Format as paragraph

Tab Indent 5 spaces or indent a list item 1 level

Shift-Tab Outdent 5 spaces or outdent a list item 1

level

Esc Move the focus to the first visible submit

button

Ctrl-s Publishes your content.

Caution:  In previous versions,

this key combination saved a draft,

rather than publishing, for blog

posts only. This is no longer the

case.

Passwords
Use a strong password containing mixed cases, numbers, and/or special characters to protect your content

and your community identity.

By making a password that's strong enough to stump the guessers, you're not only protecting your

own content (including any private content you have), but also the content and activity of others in the

community. Here are a few guidelines for making a password that only you know.

• Make sure at least three characters are upper-case, lower-case, numerals, or punctuation.

• Try using words instead of numbers—"six" instead of "6", for example.

• Use numerals instead of letters here and there—"0" instead of "o" would work.

• Mix uppercase and lowercase letters—as in "feLiX".

• Add punctuation or other special characters. You could throw in a "!" or "$" or "@"—pretty much

anything you like, really.

• Use at least six characters, although you're better off with eight or more.

If you forget your password, you can ask your community administrator to reset it, or if your community

allows you to change your password, you can change it using following steps:

Note:  Some communities provide a Forgot Password link at the login screen, which enables you to

reset your password right there.
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1. Change your password by going to the top right and selecting your avatar > Change Password. If you

don't see the Change password link, then your community has user password changing disabled and

you need to contact a community administrator to change or reset your password.

2. Change your password using the strength meter to measure how strong you've got it so far, and what

you can do to improve it, and then click Save.

Time Zone and Locale Preferences
Your time zone and locale settings determine how time and locale are displayed on your content.

To set your time zone and locale preferences:

1. Go to your user Preferences page by clicking on your avatar in the upper right corner and selecting

Preferences.

2. Select your Locale. This can be important if you use Jive from a web browser set to another locale,

such as when you're working in an Internet cafe in another country. Your preference here takes

precedence. If you want to use the locale set by your administrator for the entire community, make

sure that your web browser is not set to a specific locale (or the browser's locale will override the

administrator's locale setting).

3. Scroll down the page and select your Time Zone. This setting is used in the timestamp when you

publish a blog post, document, or discussion. Your administrator sets the time zone that affects the start

and end times for all announcements, polls, projects, tasks, and checkpoints.

4. Click Save.

Changing Non-Editable Profile Fields
Sometimes profile fields can't be edited because an administrator has locked them down, or because they

come from a directory server controlled by your organization.

If you can't edit a field such as your name or title in your profile, it's typically because an administrator has

set your community up this way. Often, fields like name, title, email address, and department aren't entered

by a Jive admin, but come from a directory server such as Active Directory. In this case, the community

administrator can't directly edit them in the profile, either.

Every organization is different, so who you should ask for help depends on who is responsible for this part

of your site data. If you need to change a non-editable field in your profile, you can try the following paths

for getting it changed:

• If you know who your community manager is, ask him or her who controls these fields. Often, he or she

can make the change, request a change for you, or tell you who can handle the change.

• If you don't know who your community manager is, try contacting your human resources department or

your IT support department. These departments often administer your company's directory server, or

know who does.
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